
User Manual

CSS50
Cable Television System Software

071-0030-02

This document applies to software versions 1.0,
2.0, and 2.1.



Copyright � Tektronix, Inc. All rights reserved. Licensed software products are owned by Tektronix or its suppliers and
are protected by United States copyright laws and international treaty provisions.

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the
Rights in Technical Data and Computer Software clause at DFARS 252.227-7013, or subparagraphs (c)(1) and (2) of the
Commercial Computer Software – Restricted Rights clause at FAR 52.227-19, as applicable.

Tektronix products are covered by U.S. and foreign patents, issued and pending. Information in this publication supercedes
that in all previously published material. Specifications and price change privileges reserved.

Printed in the U.S.A.

Tektronix, Inc., P.O. Box 1000, Wilsonville, OR 97070–1000

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.



WARRANTY

Tektronix warrants that this software product will conform to the specifications in the documentation provided with the
product, when used properly in the specified operating environment, for a period of three (3) months. The warranty period
begins on the date of shipment, except that if the program is installed by Tektronix, the warranty period begins on the date
of installation or one month after the date of shipment, whichever is earlier. If this software product does not conform as
warranted, Tektronix will provide remedial services as described in the documentation provided with the product.
Tektronix does not warrant that the functions contained in this software product will meet Customer’s requirements or that
operation of the programs will be uninterrupted or error-free or that all errors will be corrected.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the
warranty period and make suitable arrangements for such service in accordance with the instructions received from
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obligated to furnish service under this warranty with respect to any software product a) that is used in an operating
environment other than that specified or in a manner inconsistent with the User’s Manual and documentation or b) when
the software product has been integrated with other software if the result of such integration increases the time or difficulty
of analyzing or servicing the software product or the problems ascribed to the software product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO
PROVIDE REMEDIAL SERVICE WHEN SPECIFIED, REPLACE DEFECTIVE MEDIA, OR REFUND
CUSTOMER’S PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO CUSTOMER FOR
BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER
TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Preface

The CSS50 Cable Television System Software is Microsoft Windows 95- and
NT-based software to control and display measurement results of Cable TV test
equipment.

This manual supports software versions 2.1, 2.0, and 1.0 of the CSS50 Cable
Television System Software. Following is a list of test equipment supported by
the each version of the CSS50 software.

Software Version 2.0 and 2.1 Software Version 1.0

2714 and 2715 Spectrum Analyzers 2714 and 2715 Spectrum Analyzers
DS1000 series demodulators (NTSC
and PAL)

DS1001 NTSC demodulator

VM100 and VM101 Video Measure-
ment Sets

VM100 Video Measurement Set

The point and click user interface makes operation easy, even for the inexperi-
enced user. Making a measurement is as simple as selecting a channel and
measurement type and clicking a mouse. In addition, the package can automati-
cally monitor all in-service baseband and RF measurements and signal an alarm
when a measurement exceeds a specified limit.

Measurement results are displayed in a table of channel vs. measurement type.
For any measurement on a particular channel, the user simply clicks the mouse
on that data cell, and a window appears with more information.

As with other Windows-based software, CSS50 data is exportable to other
Windows-based software, such as Microsoft Excel, for in-depth data analysis.

What’s in this Manual
This manual assumes that you are familiar with Windows 95 or NT4.0. Please
refer to the Windows tutorial in the Windows reference manual for more
information if you are not comfortable with Windows.

This manual is organized as three primary chapters and a set of appendices. The
three primary chapters and their contents are:

� Getting Started. Covers software installation.

� Operating Basics. A tutorial for the beginning user.



Preface

xii CSS50 Cable Television System Software User Manual

� Reference. Provides detailed information about the software. Describes the
worksheet, the menu bar and menus, and advanced information on setups
and measurements.

The contents of the appendices are:

� A Menu Map to give you a quick overview of the software.

� A listing of error messages.

� An explanation of how to use the Channel Table Editor.

� Guidelines for using the CSS50 application to meet FCC measurement
requirements for monitoring a cable system.

� Information about the CSS50 files (how to archive worksheets, file sizes,
and other information).

� A cabling diagram showing connections between the controlling PC and
test equipment.

� How to control a 2714 or 2715 spectrum analyzer over a modem.

� Information about software version 1.0 not included in other sections of
the manual.

Contacting Tektronix

Product
Support

For application-oriented questions about a Tektronix measure-
ment product, call toll free in North America:
1-800-TEK-WIDE (1-800-835-9433 ext. 2400)
6:00 a.m. – 5:00 p.m. Pacific time

Or contact us by e-mail:
tm_app_supp@tek.com

For product support outside of North America, contact your
local Tektronix distributor or sales office.

Service
Support

Contact your local Tektronix distributor or sales office. Or visit
our web site for a listing of worldwide service locations.

http://www.tek.com

For other
information

In North America:
1-800-TEK-WIDE (1-800-835-9433)
An operator will direct your call.

To write us Tektronix, Inc.
P.O. Box 1000
Wilsonville, OR 97070-1000
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Installation

This chapter describes the computer requirements and how to install the CSS50
Cable Television System Software.

Contents of CSS50 Package
� Two 31�2 inch diskettes

� This manual

Hardware Requirements
Table 1–1 lists the computer requirements for the CSS50 software to operate
properly.

Table 1–1: Personal computer requirements 

Requirements Details Recommendations

66 MHz, 486 with hard drive Pentium recommended

Microsoft Windows 95 or
NT4.0

VGA display

8 MB of RAM 16 MB recommended

4 MB of hard drive free space

I/O ports (requirements based
on equipment setup)

GPIB or RS 232 for
2714 or 2715

GPIB:

National Instruments GPIB hard-
RS-232 for DS1000
series

N -
ware and Software for Windows

RS-232:

RS-232 for VM100 or
VM101

Desktop National Instruments
AT-232/2 (or AT-232/4)

RS-232 for Violations
Reporting

Laptop National Instruments
PCMCIA-232/2

Video display board
(optional)

View Picture Mode Video Blaster
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Step-by-Step Procedure to Install the CSS50 Software
1. Close all open applications on your PC.

2. Insert disk 1 into your disk drive.

3. Click on Start in the Windows 95 main screen. This displays a task list.

4. From the task list, select Run... This displays the Run dialog window.

5. Type ���
����� in the entry field (substitute the character � with the
character of your disk drive).

6. Click on OK.

7. Follow the software installation prompts.

Results of the Software Installation
The installation adds the following items, directories, and files.

CSS50 (Windows 95 only)

For Windows NT, you can create a shortcut to the CSS50.exe on your desktop.
Refer to the Windows NT help text for shortcuts.

CSS50

� Sub-directories of CSS50:

���	 �����


The Help directory contains the online help files. See Appendix E for how to
edit these to fit your special requirements.

The Limits directory contains an NTSC limits file (ntsc.lim) and a PAL
limits file (pal.lim).

Hardware Installation

You can use the software without having all equipment installed. If you install
only some of the equipment, use Table 1–2 to determine the available measure-
ments.

Windows Program Items

Directories Created

Minimum Equipment
Installation
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Table 1–2: Equipment required to make the various measurements 

Measurement RF1 BB2

Visual Carrier Level �

Visual Carrier Frequency �

Aural Carrier Level �

Aural Frequency Offset �

Second Aural Carrier Level �

Second Aural Frequency Offset �

Average Power �

Carrier to Noise �

Desired to Undesired �

CSO �

CTB �

Cross Modulation �

Adjacent Channel Leakage �

In-Channel Response3
� �

Hum/LFD3
� �

FCC Baseband �

Modulation Depth �

Aural Deviation �

Signal to Noise �

Waveform Distortion �

1 RF equipment includes the 2714 or 2715 spectrum analyzers.
2 BB (Baseband) equipment includes: the VM100 or VM101 video measure-

ment set and DS1000 series television demodulators.
3 If both columns are checked, use either RF or BB equipment to make the

measurement.
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Test Equipment
The following test equipment is required to complete this installation:

� A 2714 or 2715 Cable TV Spectrum Analyzer. If something is instrument
specific, then one or the other is called out.

� If the 2714 or 2715 has option 03 installed, a GPIB cable (012-0991-01)
is required.

� If the 2714 or 2715 has option 08 installed, an RS-232 cable is required.
The 25-pin RS-232 cable is Tektronix part number 012-1380-00. The
9-pin RS-232 cable is Tektronix part number 012-1379-00.

� A VM100 (NTSC) or VM101 (PAL) video measurement set

� A DS1000 series television demodulator (NTSC or PAL video standard)

� Two RS-232 cables are needed to connect both a video measurement set
(VM100 or VM101) and a demodulator (DS1000 series) to the PC. The
cables are Tektronix part number 012-0991-01 (1 meter length).

Please see Appendix F for how the equipment should be connected for proper
operation. (You need not use all of the equipment; see Table 1–2 for more
information.) See the test equipment manuals for any additional hardware
information.

The CSS50 software can only communicate with one of each type of test
equipment at any one time. For example, if you have two 2714s or 2715s in your
system, CSS50 can only use one of them to make its measurements.

To Install the Equipment
Use the following procedures to install the equipment.

If you use a 2714 or 2715 spectrum analyzer with a GPIB port, install the
National GPIB hardware and Software for Windows using the instructions
provided in the National manuals.

Install the RS-232 hardware and software using the instructions provided from
the manufacturer.

GPIB Board

RS-232 Board/Card
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Configure your 2714 or 2715 spectrum analyzer as indicated in Table 1–3 for
GPIB or Table 1–4 for RS-232.

Table 1–3: 2714 or 2715 (Option 03) GPIB 

Status Online

GPIB address 11

Power on SRQ On or Off

EOI/LF mode LF/EOI

Talk only mode Off
1 This must be a unique address between 0 and 29

Table 1–4: 2714 or 2715 (Option 08) RS-232 

Status Online

Baud rate 96001

Data bits 8

Parity None

EOL LF

Flow control Hard (RTS/CTS)

Echo Off

Verbose Off
1 Device baud rate is selectable through the

Connections menu. Other communications
parameters must be set to these values.

Configure your video measuremnet set as indicated in Table 1–5.

Table 1–5: VM100 or VM101 RS-232 

Baud rate 96001

Stop bits 1

Parity None

Flow control None

Remote address Not applicable
1 Device baud rate is selectable through the CSS50

Connections menu. Other communications
parameters must be set to these values.

2714 or 2715

VM100 or VM101
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Configure your DS1000 series demodulator as indicated in Table 1–6.

Table 1–6: DS1000 series RS-232 

Unit address Not applicable

RTS/CTS Disabled

RS485 Not applicable

Baud rate 96001

Start bits 1

Stop bits 1

Data bits 8

Parity None
1 Device baud rate is fixed at 9600. Other communica-

tions parameters must be set to these values.

Select the Demodulator and Configure the Connections
The CSS50 software must know if a DS1000 series demodulator is connected in
your system. The first time that you run the CSS50 software you need to check
that the software knows your equipment setup.

1. Start the software by clicking on the icon (created during software installa-
tion).

2. When the start-up is complete, choose Demodulator from the Configure
menu. The display will be similar to Figure 1–1. The check mark indicates
the selection.

Figure 1–1: Demodulator selection, from the Configure menu

DS1000 Series
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3. If you choose DS1000, you are presented with the demodulator setups dialog
box (Figure 1–2).

Figure 1–2: DS1000 Demodulator Setups dialog box

4. Set the demodulator parameters as required for your equipment configura-
tion.

For NTSC, the Line entry must be in the range of 10 to 20 and the Field set
to 1 or 2. Baseband Hum measurements use Field 1 only.

For PAL, the Line entry must be in the range of 6 to 16 or 319 to 329. The
Field entry is disabled (grayed out). Baseband Hum measurements use the
Line range of 6 to 16 only.

Zero Carrier Pulse must be set to On for Baseband Hum measurements.
Select a quiet line in the video signal to put the zero carrier pulse on.

Position is where within the video line the pulse is placed. The range is 0 to
4 where 0 is at the start of the video line and 4 is at the end.

NOTE. The video standard (NTSC or PAL) is defined in the channel table
attached to the current worksheet. See Appendix C: Channel Table Editor for
information about channel tables.

Now set the communication parameters for each piece of test equipment.

1. Choose Connections from the Configure menu. The Connections dialog box
looks similar to the one shown in Figure 1–3.

2. Enter the RS-232 configurations for the VM100 or VM101 video measure-
ment set, the DS1000 series demodulator, and the 2714 or 2715 spectrum
analyzer.
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Figure 1–3: Connections dialog box

3. If the 2714 or 2715 has an RS-232 connection instead of a GPIB, it must be
entered along with the baud rate and the correct Communications (Com)
Port.

CAUTION. To ensure proper operation and prevent software conflicts, verify that
no two instruments are assigned to the same port. This applies even if an
instrument is not connected or used.

4. Set the RS-232 Violations Reporting Com Port and Baud rate if you need to
have errors reported for the RS-232 Port. An additional Com Port is
required. If you are not using violations reporting, set the com port to a value
not used or doesn’t exist to avoid conflict with other instruments.

5. For learning purposes, selecting No Instruments Selected allows the
application to run without any instrumentation connected. Random numbers
are generated to approximate measurement results.

6. Click on OK when the dialog box has been set up correctly.
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Basic Tutorial

The goal of this section is to familiarize you with the basic layout of a work-
sheet, how to set up a worksheet, and make simple measurements.

Before beginning the tutorial, please check your hardware for the proper
connections. (Appendix F gives a cabling diagram.) Double-checking the
hardware helps prevent errors that are hardware related.

If you want more information on an individual command, please refer to the
on-line help or the Menu Bar section, beginning on page 3–11.

This tutorial assumes that a mouse is available. If a mouse is not available, make
selections using the ALT key plus the underlined letter of the command. For
example ALT+f means to press the ALT key and the f key at the same time.

By the end of this chapter, you should be able to do the following:

� Select cells

� Enter Worksheet Header information

� Make simple measurements

� Enter the Results Detail display

� Enter the Global View

� Define a Measurement Sequence

� Execute a Measurement Sequence

� Define a Measurement Sequence using the Auto Selection buttons

� View the broadcast picture on the computer monitor

� Set up your printer

� Print out assorted reports
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Purpose of Software
The purpose of the CSS50 software is to simplify the time-consuming and
tedious tasks of measuring and recording the results of measurements associated
with a cable TV system. To make a measurement on a particular channel, simply
select the cell where the channel and measurement intersect and double-click the
left mouse button. The results are printed in the cell. Print out the reports and the
job is completed. Of course, this is a cable system and there are many channels
and many measurements. The software allows you to make many measurements
rapidly by selecting several channels or measurements.

Start the Software
1. Start the PC with Windows 95 or NT4.0.

2. Start the CSS50 application.

a. For Windows 95 — Choose CSS50 from the Start menu.

b. For Windows NT4.0 — Choose CSS50 from where you installed the
application (or use the shortcut if one has been created).

The initial display is called a worksheet. This worksheet is blank except for the
measurement list running across the top row and a channel list running down the
left column.
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Description of the Worksheet
Figure 2–1 identifies the elements of the worksheet.

Worksheet header

Minimize

Menu bar

Measurement
header

Channel header

Horizontal scroll bar

Cell

Button bar

View filter status box

Spreadsheet

Restore or
maximize

Vertical scroll bar

Title bar Exit

Figure 2–1: The default worksheet

The following paragraphs describe the various parts of the worksheet.

Mouse Pointer. (Not shown in figure.) The mouse pointer can take many shapes,
dependent upon the functions available. If the pointer is a cross, it selects cells in
the spreadsheet. If it is an arrow, it chooses commands. If it is an hourglass, the
software is busy and no new actions are available.

Title Bar. This shows the name of the application, “Tektronix — CSS50”.

Elements of the
Worksheet
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Minimize Button. Shrinks the application to an icon.

Maximize Button. Makes the application window fill the entire display area.

Restore Button. Returns the application window to its previous size.

Control Menu Box. Contains the standard Windows commands: Restore, Move,
Size, Minimize, Maximize, Close, and Switch To.

Menu Bar. Provides access to the CSS50 menus.

Button Bar. Contains the command buttons. The command buttons are shortcuts
with equivalents in the Menu Bar.

Channel Row Header. Lists channels by number and center frequency.

Measurement Column Header. Lists measurements.

Vertical Scroll Bar. Moves the spreadsheet vertically. Note that the Measurement
Header remains along the top as a reference.

Horizontal Scroll Bar. Moves the spreadsheet horizontally. Note that the Channel
Header remains along the side as a reference.

Spreadsheet. Contains all of the cells, the Measurement Header, and the Channel
Headers.

Cell. A single cell (box) on the spreadsheet — the intersection of one measure-
ment and one channel. See Cell Coloring on page 2–22 about the meaning of cell
colors.

Figure 2–2 illustrates the Worksheet Header, which lists important information
about a worksheet. You can edit this information in various ways depending
upon which piece you would like to change. (For how to set up a worksheet, see
page 2–13.)

Figure 2–2: The worksheet header

Elements of the
Worksheet Header
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Worksheet. The name of the current worksheet. It is called <untitled> if the
worksheet has not been saved.

Chan Table. This file lists the channels in the system under test. There must be a
Channel Table or the CSS50 will not run. The default channel table is std.cht.

Site. An additional identifier for the worksheet. Site is intended to be the location
where the measurement takes place. Only one Site is allowed for each worksheet.
The Site name <undefined> is a valid name.

Test ID. The name that you give to a test. The test ID could be the name of the
person who is making the measurements, the measurement test point, or any
other identifier. A single worksheet can have multiple Test IDs sub-dividing
measurements made at a single Site (such as Pre-converter and Post-converter).
The test ID name <undefined> is a valid name.

View Filter Box. Tells how much of the spreadsheet is in view or is available. The
options for the box are: “No View Filter is On” (the entire spreadsheet is in
view), “View Selected Filter is On” (display only selected measurements and
channels), “View Sequence Filter is On” (display only measurements made with
a Measurement Sequence), and “View Test ID Filter is On” (display only
measurements made with the current Test ID). Note that only displayed channels
are available for measurements.

Navigation
This section explains how to get around in the software. All actions are first
explained for the mouse and then for the keyboard. If you are familiar with
Windows command selection, skip to Scroll Through the Spreadsheet on
page 2–9.

Step Mouse Keyboard

1 Single-click the left mouse button on
the desired menu from the Menu Bar.

Press the ALT key plus the underlined letter in
the menu.

2 Single-click the left mouse button on
the desired command.

Press the underlined letter for the desired
command or use the arrow key to scroll, then
press Enter.

Choose from the
Menu Bar
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Example: Open a worksheet 

Step Mouse Keyboard

1 Single-click the left mouse button on
the word “File” on the Menu Bar.

Press ALT+f.

This displays the drop-down File menu shown in Figure 2–3.

Figure 2–3: The drop-down File menu

Step Mouse Keyboard

2 Single-click the left mouse button on
the word “Open”.

Press o.

This displays the dialog box shown in Figure 2–4.
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Figure 2–4: Open dialog box

Step Mouse Keyboard

3 Single-click the left mouse button on
the Cancel command button to close
the Open dialog box without opening a
file.

Press ESC to close the Open dialog box
without opening a file.

Mouse Keyboard

Single-click the left mouse button on the
desired command button.

Press the ALT key plus the underlined letter
from the command button.

or

Press TAB to place the cursor in the Button
Bar, then press either TAB or the arrow keys to
select the command button. (Be careful using
the arrow keys. They will scroll off the Button
Bar and into the spreadsheet.) Press ENTER
to choose the selected command button.

Example: Open the Test ID dialog box 

Step Mouse Keyboard

1 Single-click the left mouse button on
the Test ID command button.

Press ALT+i.

Choose from the
Button Bar
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This displays the Test ID dialog box shown in Figure 2–5.

Figure 2–5: Test ID dialog box

Step Mouse Keyboard

2 Single-click the left mouse button on the
Cancel command button, to close the
dialog box without making any changes.

Press ESC.

Many dialog boxes have two special command buttons: OK and Cancel.

To choose OK from the keyboard, press ENTER with anything highlighted
except the Cancel button.

To choose Cancel from the Keyboard, either press ESC or press TAB until the
Cancel command button is highlighted, then press ENTER.

Special Command Button
Keyboard Shortcuts
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Mouse Keyboard

Either:

Click on the left, right, up, or down scroll
arrows in the Vertical or Horizontal Scroll Bar
with the left mouse button. This moves the
spreadsheet one vertical row or one horizontal
column at a time.

or

Click on the scroll box in the Vertical or
Horizontal Scroll Bar with the left mouse
button, then hold down the left mouse button
and drag the scroll box to the desired position.
Release the mouse button.

Place the cursor in the spreadsheet. To scroll
the spreadsheet to the desired position, use
the arrow keys if you are in the Button Bar or
ESC if you are on the Menu Bar. The
spreadsheet display will move every time you
move to a cell that is off screen. The HOME,
END, PAGE UP, and PAGE DOWN are also
available to move quickly through the
spreadsheet.

HOME. Moves to the first cell in the current
channel.

END. Moves to the last cell in the current row
that has a measurement made for any
channel.

PAGE UP. Moves the spreadsheet up one
page. (Measurement stays the same and the
current channel is the next channel that was
just off screen to the top.) Nothing happens if
the top channel is currently visible.

PAGE DOWN. Moves the spreadsheet down
one page. (Measurement stays the same and
the current channel is the next channel that
was just off screen to the bottom.) Nothing
happens if the bottom channel is currently
visible.

Example: Display the FCC Baseband measurement for channel 3 

Step Mouse Keyboard

1 Click on the Horizontal Scroll Bar box
with the left mouse button. Hold down
the left mouse button and drag the
cursor until it is all the way to the right
side of the Horizontal Scroll Bar. The
FCC Baseband column is visible.

Place the cursor on the spreadsheet. Press
the right arrow key until the FCC Baseband
column is visible.

2 Click on the Vertical Scroll Bar down
arrow with the left mouse button until
channel 3 is visible. The spreadsheet
looks similar to Figure 2–6. Notice the
position of the boxes in the Vertical
and Horizontal Scroll Bar.

Press the down arrow key until channel 3 is
visible. The spreadsheet looks similar to
Figure 2–6. The FCC Baseband cell for
channel 3 is selected (using the std.cht
Channel Table). Notice the position of the
boxes in the Vertical and Horizontal Scroll Bar.

3 Reverse the steps to return to the spreadsheet to display the first column.

Scroll Through the
Spreadsheet
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Figure 2–6: The spreadsheet scrolled to the FCC Baseband column

Mouse Keyboard

Single-click the left mouse button on the
desired cell.

Press ESC or the arrow keys until the cursor is
in the spreadsheet. Use the arrow keys to
move the cell outline to the desired cell.

Example: Select Carrier to Noise cell for channel 3 

Mouse Keyboard

Place the mouse cursor anywhere in the cell.
Single-click the left mouse button. The
selected cell is outlined.

Use the arrow keys to move the cell outline to
the desired cell.

The selected cell on the spreadsheet looks similar to Figure 2–7.

Select a Cell from the
Spreadsheet
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Figure 2–7: A single cell selected on the spreadsheet

Select a group of adjacent cells (rows, columns, or block).

NOTE. You can only select adjacent cells. If non-adjacent cells need to be
measured as a group, use a Measurement Sequence (see page 2–24).

Step Mouse Keyboard

1 Click on one of the corner cells in the
desired group.

Press the arrow keys until one corner cell of
the desired group is selected.

2 Hold down the left mouse button and
drag the mouse until all of the desired
cells have reversed color. (When the
cell color reverses, it indicates selec-
tion. The first cell does not reverse
color.)

Hold down the SHIFT button. Use the arrow
keys to move around the spreadsheet until the
desired group of cells has reversed color.
(When a cell reverses color — it has been
selected. The first cell does not reverse color.)

3 Release the left mouse button. Release the SHIFT button.

Select a Group of Cells
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Example: Select channels 3-4’s carrier levels and frequencies 

Step Mouse Keyboard

1 Single-click on the second channel’s
Visual Carrier Level cell.

Use the arrow keys to place the cursor around
the second channel’s Visual Carrier Level cell
(Channel 3).

2 Start the mouse pointer in the selected
cell, then hold down the left mouse
button and drag the mouse cursor until
the desired cells have reversed color.
Release the left mouse button. The
selected cells keep the reversed color,
except for the original corner cell which
is outlined.

Hold down the SHIFT key and use the arrow
keys to select the desired cells. The selected
cells reverse color, except for the original
corner cell which is outlined.

The spreadsheet resembles Figure 2–8. Note that the selected cells have reversed
in color except for the corner cell which is outlined.

Figure 2–8: A group of cells selected on the spreadsheet
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Selecting an entire row or column 

Mouse Keyboard

Single-click on the name of the measurement
or channel in the Measurement or Channel
Header.

To select an entire row, place the cursor
anywhere in the row and press SHIFT+space-
bar.

To select an entire column, place the cursor
anywhere in the column and press
CTRL+spacebar.

Select the Entire Spreadsheet. You can select the entire spreadsheet three ways:

Select the entire spreadsheet 

Mouse Keyboard

Click with the left mouse button on the upper
left cell where the Channel and Measurement
Headers intersect.

Press CTRL+SHIFT+spacebar.

Select the Edit menu by pressing ALT+e, then
choose Select All by pressing s.

Setting Up a Worksheet
There are four parts to a worksheet definition: Site, Test ID, Channel Table, and
Worksheet name. The Worksheet is the main file that stores everything. Each
Worksheet may only have one Site and one Channel Table associated with it. If
the Channel Table or Site changes, the software automatically gives you the
option to start a new worksheet or rename the Site in the current worksheet. You
will now create a new worksheet for practice.

1. From the File menu, choose New. If a worksheet has already been defined,
the following Warning dialog box (Figure 2–9) may be displayed:

Figure 2–9: Worksheet has changed warning

Enter a Site and
Description
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2. Do not save the old worksheet; click on No.

This displays the New dialog box, as shown in Figure 2–10.

Figure 2–10: New dialog box

3. Select the Site box and enter an appropriate site name (for example,
“Tektronix – Beaverton”).

Mouse Keyboard

Click on the Site box. Type in your site name
or click on the arrow box to select an existing
Site name. (Use a site name appropriate to
your setup.)

Press TAB until the cursor is in the Site list box
and type in your site name.



Basic Tutorial

CSS50 Cable Television System Software User Manual 2–15

4. Select the Description text box.

Mouse Keyboard

Click the left button in the Description text box. Press ALT+p or TAB.

5. Enter the description: ��	� ���
����� 	� ��� �����	�� ����

6. Select std.cht as the Channel Table by clicking on std.cht in the list box.
(This is the default selection.)

7. Leave the New dialog box and save the changes by clicking on OK.

8. From the File menu, choose Save As. The Save As dialog box appears, as
shown in Figure 2–11.

Figure 2–11: Save As dialog box

9. In the File Name combo box, type: �������.

10. Click on OK. The title “example.wrk” is in the worksheet header.

1. From the Configure Menu, choose Test ID or click on Test ID in the Button
Bar. This displays the Test ID dialog box shown in Figure 2–12.

Enter a Test ID
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Figure 2–12: The initial display of the Test ID dialog box

2. Select a Test ID.

Mouse Keyboard

Type in a Test ID or select from the combo
box: click on the arrow in the list box (if
present) and then select one from the list. The
example uses “Learner’s Permit”.

Type in the Test ID or select one from the list
box by scrolling through the list by pressing
the down arrow key. The example uses
“Learner’s Permit”.

3. Leave the Test ID dialog box and save the changes by clicking on OK.

The worksheet header should look similar to Figure 2–13.

Figure 2–13: The worksheet header after filling in all information

See Advanced Setups Tutorial on page 2–37 or Appendix C: Channel Table
Editor if the Channel Table must be changed.

Attach or Change a
Channel Table
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Make Simple Measurements
You now have enough background to begin making simple measurements and
you have created a new worksheet so you won’t overwrite an existing one.

NOTE. Do not use the 2714 Spectrum Analyzer (or 2715 Spectrum Analyzers
with firmware below version 12.01.95) to take digital measurements. The 2714
will not run digital measurements (Average Power, Desired to Undesired, and
Adjacent Channel Leakage), but uses the same channel table format as the 2715.
If the software attempts to take a digital measurement using the 2714, measure-
ments returned will be incorrect, errors will be returned, or the software will
behave unpredictably.

To make one measurement on one channel, select a cell. From the Measure
menu, choose Current Selection (or click on Meas Sel in the Button Bar) or
double-click on a cell with the left mouse button.

The measurement results appear in the cell, replacing any previous results. (The
previous results are not necessarily lost. See Measurement History Group on
page 2–48.)

Only one measurement on one channel takes place, unless you select one of the
first six measurements: Visual Carrier Level, Visual Carrier Frequency, Aural
Carrier Level, Aural Frequency Offset, Second Aural Level, and Second Aural
Frequency Offset. Select any of these cells and all six measurements are always
taken.

Example: Measure Carrier Levels and Frequencies for the channel 2 

Mouse Keyboard

Select the cell by single-clicking the left mouse
button.

Place the cursor in the spreadsheet, then use
the arrow keys to select the cell.

Execute the measurement.

Mouse Keyboard

Either double-click with the left mouse button,
choose Current Selection from the Measure
menu, or click on Meas Sel in the Button Bar.

Either choose Current Selection from the
Measure menu or choose Meas Sel from the
Button Bar.

One Measurement for
One Channel
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A dialog box then appears, telling you that the software application is busy
making measurements.

Figure 2–14: Measurement Execution dialog box

If you chose the wrong measurement or channel, click on Cancel to stop the
measurement. (Cancel stops after the current measurement. Cancel does nothing
when making a single measurement.)

The CSS50 software might respond with a message to turn off the scrambling if
that particular channel has scrambling enabled and the requested measurement
requires the channel. (When all of the measurements for the channel are finished,
then another message reminds you to turn the scrambling back on.)

The CSS50 software might also respond with the Message box shown in
Figure 2–15.

Figure 2–15: Switch RF signal message

This is an optional dialog box warning you to double check your equipment
setup. The measurement halts until you click on OK. To stop the measurement
click on Cancel. (You can turn this message box on or off; see Configuration
Preferences, page 2–47.)

If everything is properly connected, click on OK.

The CSS50 software responds with the dialog box in Figure 2–16 to let you
know that it is working on the measurement.
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Figure 2–16: Measurement Execution dialog box

Again, you can cancel the measurement at this point by clicking on Cancel.

The first four or six cells for the selected channel are filled in. (There are only
four measurements made in the following example because std.cht does not have
the Second Aural Frequency set. If this Channel Table field has a value, then the
last two measurements are available.)

Repeat this measurement for the next two channels on the list. The resulting
spreadsheet looks similar to Figure 2–17.

Figure 2–17: The spreadsheet after making a few measurements
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To make several measurements on adjacent cells:

1. Select the cells.

2. From the Measure menu, choose Current Selection or double-click on the
channel name in the Channel Header. This makes all the measurements on
the selected channel.

Use the same procedure to run one measurement for all the channels:

1. Select all the channels for that measurement

2. From the Measure menu, choose Current selection or double-click on the
Measurement Header.

Remember, you cannot use this method to make measurements on non-adjacent
cells because they cannot be selected together. Use a Measurement Sequence (see
page 2–24) to make measurements on non-adjacent cells.

Since it usually takes a little while for groups of measurements to complete, you
can switch to other Windows applications while the measurements are executing.

Example: Make FCC Baseband Measurements for Several Channels. 

1. Scroll the spreadsheet horizontally to display the FCC Baseband measure-
ment column.

2. Select the first three channels for an FCC Baseband measurement. From the
Measure menu, choose Current Selection. A dialog box similar to Fig-
ure 2–18 appears.

Figure 2–18: Measurement Execution dialog box

3. If you need to stop the measurement, click on Cancel. The current measure-
ment will finish but no further measurements will be made. (Press ESC,
RETURN, or the spacebar to cancel the measurement.)

4. The next dialog box tells you that a measurement is going to be made on the
next channel (see Figure 2–19). This allows you to tune the external
pre-selector, if necessary.

Make Several
Measurements at a Time
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Figure 2–19: Execution paused message

This dialog box repeats three times, once for each channel.

5. If you need to stop the measurement, click on Cancel.

The spreadsheet cells should look similar to Figure 2–20.

Figure 2–20: The spreadsheet cells after making a group of measurements

Note that this measurement only gives Pass/Fail results instead of numerical
results. There are several separate measurements under this Measurement
Header. If you want to see the individual results of each of these measurements,
Differential Gain, Differential Phase, and Chrominance-to-Luminance Delay,
enter the Results Detail display.

The Results Detail display gives more information than a single cell can hold.
There are three ways to enter a cell’s Results Detail display from the worksheet:

� Single click on the cell using the RIGHT mouse button.

� Select a cell, then click on Results in the Button Bar.

� Select a cell, then from the View menu, choose Results Detail.

Example: Results Detail for FCC Baseband for channel 3. 

Results Detail Display
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1. Select channel 3’s FCC Baseband measurement cell.

2. Click on Results in the Button Bar. See Figure 2–21 for the dialog box.

Figure 2–21: Results Detail dialog box

3. Scroll to the right to view the Date & Time and the Test ID for these
measurements. Click on Close to return to the spreadsheet.

There is more information on this display under Results Detail Display on
page 2–56.

The cells have different colors: white, green, yellow, red, blue, or gray. These
colors indicate the range of the measurement results.

� White means that there are no limits assigned to that measurement or no
measurements have been made.

� Green means that the measurement is passing.

� Yellow means that the measurement is in the Caution range.

� Red means that the measurement has dropped into the Alarm state. The
Limits File defines these ranges. Limits are covered in Defining Limits,
page 2–73.

� Blue indicates that an error occurred in the measurement, making the results
invalid. All of the results in the cell must be in error for the cell to be blue,
otherwise the cell will take on the color of the worst case valid measurement.

� Gray cells are inactive and can have no measurements made on them. For
example, digital-only measurements are grayed out on analog channels.

Cell Coloring
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This display shows all of the measurements for many channels at a time. This
view does not give numerical results, only pass, warning, alarm, unknown/not
defined, or error-in-measurement indications based on the color of the cells.

Enter the Global View by clicking on Global in the Button Bar or, from the View
menu, choose Global View.

The display should be similar to Figure 2–22.

Figure 2–22: Global View of the spreadsheet

The colors tell the health of the system and can give you an overall view of how
the system is performing.

You can select a cell on this display and then go to the Results Detail display for
that cell by clicking on View Results Detail. Also, by selecting the entire
worksheet, you can go to the Status Report. If you select an entire row, you can
go to the Channel Summary. If you select an entire column, you can go to the
Measurement Summary.

Click on Close to close the Global View and return to the spreadsheet.

Global View
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Define and Use a Measurement Sequence
Suppose you need to make several measurements on a couple of different
channels on a regular basis. These measurements and channels are not close
enough on the worksheet to select the cells and use Current Selection from the
Measure menu. You do not have to do the measurements one cell at a time.
Instead, you can use a Measurement Sequence. A Measurement Sequence is a
list of measurements that you define and run whenever you need. You can only
define one Measurement Sequence at a time.

Now define a simple Measurement Sequence to make Carrier Level and
Frequency, FCC Baseband, and Signal to Noise measurements for your first,
third, and fifth channels.

1. Clear the spreadsheet.

a. From the Edit menu, choose Select All.

b. From the Edit menu, choose Clear.

2. From the Configure menu, choose Measurement Sequence. The Measure-
ment Sequence dialog box appears (see Figure 2–23). Which Measurements
Sequence dialog box appears depends on the Regional Setting Properties
specified in the Windows Control Panel.

NOTE. The CSS50 software also uses the Windows Regional Setting Properties to
define the display of the decimal symbol used for measurement values.

For example, setting the Regional Setting to the United States produces values
displayed as �������. Regional Settings for many countries other than the
Untied States produce values displayed as �������.

If you change the Regional Setting, you must remove the existing CSS50.ini and
ctloader.ini files and restart the CSS50 program. See page E–5 about removing
these files.

Define a Measurement
Sequence
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Measurement Sequence box with
the Windows Regional Setting

set to United States

Measurement Sequence box with
the Windows Regional Setting

not set to the United States

Figure 2–23: Measurement Sequence dialog boxes
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3. Select the Carrier Levels and Frequencies, FCC Baseband, and Signal to
Noise for channels 2, 4, and 6.

Mouse Keyboard

Double-click those cells. (To deselect:
double-click on the cell again.)

Press TAB until the cursor is in the spread-
sheet. Use the arrow keys to move to the cell,
then select the cell by pressing the spacebar.
(To deselect: press the spacebar again.)

Your dialog box should resemble Figure 2–24.

Figure 2–24: Measurement Sequence dialog box after measurements are selected

4. Click on Edit Time Parameters to display the Time Parameters dialog box
(Figure 2–25).
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Figure 2–25: Edit Time Parameters dialog box

5. Select the Run Immediately option.

6. Enter � in the Run N Times text box.

7. Enter � in the Repeat Interval text box.

8. The rest of the options in the Edit Time Parameters dialog box are gray,
indicating they are not available. Click on OK to save the changes and return
to the Measurement Sequence dialog box. Refer to page 3–55 for more detail
about the Time Parameters dialog box.

9. Click on OK to accept the Measurement Sequence. The display returns to the
worksheet.

1. Click on Meas Seq in the Button Bar or choose Measurement Sequence from
the Measure menu. The dialog box Figure 2–26 appears indicating the
sequence is running along with messages for each measurement being made.

Figure 2–26: Dialog box indicating a measurement sequence is running

Run the Measurement
Sequence
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2. If you want the Measurement Sequence to stop, click on Cancel; otherwise
allow the sequence to run. The Measurement Sequence runs through once. (It
will take a while.)

NOTE. If you would like to be able to change to another application while the
Measurement Sequence is running, before you start the Measurement Sequence,
size the window so the other application icons or windows are visible. Click on
another icon or window to change applications. You can also use ALT+TAB to
change applications. When the sequence is complete, the CSS50 application
automatically becomes the active window.

At the end of the Measurement Sequence, the dialog box in Figure 2–27
appears.

Figure 2–27: Prompt to turn on the Sequence filter

3. Click on Yes. Now only the measurements made with the Measurement
Sequence are visible and the View Filter box says that the Measurement
Sequence View Filter is on (see Figure 2–28). For more information on View
Filters, see page 2–67 in Advanced Measurements Tutorial.
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Figure 2–28: Measurement sequence results with view sequence filter on

4. Choose Measurement Sequence Results from the View menu to turn the
Measurement Sequence View Filter off and return to a normal display.

In the Measurement Sequence dialog box, there are four Auto Selection buttons
to allow you to quickly set up a Measurement Sequence to run on a regular basis.
The four buttons are FCC Pre-Converter, FCC Post-Converter, FCC Headend
Msmts, and 24 Hour Test. You can add other measurements to the sequence
either before or after choosing an Auto Selection command button.

NOTE. Non-US countries have only the 24 Hour Test button available; the rest of
the Auto Selection buttons are for FCC (a US regulatory agency) required
measurements.

Table 2–1 lists the measurements available under the Auto Selection command
buttons. They all have Carrier Levels and Frequencies for all channels. Other
measurements are for user-selected channels only.

Measurement Sequences
Using Auto Selection
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Table 2–1: Measurements executed by Auto Selection buttons 

ha el ha

Auto Selection button

Channels that
are measured

FCC 
pre-converter

FCC 
post-converter

FCC
headend 24 hour test1

All 
Channels

Carrier Levels
and Frequencies

Carrier Levels
and Frequencies

Carrier Levels
and Frequencies

Carrier Levels
and Frequencies

Selected 
Channels

ICR Carrier to
Noise Ratio

FCC
Baseband

Selected 
Channels

CSO

Selected 
Channels

CTB

Selected 
Channels

Cross
Modulation

Selected 
Channels

Hum

1 The 24 Hour Test is automatically set to run 4 times at 6 hour intervals.

Set Up an Auto Selection Measurement Sequence 

1. From the Configure menu, choose Measurement Sequence. The Measure-
ment Sequence dialog box appears.

2. Click on Clear Sequence to erase any old Measurement Sequence informa-
tion.

Mouse Keyboard

Click on Clear Sequence with the left mouse
button.

Press ALT+c.

3. Click on FCC Pre-Converter from the Auto Selection group. The FCC
Pre-Converter Measurements dialog box appears as shown in Figure 2–29.
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Figure 2–29: FCC Pre-Converter Measurements dialog box

4. Select several channels from the Available Channels list box and place them
in the Selected Channels list box. The In-Channel Response measurement
will be executed for the selected channels.

Mouse Keyboard

Double-click the left mouse button on the
channel name for single channels. For several
channels, click on the first channel with the left
mouse button, then hold down SHIFT and
click on the last channel in the list with the left
mouse button. Then choose the <–Select
command button.

Press TAB until the cursor is in the Available
Channels list box. Use the arrow keys to select
a channel or, to select several channels at a
time, hold down SHIFT while moving through
the list with the arrow keys. Add the selected
channel(s) to the Selected Channels list box
by pressing ALT+e.

5. Click on OK to return to the Measurement Sequence dialog box.

NOTE. You can add other measurements to be made on the selected channels.

The Measurement Sequence dialog box should look similar to Figure 2–30.
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Figure 2–30:  Measurement Sequence dialog box (after using Auto Selection with
additional measurements)

6. Click on OK to return to the spreadsheet.

Run an Auto Selection Measurement Sequence. You run the Auto Selection
Measurement Sequence in the same way that you run any other Measurement
Sequence by selecting Meas Seq button or selecting Sequence from the the
Measure menu.

Carrier Survey. The Carrier Survey check box in the Measurement Sequence
dialog box allows you to quickly select all of the Carrier Level and Frequency
measurements. See page 3–54 for more details on the Carrier Survey check box.
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Display the Picture (Optional)
You can see what the broadcast signal looks like while you are making measure-
ments. For example, if your first channel failed its last FCC Measurements check
and you would like to view the picture distortion, you can display the picture
directly on the computer screen. The Picture command displays the complete
active picture of the channel that the demodulator is tuned to at the time. You can
select the current channel with the Tune to Channel command.

To use the Picture command, you must have a video board and software driver
installed in your PC. (The CSS50 package does not include the video board and
driver). The video board and driver must be active when the Picture command is
called. The default driver is the Video Blaster. For information on using other
drivers, refer to page 3–37.

Use the following procedure to display your first channel:

1. From the Start task bar, start your video driver.

2. Return to the CSS50 application.

3. Configure your equipment to provide the desired video signal to the video
card in the PC.

4. From the View menu, choose Picture.

The picture is displayed on the computer screen.

5. To leave the Picture display from the control menu box in the picture
window, choose Close. Or you can hide the picture by clicking anywhere in
the CSS50 application window.

Print (Optional)
Now that you have some data to look at, it is time to print out some worksheets
and reports.

1. Check your printer setups. From the File menu, choose Print Setup. The
Print Setup dialog box appears, as shown in Figure 2–31.
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Figure 2–31: Print Setup dialog box

This dialog box is identical to the standard Windows Print Setup dialog box.
When the printer is set correctly, click on OK. The printer is now ready to use.

NOTE. As a general rule, use landscape orientation for easier-to-read reports.

Before printing out a worksheet, select the View Used option from Measurements
and Channels dialog box in the View menu. This automatically limits the display
to measurements and channels that have results.

2. From the File menu, choose Print. The dialog box shown in Figure 2–32
appears.
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Figure 2–32: Print dialog box

3. Select the appropriate options and then click on OK to print.

Click on Print in the Button Bar. The entire worksheet prints.

NOTE. The Expand Columns option in the Print dialog box expands all of the
measurements which would normally only show Pass, Caution, or Alarm, to
show all of the numerical results. For example, FCC Baseband expands to 3
columns to display all of the measurements. The columns that expand are: CSO,
CTB, Hum/LFD, FCC Baseband, and Waveform Distortion.

1. Display the Results Detail for the first channel of the FCC Baseband
measurement. (Select the cell, then click on Results in the Button Bar, or
click on the cell with the right mouse button.)

2. Click on Print in the Results Detail Display.

3. Click on Close to leave the Results Detail Display.

Print Out the Worksheet

Print Out the Results
Detail Display
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End of the Tutorial
You have completed the basic tutorial. At this point, you should be able to do the
following:

� Select cells. (See page 2–10.)

� Enter worksheet header information. (See page 2–13.)

� Make simple measurements. (See page 2–17.)

� Enter the Results Detail display. (See page 2–21.)

� Enter the Global View. (See page 2–23.)

� Define a Measurement Sequence. (See page 2–24.)

� Execute a Measurement Sequence. (See page 2–27.)

� Define a Measurement Sequence using the Auto Selection buttons. (See
page 2–29.)

� View the broadcast on the computer monitor. (See page 2–33.)

� Set up your printer. (See page 2–33.)

� Print out assorted reports. (See page 2–35.)

If you don’t feel comfortable with any of the above topics, review them before
continuing.



CSS50 Cable Television System Software User Manual 2–37

Advanced Setups Tutorial

This section explains how to set up your system to give you only the information
that you want and to give you the most accurate measurements. The following
topics are covered:

� Selecting and configuring the demodulator

� Reviewing the RS-232 and GPIB connections

� Setting how the measurements are made

� Setting the measurement setups for the 2714 or 2715

� Setting the correct VITS locations

� Attaching a different Channel Table

� Selecting whether or not to collect history

� Selecting the Power Level Units

� Turning the user prompts and alarm messages on or off

Select and Configure the Demodulator
From the Configure menu, choose Demodulator (see Figure 2–33). Next, choose
either the DS1000 or None, depending on whether a DS1000 series demodulator
is in your system. A check mark indicates the selection.

Figure 2–33: Selecting Demodulator from the Configure menu
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Connections
The first time you run the CSS50 application or any time the test equipment
connections change, choose Connections from the Configure menu to tell the
software what the instrument connections are. Figure 2–34 shows the Connec-
tions dialog box when the DS1000 series demodulator is selected. If None is
selected, then the whole Demodulator group is grayed out.

CAUTION. To ensure proper operation and prevent software conflicts, verify that
no two instruments are assigned to the same port or GPIB address. This applies
even if an instrument is not connected or used.

Figure 2–34: Connections dialog box

Configure Measurement Setups
There are many different ways that your system can execute measurements. The
Measurement Setups dialog box tells the CSS50 software how your system
needs to be set up to make measurements and to get the best results. There are
setup parameters that affect all channels and some that are channel specific.
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From the Configure menu, choose Measurement Setups, or click on Setups in the
Button Bar. The Measurement Setups dialog box looks similar to Figure 2–35.

Figure 2–35: Measurement Setups dialog box

The All Channels group contains settings that specify how measurements are
made on all channels.

2714/2715 Sub-group

� External Attenuation/Amplification. Enter the attenuation or amplification
(in dB) of the test point in this text box. For example, if you are taking
measurements at a 10 dB down test point, enter ��� dB.

The All Channels Group
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� Preamp. The Preamp allows increased sensitivity when measuring low level
signals. Select On or Off to match your measurement needs. See the 2714
manual for more information on the correct settings.

NOTE. The 2715 automatically sets the preamp as required for each measure-
ment.

� Carrier Levels Mode. These option buttons select how the Carrier Level
measurements are made. This includes both regular measurements and
Carrier Surveys. The options are given below:

Accurate Frequency and Amplitude (recommended)
Accurate Amplitude Only
Fast Amplitude Only

VM100/VM101 Sub-Group 

� Average Mode.Use averaging to reduce the effect of noise on your signal.
This selection turns Average Mode in the VM100 or VM101 on or off. If
checked, measurements will be slower (depending on the Signal-to-Noise on
the input signal) but more accurate and with less variation. If not checked,
measurements will be faster.

Power Line Frequency Sub-group 

Select the power line frequency of your system.

� 60 Hz  (60 Hz is not selectable if the channel table video standard is set to
PAL.)

� 50 Hz

Get Defaults

This command button loads all of the previously saved default values into the
All Channels group text boxes and option buttons.

Save As Defaults

This command button saves all of the current text box and option button settings
as the default values. The default values are automatically loaded whenever a
new worksheet is created. They are also available through the Get Defaults
command button.



Advanced Setups Tutorial

CSS50 Cable Television System Software User Manual 2–41

The Selected Channels group allows you to further customize measurements to
individual channels. Some reasons why you might want different setups for
different channels are: different locations of the VITS lines, no VITS signals on
some channels (measurements must be made using RF), or inability to turn the
carrier off on some channels (need to use other methods to make measurements).

In Auto mode the VM100 or VM101 finds the VITS signals if they exist. In
manual mode the VM100 or VM101 tries to make the measurement on the
specified line. In either mode, if the VITS signals are not correct, the measure-
ment will not be made. See page 3–70 for more detail about the VITS group.

To enter the Edit Setups dialog box for channel 2, double-click on channel 2 in
the Selected Channels list box or with channel 2 highlighted, click on Edit
Setups. See Figures 2–36 and 2–36 for thee Edit Setups dialog boxes for both
NTSC and PAL.

Figure 2–36: Edit Setups dialog box for channel 2 (NTSC)

Selected Channels Group
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Figure 2–37: Edit Setups dialog box for channel 2 (PAL)

Carrier To Noise Group. Select the Auto, Auto with Pause, or Gated (the 2715
calls this “in service” measurements) option button. Auto with Pause expects the
carrier to be turned off and will prompt the operator to do so. Gated (Gated
measurements are only available for the 2715) allows you to make the measure-
ments on a “quiet” or unmodulated line. (The quiet line is found in the Channel
Table Editor. See Appendix C, page C–24, for more information.) This allows
you to make the measurements without taking the system out of service.) In the
Noise Bandwidth text box, enter the bandwidth for the noise calculation.

Hum Group. Select how to make the Hum measurement. The options are to use
RF (2714 or 2715) or Baseband (VM100 or VM101). Make sure the demodula-
tor is set up correctly for Hum measurements. See page 3–76 for details.
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VM100 or VM101 VITS Group. Select Auto or Manual mode.

Auto causes the VM100 or VM101 to automatically search for the appropriate
test signals. You don’t have to enter the VITS locations. This is the recom-
mended mode

Manual always has the VM100 or VM101 use the specified line and field for the
test signal. (Field is removed if the channel table video standard is set to PAL.)
Manual mode is faster but if the required signal is not present, the measurement
will fail.

The video standard (NTSC or PAL) is defined in the channel table attached to the
current worksheet. See Appendix C: Channel Table Editor for information about
channel tables.

NOTE. The VITS group in the Edit Setups dialog box is slightly different for
CSS50 software versions below 2.0. See Appendix  H: V1.0 Software about
these differences.

CSO Group. The measurement options are: Auto, Auto with Pause, Single Sweep,
or Gated. Auto performs this measurement without turning the carrier off. Auto
with Pause expects the carrier to be turned off and will prompt the operator to do
so. Single Sweep also expects the carrier to be turned off and will prompt the
user to turn it off. It also performs all of the measurements in one sweep, instead
of one sweep for each test location. Gated means that the measurement is made
on a “quiet” (unmodulated) line. This is only available for the 2715.

Enter the frequency locations (relative to the visual carrier) where this measure-
ment should be made.

ACL Group. Measures the power in the channels adjacent to the digital channel
under test. This is a headend test with the 2715 connected to the test port of the
modulator. Select Upper to measure the power in the upper adjacent channel
only, Lower to measure the lower adjacent channel only, or Both to measure both
the upper and lower channels.

CTB Group. The measurement options are: Auto, Auto with Pause, or Single
Sweep. Auto performs this measurement without turning the carrier off. Auto
with Pause expects the carrier to be turned off and will prompt the user to do so.
Single Sweep also expects the carrier to be turned off and will prompt the user to
turn it off. It also performs all of the measurements in one sweep, instead of one
sweep for each test location.

In the text boxes, enter either the absolute or relative frequency locations
(relative to the visual carrier) where you want this measurement made.
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In-Channel Response Group. Make the In-Channel Response measurement using
either Baseband (using the VM100 or VM101) or RF methods (using the 2714 or
2715).

Enter the frequencies (relative to the visual carrier) where you want the
measurement calculated (6 locations must be entered for RF) in the Test
Locations text boxes.

If using the RF method the signal could also be gated. (Gated means that the
measurement is made on a test line and the carrier does not need to be turned
off.) The 2715 is the only instrument that can perform gated measurements.

Command Buttons for the Edit Setups for Channel XX Dialog Box. There are three
special command buttons located in the Edit Setups for Channel XX dialog box.
They are Get Defaults, Save as Defaults, and Copy to All Channels.

� Get Defaults. The Get Defaults command button takes the default Measure-
ment Setup values from the CSS50 initialization file (CSS50.ini) and places
them in the text boxes. It also sets the option buttons to the default values.
You select which groups of default values you want loaded using the check
boxes as shown in Figure 2–38.

Figure 2–38: Get Defaults dialog box

� Save as Defaults. This command button takes the current entries in the text
boxes and selections of the option buttons and stores them as the default
Measurement Setup values in the CSS50 initialization file. It only saves as
defaults, the groups selected in the check. The rest keep the current defaults.
When a new worksheet starts, these defaults load automatically. You can also
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load these defaults into selected channels using the Get Defaults command
button when editing the setups for those channels.

� Copy to All Channels. The Copy to All Channels command button takes the
settings on the current Edit Setups for Channel dialog box for the selected
groups and copies them to all of the channels. However, if the current
channel is digital, CTB and CSO setups are copied only to digital channels.
Similarly, if the current channel is analog, CTB and CSO setups are copied
only to analog channels.

NOTE. For both Save As Defaults and Copy to All Channels, the changes take
place immediately. You don’t need to wait until you exit the dialog box.

Leave the Edit Setups for Channel XX Dialog Box. Save all of the changes and
leave the Edit Setups for Channel XX dialog box and return to the Measurements
Setup dialog box by clicking on OK.

Save all of the changes, leave the Measurement Setups dialog box and return to
the spreadsheet by clicking on OK.

Attach a Different Channel Table

NOTE. The CSS50 software only recognizes a Channel Table by its name, not its
contents. It will not load a changed Channel Table into an instrument if it
already has a Channel Table by that name.

There will always be a Channel Table associated with a worksheet (the default),
so you can make measurements without changing the Channel Table. (If the
default Channel Table is corrupt or not available, the system will always try to
load the std.cht Channel Table.) Please see Appendix C or the on-line help for
more information about the Channel Table Editor. This section only deals with
changing from one Channel Table to another.

1. Choose Worksheet Info from the Configure menu. The Worksheet Info
dialog box appears (see Figure 2–39).

Leave the Measurement
Setups Dialog Box
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Figure 2–39: Worksheet Info dialog box used to change the Channel Table

2. Select a Channel Table file from the list.

3. Click on OK to save the changes and exit the dialog box. The Warning in
Figure 2–40 may appear if there are measurements in the current worksheet.
This is to remind you that you are creating a new worksheet whenever you
change the Channel Table. (Only one Channel Table is allowed in each
worksheet.)

Figure 2–40: Warning message that the worksheet has changed
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4. Click on Yes to save the old worksheet. The new worksheet, with the new
Channel Table, is <untitled>.

You are now ready to make measurements using the new Channel Table and
worksheet. If this Channel Table does not exist in the 2714/2715 (by name), the
CSS50 software will automatically load it when needed.

The DS1000 series demodulator loads the frequencies from the channel table
only as needed. It does not load the Channel Table into its own memory.

Configuration Preferences
There are several ways to configure the CSS50 application that are not directly
related to making measurements. These options are located in the Configure
menu under Preferences.

From the Configure menu, choose Preferences. The Preference dialog box looks
like Figure 2–41.

Figure 2–41: Preferences dialog box
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There are three Preferences groups. They are: Measurement History, Power Level
Units, and Measurement Execution.

This group allows you to collect history or keep only the results of the last
measurement. If you choose to collect history, the previous results are saved but
not visible on the spreadsheet. The spreadsheet is actually three dimensional (the
three dimensions are Channel, Measurement, and Time) but only two dimensions
are visible (Channel and Measurement). Only the top (most recent) measurement
of the time stack is visible on the spreadsheet. The three-dimensional spreadsheet
structure is illustrated by Figure 2–42.

Figure 2–42: A three-dimensional view of a spreadsheet

When Collect History is selected, measurement results are saved beginning with
the current measurement (what is currently in the spreadsheet).

An example of why you would want history collected on a measurement is the
24 Hour variation test. This measurement is performed by running the Carrier
Levels and Frequencies four times in a 24 hour period and comparing the
collected results. Another example is a measurement that is failing sporadically.
By taking the measurement over a period of time and collecting the history, a
trend might become evident.

The way that the history is saved is best illustrated by an example of the life of a
cell, as shown in Figure 2–43.

Measurement History
Group
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Figure 2–43: The effect of turning Collect History off and then on

The first column in Figure 2–43 shows three measurements made with Collect
History turned on. After the third measurement, the history is turned off and four
more measurements are made (for a total of seven). The results are shown in the
second column. You still have the first three measurements stored in history,
measurements four through six have been written over, and measurement seven
is presently displayed in the cell. After the seventh measurement, Collect History
is turned back on and two more measurements are made (for a total of nine). The
results are shown in the third column. The first three measurements are still there
and seven through nine are added to the history stack.

If you want to view the history of a measurement, one way is to look at the
Results Detail display. In this display, you can flip through the results to see
what the measurement results were in the past (a lot like flipping through sheets
in a log book). Refer to page 2–56 for more detail.

The option buttons select between Visual Carrier Level and Average Power
Level units in dBmV (referenced to 1 mV) or dBuV (referenced to 1 �V).

These check boxes select the following options:

� whether or not to prompt the operator to make the required equipment
connections before a requested measurement is executed

� whether or not to pause on a new channel

� the type of action to take (if any) if a measurement falls into an alarm or
caution range or has some type of error

Prompt for Signal Connection. An example of this type of prompt is a dialog box
requesting the operator to properly connect the signal under test to the test
equipment. You must click on OK to continue the measurement. This allows the

Power Level Units Group

Measurement Execution
Group
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operator to manually switch the RF signal between the 2714/2715 and demodu-
lating equipment using one RF signal tap rather than requiring a splitter.

If this option is checked and a measurement is executed that requires both RF
and baseband testing, all of the RF measurements are done first. Then all of the
baseband measurements, so the connection only needs to be changed once.

Pause on New Channel. If you want to be informed that measurements are ready
to begin on a new channel, select this check box. If it is turned on, the measure-
ments stop whenever a new channel is encountered until you click on the OK
button. One of the things this allows you to do is tune an external preselector to a
new channel.

Alarm, Caution, or Error Conditions. These check boxes allow you to be notified
in several ways if an error, alarm, or caution flag occurs during a measurement.
Three different actions can occur: a report can go out the RS-232 port, the
condition can be logged to a file, or the measurements can be stopped and an
alarm message posted. You can use any combinations of these options.

The Pause Execution check boxes stop the measurements if a measurement is
encountered that is in Alarm (cell is red), Caution (cell is yellow), or Error (cell
is blue) until the user clicks on OK. It is useful for system monitoring because it
forces you to become aware of bad or non-standard conditions.

Report out RS-232 sends a Violations Report out a Com Port (set with the
Connections dialog box). Based on the selections, the following information is
sent: Site Name, Measurement Column Heading, Channel Number, Program,
Condition Type (alarm, caution, or error), and Date/Time. This information is
tab-delimited and packetized. (For more information on intercepting an alarm,
see Measurement Execution on page 3–51.)

Log To File sends a violations report to a log file (available only if the worksheet
has been named and saved). The log file created is put in the same directory as
the worksheet file and has the same base worksheet name, with a “.log”
extension. The same information, in the same format, is logged to the file as is
sent out RS-232. There is no byte count or checksum and a CR/LF is appended
to each message.

Set the Preferences to:

� Collect History

� dBmV Power Level Units

� Prompt for Signal Connection

� Pause on New Channel

� Pause Execution — On Alarm

Set the Preferences
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1. Select the first two channels’ Carrier Levels and Frequencies.

2. From the Measure menu, choose Current Selection. First, you are prompted
to connect the 2714/2715 (see Figure 2–44). If necessary, connect the input
signal to the 2714/2715, then click on OK to continue. (Cancel stops the
measurement and returns you to the spreadsheet.)

Figure 2–44: Prompt to connect the input signal to the 2714 or 2715

The software pauses at the next channel, as shown in Figure 2–45.

Figure 2–45: Message box stating that the measurements are paused

3. If necessary, tune the preselector to the channel, then click on OK to
continue. If any of your measurement results fall into the Alarm range,
Figure 2–46 is displayed.

Make Measurements
Using the Defined

Preferences
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Figure 2–46: Message box displayed when a measurement result falls into an Alarm
range

4. Click on OK to continue making measurements. (You have another option.
You could click on Cancel to stop making measurements and handle the
measurement alarm.) When the measurements are finished with the first
channel, the Paused for Next Channel message is displayed, as shown in
Figure 2–47.

Figure 2–47: Message box stating that the measurement is paused

5. If necessary, tune the preselector, then click on OK to finish making the
measurements.
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Review
Now that you have completed this section you should be able to do the follow-
ing:

� Pick and set up the demodulator. (page 2–37)

� Review the RS-232 and GPIB connections. (page 2–38)

� Set how measurements are made. (page 2–38)

� Set the measurement setups for the 2714/2715. (page 2–39)

� Set the correct VITS location. (page 2–43)

� Attach a different Channel Table. (page 2–45)

� Select whether or not to collect history. (page 2–48)

� Select the Power Level Units. (page 2–49)

� Turn the user prompts and alarm messages on or off. (page 2–49)
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Advanced Measurements Tutorial

This section deals with advanced measurement and display topics:

� Viewing the history of a measurement

� Copying data to other Windows applications

� Viewing violations

� Using the various View Filters

� Changing and defining limits

� Defining a User Defined Program (UDP)

� Loading the results of a UDP back into the application

Reset the Preferences and Worksheet for this Chapter
1. Make a new worksheet and call it “example.wrk”. (Overwrite any old

worksheets.)

2. From the Configure menu, choose Preferences. Set Preferences to:

� Collect History

� dBmV Power Level Units

� No Prompt for Signal Connection (unless necessary for your equipment
setup)

� No Pause on New Channel (unless necessary for your equipment setup)

� No Pause on Cautions, Alarms, or Errors

� No Report Out RS-232 on Cautions, Alarms, or Errors

� No Log To File on Cautions, Alarms, or Errors

3. From the Configure menu, choose Measurement Setups. Make the appropri-
ate selections for your system.

4. From the Configure menu, choose Worksheet Info. Select the std.cht
Channel Table (or other appropriate Channel Table). Select a Site name. (The
examples use Tektronix – Beaverton.)
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1. Select the first two channels’ Hum/LFD and FCC Baseband.

2. From the Measure menu, choose Current Selection or click on Meas Sel in
the Button Bar.

3. Repeat three or four times to collect history for these measurements.

Results Detail Display
We have collected some history and are ready to view the Results Detail display.

Enter the Results Detail Display for your first channel HUM/LFD:

1. Select the Hum/LFD cell of your first channel.

2. Click on Results in the Button Bar; or click on the cell with the right mouse
button; or, from the View menu, choose Results Detail. The Results Detail
dialog box is shown in Figure 2–48.

Figure 2–48: Results Detail dialog box for the HUM/LFD measurement

Note that the Select History Next command button is gray but the Prev button is
black. This indicates that you are looking at the most recent measurement results
and there is history on that measurement.

3. Scroll the Results Detail dialog box horizontally to display the Date/Time
and Test ID. Note the time of the measurement.

4. Scroll back to the far left of the Results Detail dialog box.

1. Click on Prev. Note that this information is from the previous time you made
this measurement. Confirm this by scrolling horizontally to the Date/Time.

2. Click on Prev again.

Make Measurements to
Collect History

Look at the History of this
Measurement
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3. Repeat until the Prev command button is gray. You are now at the first
measurement for this cell on this worksheet.

4. Click on Next until you are back to the most recent measurement. (The Next
command button is gray.)

You use the Worksheet Navigation arrows to move between channels and
measurements without leaving the Results Detail Display.

1. Move to the FCC Baseband measurement for your first channel by clicking
on the right Worksheet Navigation arrow. Note that the Title Bar of the
dialog box changes to reflect the different measurement. The Results Detail
display is shown in Figure 2–49.

Figure 2–49: Results Detail dialog box for the FCC Baseband measurement

2. Move to the FCC Baseband measurement for your second channel by
clicking on the Worksheet Navigation down arrow.

3. Move to the Hum/LFD measurement for your second channel. Click on the
Worksheet Navigation left arrow.

4. Move back to where you started (Hum/LFD for the first channel). Click on
the Worksheet Navigation up arrow.

NOTE. The equipment making the measurements places the information that you
see in the Notes Field. Please see Notes under Measurement Summary on
page 3–30 for how to decode this information.

Move Around in the
Results Detail Display
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5. Click on Close to leave the Results Detail Display and return to the
worksheet.

NOTE. The active cell in the worksheet is the last cell navigated to in the Results
Detail Display.

Status Report and View Violations Displays
The Status Report is available to give an impression for how the system is doing
as a whole. The Status Report lists all of the measurements and channels with the
worst measurement results (based on the active View Filter). The Violations
Display is available from the Status Report and it lists all of the measurement
Cautions and Alarms.

1. Make all of the measurements for the first three channels. The worksheet
looks like Figure 2–50.

NOTE. In older 2714 firmware versions, anytime you are making a CSO
measurement, a message that the 2714 is executing a CTB measurement appears
on the 2714’s display. Although unexpected, it is correct and only an artifact of
the method that older firmware versions of the 2714 use to measure CSO.

Figure 2–50: The worksheet with three channels and their measurements
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2. To display the Status Report either click on Status in the Button Bar or
choose Status Report from the View menu. This displays the Status Report
dialog box as shown in Figure 2–51. The measurements are in the same
order as they are in the spreadsheet with the addition of the Visual Carrier
Level (Adjacent) results. The worst case is listed for each measurement.

Figure 2–51: Status Report dialog box

3. Click on View Violations display to see all of the measurement results that
are either in Caution or Alarm states. (See Figure 2–52.) The Violations are
first sorted by Alarms and Cautions (Alarms first), then by channel number
(same order as the spreadsheet), and finally by the measurements. In the
View Violations dialog box shown in Figure 2–52, all of the measurement
alarms for channel 2 are first, then channel 3, and so forth. From the View
Violations dialog box, you can go to the Results Detail display.
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Figure 2–52: View Violations display

4. Place the cursor somewhere in the Aural Carrier Level for Channel 2 row.

5. Either double-click the left mouse button in that cell, single-click with the
right mouse button, or click on View Results Detail (see Figure 2–53.) This
is the same Results Detail display that you would access by selecting that
channel and measurement cell from the spreadsheet and then either clicking
the right mouse button or clicking on Results in the Button Bar.
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Figure 2–53: Results Detail display

6. Close this display and return to the View Violations display.

7. Close the View Violations dialog box. You are now back to the Status
Report. Notice that you can enter the Results Detail display from this dialog
box.

8. Enter the Results Detail display for your first entry in the Status Report.
(Place the cursor anywhere in the first row. Either double click with the left
mouse button, single click with the right mouse button, or click on Results
Detail to enter the Results Detail Display.)

9. Close the Results Detail display. You are back to the Status Report.

10. Close the Status Report and return to the spreadsheet.

The Status Report and View Violations display are two nested reports or
measurement summaries of what is going on in the worksheet. Either can access
the Results Detail display for any measurement result of interest.

Print any of these by clicking on Print in the dialog box.

The View Filter also affects these displays. (See page 2–67 for more information
on the View Filter.)

If the Include History check box is selected, the results include all of the
measurement results collected. If it is not checked, then only the most recent
measurement results are included.

You know how to collect measurement results and one way to display history.
What if you want to take results that you have collected and use them for reports

Quick Summary of the
Status Report and View

Violations
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or to graph trends? You can transfer the data to other programs such as Excel or
Word, through either the Copy or Export commands.

Copy and Export
Copy and Export are the two ways of getting data out of the spreadsheet and into
other Windows applications for additional processing or to include information
in reports. Copy moves the data to the Windows Clipboard, while Export saves
the data as a results (*.wsr) file.

There are many reasons why you might want to move a few cells of data from
the CSS50 application into some other Windows application. You might want to
average some of the measurements or make a graph of some channels that seem
to be deteriorating or paste them into a report. The easiest way of getting a few
cells of data is to copy them to the Clipboard using Copy from the Edit menu.

Copy Cells to the Clipboard 

1. Select the Carrier to Noise cell for the first channel and make that measure-
ment several times.

2. With that cell still selected, from the Edit menu, choose Copy. The Copy
dialog box appears as shown in Figure 2–54.

Figure 2–54: Copy dialog box

3. Select the Export Format option button and the Include Measurement
History check box.

4. Click on OK. The information from the spreadsheet is copied to the
Clipboard.

Copy to the Clipboard
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1. Start the Excel application.

2. Select the first cell in the Excel sheet.

3. From the Excel Edit menu, choose Paste. This loads the new data into the
sheet. (You may need to change the format width of the columns in order to
read the data.) The resulting spreadsheet looks similar Figure 2–55.

Figure 2–55: The results of pasting the Clipboard data into Excel

4. Use Switch To, from the Excel Control Box, to return to the CSS50
application.

Use the Copy As Displayed Format. There is a difference between copying data As
Displayed and in Export Format. The As Displayed format will not copy any
history or header information such as Site or Test ID. In this format, only the
Measurement and Channel Header information follow the cell data. This is
useful if you only want to process the data and don’t want any additional
information.

Paste the Clipboard Data
into Excel
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1. Select the Carrier to Noise cell for the first four channels and make some
measurements.

2. With those cells still selected, choose Copy from the Edit menu. The Copy
dialog box appears as shown in Figure 2–56.

Figure 2–56: Copy dialog box

3. Select the As Displayed option button.

4. Click on OK. The information from the spreadsheet is copied to the
Clipboard.

1. Switch to the Excel application.

2. Select a cell in the spreadsheet.

3. From the Edit menu, choose Paste. This loads the new data into the
spreadsheet. Figure 2–57 shows the results. Notice the differences between
the two spreadsheets (see Figure 2–55 and Figure 2–57).

Paste the Clipboard Data
into Excel
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Figure 2–57: The result of the Copy As Displayed pasted into Excel

4. Use Excel to make a graph of the measurement results’ trend, similar to the
one shown in Figure 2–58.
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dB

Figure 2–58: Data for the Carrier to Noise Ratio for four channels
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5. Switch back to CSS50 application.

Use Export when you want to save the results to a file instead of just to the
clipboard. This is useful for archiving the measurement results without needing
to save all of the files necessary to archive an entire worksheet.

1. From the File menu, choose Export. The Export dialog box looks similar to
Figure 2–59.

Figure 2–59: Export dialog box

2. The worksheet name with a “.wsr” extension is automatically inserted in the
File Name combo box. If you want a different filename, type it in the File
Name combo box.

3. Select Include Measurement History.

4. Click on OK to export the data to a file.

5. Clear the worksheet (including history) to be ready for the next exercises.

Using Export
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View Filters
There may be times when you do not want to see the entire list of measurements
and channels on the spreadsheet, rather only the few that you are working with at
the moment. You can simplify the spreadsheet down to only the interesting cells,
through the use of three View Filters. They are: Measurements and Channels,
Sequence Results, and Test ID. These filters hide any measurements results that
you are not currently interested in. The View Filters affect most of the other
displays such as Global View and Results Detail. These displays only show the
same measurement results as the main spreadsheet.

The View Filter affects Copy operations; if you cannot see it, you cannot select
it. Export always sends the entire worksheet to the *.wsr file, regardless of the
View Filter Status.

Only one View Filter can be on at a time and the filter that is on is displayed in
the View Filter Status Box in the Worksheet Header.

If a View Filter is on, many other operations are locked out. For example, if
Measurement Sequence View Filter is on, Meas Sel from the Button Bar is
unavailable.

Set the View Filter so that only the first four measurements for the first two
channels are in view.

1. Select the Carrier Level and Frequency measurements for the first two
channels. Make the measurements.

2. From the View menu, choose Measurements and Channels. The Measure-
ments and Channels dialog box appears as shown in Figure 2–60.

Measurements and
Channels View Filter
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Figure 2–60: Measurements and Channels View Filter dialog box

3. Under the View Measurements group, select the Selected Measurements
option.

4. Select everything except Carrier Levels and Frequencies (Visual Carrier
Level, Visual Carrier Frequency, Aural Carrier Level, and Aural Carrier
Frequency) from the Selected Measurements list box. (Hint: select 2nd Aural
Carrier Level, then scroll to the bottom of the list. Hold down the SHIFT key
and click on the last measurement.)

5. Click on Unselect to remove all of these measurements. (The only measure-
ments left in the Selected Measurements list box are Carrier Levels and
Frequencies.)

6. Under the View Channels group, click on Selected Channels.

7. Select everything except the first two channels from the Selected Channels
list box.
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8. Click on Unselect to remove these channels. (Only the first two channels, 2
and 3, remain in the Selected Channels list box.) The Measurements and
Channels dialog box now resembles Figure 2–61.

Figure 2–61: Measurement and Channels dialog box

9. Click on OK to save the changes and leave the dialog box. The spreadsheet
looks similar to the one shown in Figure 2–62.
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Figure 2–62: The Spreadsheet with the Measurement and Channels View Filter on

NOTE. Notice that although the first six measurements are tied together under
most circumstances, the View Filter allows them to be viewed separately. If you
request one of these measurements, the CSS50 software will try to make all six
even if they are not in view. (It cannot make the Second Aural Measurements if
they are not enabled in the Channel Table.)

10. Return to the full spreadsheet. From the View menu, choose Measurements
and Channels. The view automatically switches back to the full display. You
can toggle between the filtered and full view by selecting/deselecting
Measurements and Channels from the View menu.

If you only want to see the results from the last Measurement Sequence, use the
Measurement Sequence Results View Filter. At the end of every Measurement
Sequence execution you are prompted if you want this filter turned on.

For example: define a Measurement Sequence, run it, and then display only its
results using the View Filter.

1. Clear the present spreadsheet. (From the Edit menu, choose Select All. Then
from the Edit Menu, choose Clear and select the check boxes to delete
Current Values and Measurement History.)

2. From the Configure menu, choose Measurement Sequence. (You are now in
the Measurement Sequence dialog box.)

3. Click on Clear Sequence to clear the Measurement Sequence.

Measurement Sequence
Results View Filter
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4. Select the following measurements for the first four channels:

� Carrier Levels and Frequencies

� FCC Baseband

� Signal to Noise

� Waveform Distortion

5. Click on Edit Time Parameters. (You are now in the Edit Time Parameters
dialog box.)

6. Select the Run Immediately check box and make sure that the Run Continu-
ously check box is not checked.

7. Click on OK to save the changes and leave the Edit Time Parameters dialog
box. (You are back to the Measurement Sequence dialog box.)

8. Click on OK save the changes and leave the Edit Measurement Sequence
dialog box. (You are back to the spreadsheet.)

9. Click on Meas Seq in the Button Bar to run the Measurement Sequence. At
the end of the Measurement Sequence, a dialog box similar to Figure 2–63 is
displayed.

Figure 2–63: Prompt to turn on the Sequence filter

10. Click on Yes to turn on the Measurement Sequence View Filter. The
spreadsheet looks similar to the one shown in Figure 2–64. Notice that there
are no Second Aural measurements. They are not enabled in this Channel
Table.
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Figure 2–64: The spreadsheet with the Measurement Sequence Results filter on

11. Turn off the Measurement Sequence Results filter. From the View menu,
choose Measurement Sequence Results. This toggles the View Filter off. You
are back to the standard spreadsheet display.

NOTE. If you went in and defined a new Measurement Sequence and ran it, then
turned on the Measurement Sequence Results filter, you will see only the results
from the last Measurement Sequence — not the old one.

There are times when you only want to see a subset of the measurements made at
a particular site. This is when the Test ID Results View Filter is useful. For
example, if Pre-Converter and Post-Converter measurements are made under
different Test IDs, then they can be viewed separately using the Test ID Results
View Filter.

You have been operating under the Test ID “Learner’s Permit.” Now change your
Test ID, make a few measurements under that ID, and look at the results using
the Test ID View Filter.

1. Click on Test ID in the Button Bar.

2. Type: ����
�
� ����	� in the text box.

3. Click on OK.

4. Select the Hum/LFD measurement for the first four channels.

Test ID Results View Filter



Advanced Measurements Tutorial

CSS50 Cable Television System Software User Manual 2–73

5. From the Measurement menu, choose Current Selection.

6. From the View menu, choose Test ID Results. The results should be similar
to Figure 2–65.

Figure 2–65: The results of turning on the Test ID Results filter

7. Click on Test ID in the Button Bar.

8. Display the selection of Worksheet Test IDs and select “Learner’s Permit”.
(The Worksheet Test IDs are the Test IDs used in the current worksheet. The
other list is all of the Test IDs ever used.)

9. Click on OK to save the change and exit the Test ID dialog box. You will
only see the measurements that you made under the Learner’s Permit Test ID
— not the Hum/LFD measurements.

10. From the View menu, choose Test ID Results to turn the View Filter off and
return to the normal spreadsheet with measurements collected from both Test
IDs displayed.

Defining Limits
Limits files determine how to characterize your measurement results. Results can
be passing, in alarm, in caution, or have no limits defined. You can change the
range of these values to suit your own application. In fact, you can have a
different set of limits for every channel. For example, the premium and the
public access channels may have their own unique Limits files.
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First, enter a Limits file to see the information contained there.

CAUTION. When you edit a Limits file, the changes affect all worksheets using
that Limits file.

1. Click on Limits in the Button Bar, or, from the Configure menu, choose
Measurement Limits. This displays the Measurement Limits dialog box, as
shown in Figure 2–66.

Figure 2–66: Measurement Limits dialog box

In the present setup, all of the channels have the same Limits file associated with
them, “ntsc.lim”. Now take a look at the contents of this file (or whatever Limits
file you might like).

2. Select a Limits file from the Limits file combo box (the example uses
ntsc.lim).

3. Click on Edit Limits File. Figure 2–67 shows the Edit Limits File – ntsc.lim
dialog box.

Edit a Limits File



Advanced Measurements Tutorial

CSS50 Cable Television System Software User Manual 2–75

Figure 2–67: Edit Limits File – ntsc.lim dialog box

Three of the columns (Range Lower Limit, Range Upper Limit, and Units)
define the allowable ranges. These columns are not editable. The other four
columns define the Alarm and Caution ranges.

The Caution and Alarm columns define the way the measurement results are
categorized. See Figure 2–68 for an example of the three types of measurements
and the different limits that they require. The Aural Frequency Offset requires
both upper and lower limits. The Carrier to Noise Ratio has only lower limits.
The ICR has only upper limits.
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Figure 2–68: How limits work

If you attempt to enter an Upper or Lower Limit outside the ranges defined, you
receive an error message (as shown in Figure 2–69) that the value is out of range
and are returned to that cell to re-enter an acceptable value.

Figure 2–69: An example of an error message

You can edit the Alarm and Caution ranges to as tight or loose a specification as
desired as long as the value is in the acceptable range and maintains the
relationship:

Alarm Lower Limit < Caution Lower Limit < Caution Upper Limit < Alarm
Upper Limit

Note that there are different measurements in the Limits file depending on the
video standard (NTSC or PAL). The video standard is defined in the channel
table attached to the current worksheet. See Appendix C: Channel Table Editor
for information about channel tables.
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Practice editing the Limits file by tightening the Alarm and Caution limits on a
few measurements and then save it as a new Limits file. (Remember, any change
that you make to a Limits file affects all channels and worksheets using that file.)

CAUTION. When you edit a Limits file, the changes affect ALL worksheets using
that Limits file.

1. Click on Clear Limits. This erases all of the old limit values.

2. Click on Get Defaults. This loads the limit values corresponding to the
default Limits file.

3. Select the Visual Carrier Frequency measurement–Caution Lower Limit cell.
(Present value is –5 in the example.)

4. Type ��. (Values automatically overwrite.)

5. Move the cursor to the Caution Upper Limit cell.

6. Type �.

7. Select the Visual Carrier Frequency measurement–Alarm Lower Limit cell.

8. Enter ���.

9. Press TAB to move to the Alarm Upper Limit.

10. Enter ��.

11. Click on Save As Limits File to save the file.

12. Save this as a new file.

13. You are prompted for a new name and the cursor is already in the list box.
Type in ���	��	
.

14. Click on OK to leave the Edit Limits dialog box. You are back to the
Measurement Limits dialog box.

1. Select the first channel on the list. (In the example, it is channel 2.)

2. Select your file “learners.lim” from the Limits list box. The selected file
appears in the box at the top of the list box.

3. Attach the file to the channel. Either double click on the file name with the
left mouse button or choose the Select Limits File command button.

The Limits file for channel 2 is now “learners.lim”.

Edit the Limits File

Attach a Limits File to a
Channel
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1. Select your second channel. (In the example, it is channel 3.)

2. Remove the Limits file associated with that file. Choose the Clear Limits
File command button. Channel 3 no longer has a Limits file associated with
it and the Limits File column is blank. (You know that a measurement has no
defined limits when the results are in white cells on the spreadsheet.)

1. Click on OK to save the changes and return to the spreadsheet. Notice that
the Alarm and Caution ranges have tightened (and may have changed colors)
and that all measurements in the second channel are now in white cells.

2. Click on Limits in the Button Bar to return to the Measurement Limits
dialog box.

3. Change your first two channels back to their previous Limits file, “ntsc.lim”.

4. Click on OK to save the changes and return to the spreadsheet.

The Summary Limits affect all of the channels and are not associated with any
particular Limits file. Edit the Visual Carrier Level Difference and the Adjacent
Visual Carrier Level Difference like any other text box. Click on the text box and
enter a number between 0.0 and 40.0 to set the Alarm and Caution flags.

The results of these limits are not available on the main spreadsheet, but rather in
the reports (such as the Status Report and the Measurement Summary for the
Carrier Levels and Frequencies).

Visual Carrier Level Difference. These calculated results look at the results of the
Visual Carrier Level measurements to find the highest and lowest level across all
channels. The difference between them is the result.

Adjacent Visual Carrier Level Difference. These are calculated results that show the
difference in Visual Carrier Level between two channels that are adjacent in
frequency.

NOTE. If you have a View Filter on so that not all channels are displayed, the
calculated results do not comply with FCC requirements, because the CSS50
software only looks at the displayed channels. Make sure no View Filters are on
when you want to check these results.

Set the Summary Limits. Click on Limits in the Button Bar. Figure 2–70 shows a
portion of the Measurement Limits dialog box.

Remove a Limits File from
a Channel

Return to the Spreadsheet
to See the Results

Summary Limits Group
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Figure 2–70: Summary Limits (located at the bottom of the Limits dialog box)

Edit the text boxes as required.

Click on Parameters to set the window for adjacent channels. This dialog box
(see Figure 2–71) defines what constitutes an adjacent channel. Any adjacent
channels that are outside of this frequency window are not included in the
calculations. Select what is required for your system and then click on OK.

Figure 2–71: Parameters dialog box

Click on OK to save the changes to the measurement limits and exit the
Measurement Limits dialog box.
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The 2714/2715 User Defined Program (UDP)
There are many times when tests need to be run at a remote location away from
the convenience of the computer running the CSS50 application, but you still
want to incorporate the data into the spreadsheet. The answer is to generate a
User Defined Program (UDP). A UDP is basically a Measurement Sequence run
on the 2714/2715 at a remote location. When the remote testing is completed,
return the results to the CSS50 application and the spreadsheets and reports are
very similar to the data collected directly with the CSS50 application. For
example: a worksheet is used to generate a UDP for the 2714/2715. The
2714/2715 is removed and taken to various field test locations, using the UDP
for measurement results gathering.

Remember that the UDP carries not only the Measurement Sequence instruc-
tions, but also much of the header and configuration information. Table 3–7, on
page 3–57, gives a complete list. It is important to check the following dialog
boxes to make sure that they describe the way that you want the UDP to operate:

� Worksheet Info, from the Configure menu (the Channel Table)

� Test ID

� Measurement Setups, from the Configure menu

� Preferences, from the Configure menu

� Edit Time Parameters (from the Measurement Sequence dialog box)

A good example of a typical UDP is a 24 Hour Test with a few extra measure-
ments specific to your application.

The following procedures describe how to define a UDP.

Define a Worksheet, Channel Table, and Test ID 

1. Choose New from the File menu.

2. In the Description group, type ��� �����

� �� ���� ��� ����������

������� ��	 �
���
���� 	��� ���� ����.

3. Select the std.cht from Channel Table in the list box.

4. Select <undefined> from the Site combo box. (There is no need to define the
Site — that information is not transferred to the 2714/2715.)

5. Click on OK to save the changes and return to the spreadsheet.

6. From the File menu, choose Save As.

7. Enter the new worksheet name �
���
����.

Define a UDP
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8. Click on OK to save the worksheet and return to the spreadsheet.

9. From the Configure menu, choose Test ID.

10. Type ���
��
�� ���	�� in the text box.

11. Click on OK to save the change and return to the spreadsheet. The Work-
sheet Header looks similar to Figure 2–72.

Figure 2–72: Worksheet header after being edited for the UDP

Define the Measurement Setups and Preferences 

1. From the Configure menu, choose Measurement Setups.

2. Set the 2714/2715 Power Line Frequency and Preamp option buttons to
match your system (at the remote location).

3. Enter the External Attenuation/Amplification in the text box to match the
remote location. (The Average group does not matter for UDPs since they
are only significant for baseband and do not apply to the 2714/2715.)

4. Select a channel from the list box, then click on Edit Setups.

5. Make the appropriate selections from the various groups.

6. Click on OK to return to the Measurement Setups dialog box. Repeat as
necessary for all channels.

7. Click on OK to save the changes and return to the spreadsheet.

8. From the Configure menu, choose Preferences.

9. Select the Collect history option.

10. Do not select any of the check boxes.

11. Click on OK to save the changes and return to the spreadsheet.

Define the Measurement Sequence 

1. From the Configure menu, choose Measurement Sequence.

2. Click on Clear Sequence to remove any previous Measurement Sequence.

3. Click on 24 Hour Test Auto Selection.
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4. Click on Create 2714/2715 UDP. The dialog box appears as shown in
Figure 2–73.

Figure 2–73: Create 2714/2715 UDP dialog box

5. Enter ������ in the text box.

6. Accept this UDP title (the same as the worksheet) by clicking on OK. The
UDP “Remote” is generated and loaded into the 2714/2715. This title
appears in the 2714/2715’s USER DEF menu.

7. The Create 2714/2715 UDP dialog box goes away if the UDP was successful
in loading; if it fails an error message appears. The most common error is
having more than nine UDPs defined in a single instrument. At the
instrument, delete one or more UDPs and then try again.

1. Take the 2714/2715 to the remote location and connect it to the test point.

2. Define the 2714/2715 SITE parameter. “Beaverton – Remote 1” is the
example. The Site name is not defined in the UDP, therefore it must be done
on location in the 2714/2715.

3. Execute the UDP using the 2714/2715 front panel keys (see the 2714/2715
“USER DEF” menu). Allow the 2714/2715 to run until all measurements are
collected. (This will take 24 hours to complete – but it can be stopped after
one iteration.)

Now that you have gathered the data, it needs to be loaded back into a CSS50
worksheet.

Run the UDP
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Get Stored Results from the 2714/2715
This menu item retrieves all the measurement results currently stored in the
NVRAM of the connected 2714/2715. The results are not erased from the
2714/2715 memory after they are retrieved. Results are only erased using
specific 2714/2715 front panel keystrokes. It is a good practice to always Import
into a new worksheet or one set up specifically for importing, so that no
information in the current worksheet is inadvertently overwritten.

1. From the File menu, choose Open.

2. Select the remote worksheet used to define the UDP.

3. Click on OK.

4. From the Measure menu, choose Get Stored Results from the 2714/2715.
Figure 2–74 shows the dialog box.

Within the dialog box, the results are grouped according to Site and Channel
Table name. The directory is alphabetical by site name. Count is the number
of measurement results contained in the group specified by the Site and Chan
Table columns. Results File is the name of the results file to which a
particular group of results has been exported.

Note that in Figure 2–74 there is no results file for the selected site. This is
because the data has not yet been exported to a results file. Before results can
be imported, it must first be exported into a *.wsr file.

Figure 2–74: Get Stored Results dialog box

5. Click on Export Results to export some results (the example uses Site 888)
into a *.wsr file. Figure 2–75 shows the Export dialog box.
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Figure 2–75: Export Results dialog box

6. Enter a name for the destination file in the File Name combo box. The
example uses the name “bringin.wsr”.

7. Click on OK. You are returned to the Get Stored Results dialog box as
shown in Figure 2–76. Notice that the Site 888 now has the bringin.wsr
results file associated with it and the Export button is disabled.

Figure 2–76: Get Stored Results dialog box (site results exported to a results file)

8. Click on Import Results to load the information into the current worksheet.
Because no Site name is defined for this worksheet, the Site name in the
exported file does not match and the warning shown in Figure 2–77 appears.
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Figure 2–77: Site name and worksheet site name mismatch warning

9. Click on Yes to continue importing the results. The Warning shown in
Figure 2–78 then appears.

Figure 2–78: Site name and imported site name mismatch warning

10. Click on Yes to change the worksheet site name to the site from the
2714/2715. Clicking on No will attribute the imported measurement results
to the Site name currently in the worksheet even if it is undefined. If the
Channel Table in the worksheet does not match the one from the 2714/2715,
the warning shown in Figure 2–79 appears.

Figure 2–79: 2714/2715 and worksheet Channel Tables mismatch warning
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11. Click on Yes. The dialog box shown in Figure 2–80 appears. This dialog box
is the result of a mismatch in the Channel Table. There will always be
mismatches in the Channel Table because the 2714 (or 2715) stores only the
channel number as the channel ID, while the CSS50 software stores channel
number, tag, program name, and nominal visual carrier.

Figure 2–80: Import Results dialog box

12. Select “Use blank channel information as wildcards” in the Import Channel
Criteria sub-group.

Note that there are three Import Channel Criteria option buttons:

� Exact channel information match only

� Use blank channel information as wildcards

� Verify mismatched channel information

Generally, when using Import to get results from a 2714 (or 2715) into a
worksheet, “Use blank channel information as wildcards” is the most
efficient option, since there will never be an exact match. Although you
could go through and verify each channel to make sure that the channel
numbers match, using the “Use blank channel information as wildcards”
selection is the most efficient way to load the data, because it reduces further
prompts.
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NOTE. Results for Channel Numbers not in the Worksheet’s Channel Table are
always ignored. You are notified that they were not loaded at the end of the
import process. Any cell without results data or in error condition will not be
imported. Cells that have more than one measurement will have all valid data
imported and the Error data results left blank. Results from a channel table that
has mismatches in the channel header, no destination channel, an inactive
destination cell, or a user requested skip will not be imported.

Keep in mind that the destination channel must also be of the same type
(analog or digital) as that of the imported data. For example, suppose the
imported data has an Average Power result on channel 63; this means that
channel 63 is a digital channel. If channel 63 in the worksheet is an analog
channel, the Average Power destination cell is inactive; thus, the channel 63
Average Power result will not be imported.

13. Select the Use Channel Results option button to load that channel’s results
and continue the import process. If there are no more mismatches, the import
process is completed when a message box similar to Figure 2–81 appears.
Make sure that the number of results transferred is similar to that listed in the
Count column of the Get 2714/2715 Stored Results dialog box shown in
Figure 2–76 (this is a cross check).

Figure 2–81: Message box that tells you that the import procedure is finished
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Overview

This chapter contains several sections that describe the CSS50 software in detail.
Three sections (Parts of the Worksheet, Control Menu Box, and Menu Bar)
provide in-depth descriptions of all the menu commands available in the CSS50
software.
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Parts of the Worksheet

This section describes the various parts of the CSS50 worksheet. Each of the
parts of the worksheet are identified in Figure 3–1.

Worksheet header

Minimize

Menu bar

Measurement
header

Channel header

Horizontal scroll bar

Cell

Button bar

View filter status box

Spreadsheet

Restore or
maximize

Vertical scroll bar

Title bar Exit

Figure 3–1: Parts of the CSS50 worksheet

 Title Bar
The Title Bar displays the name of the application that created the window. The
active application’s Title Bar is highlighted. The Title Bar is also a handle for
moving the window. Place the cursor in the Title Bar then hold down the left
mouse button to move the window to the desired position.)
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 Minimize Button
The Minimize button quickly shrinks the application to an icon, same as the
Menu Control Box command, Minimize. (See page 3–10.)

 Maximize Button
The Maximize command makes the application window fill the entire display.
(The Restore button replaces it when the window is at its maximum size.) This is
the same as the Maximize command from the Menu Control Box. (See
page 3–10.)

Restore Button
The Restore button quickly returns the application window to it previous size.
This is the same as the Menu Control Box command Restore. (The Maximize
button replaces it whenever the window is not at its maximum size.) (See
page 3–9.)

Worksheet Header
The worksheet name, Channel Table, Site, Test Id and View Filter status are all
listed in the Worksheet Header (see Figure 3–2).

Figure 3–2: The worksheet header

The worksheet name generally ends in “.wrk”. (It is good practice to make sure
that it ends in .wrk for file organization.) Change using the Save As command
(in the File menu; refer to page 3–13). This stays with the worksheet whenever it
is saved.

The Channel Table determines what channels are available. Edit using the
Create/Edit Channel Table command button in Worksheet Info, from the
Configure menu (see page 3–46) or Channel Table Editor from the Execute menu
(see page 3–77). If you change the Channel Table name, you are prompted to

Worksheet

Chan Table
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save the worksheet as a new one because only one Channel Table is allowed for
each worksheet. The Channel Table file should end in “.cht”.

NOTE. Use care when editing the Channel Table. See the warnings and
explanations in Appendix C: Channel Table Editor for more information.

Site specifies the location where the measurements take place, but there are no
defined values that this space must have. Change using the Configure menu,
Worksheet Info (see page 3–46). If you change the Site, you are asked if you
want to create a new worksheet because only one Site name can be associated
with any worksheet. If you choose not to create a new worksheet, all of the
measurement results are then associated with the new Site name.

This could be a person’s name, operator number, test session identification, or
whatever is the most appropriate for your particular application. Multiple Test
IDs for each worksheet are allowed. An example of multiple Test IDs for one
worksheet is to separate the Pre-converter, Post-converter, and 24 Hour results
from the same Site.

This box tells if a View Filter is on. The choices are: No View Filter is On, View
Selected Filter is On, View Sequence Filter is On, and View Test ID Filter is On.
Enable the View Filters through the View menu, see page 3–24.

Channel Header
This is the list of channels defined by the Channel Table. Change using the
Create/Edit Channel Table command button (from the Configure menu,
Worksheet Info, see page 3–46). There are up to four fields in each Channel cell.
They are: Number, Tag, Visual Frequency, and Program.

� Number. The number by which this channel is commonly known.

� Tag. A 3-character designation for the channel, such as “AAA” or “2-B”.

� Program. A 6-character identifier for the channel, usually used for the
channel’s call letters or abbreviated name.

� Visual Frequency. The frequency of the visual carrier.

You can edit which fields are displayed using the Row Header Fields from the
View menu (see page 3–41).

The Channel Table Editor defines these fields; see Appendix C.

Site

Test ID

View Filter Status Box
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Measurement Header
The Measurement Header is the measurement list. The measurement list includes
(additional measurements made under this Header are in parentheses):

� Visual Carrier Level

� Visual Carrier Frequency

� Aural Carrier Level

� Aural Frequency Offset

� Second Aural Carrier Level

� Second Aural Frequency Offset

� Average Power

� Carrier to Noise

� Desired to Undesired

� CSO (5 beat locations and amplitudes)

� CTB (5 beat locations and amplitudes)

� Cross Modulation

� Adjacent Channel Leakage

� In-Channel Response

� HUM/LFD (Total, Fundamental, and 2nd Harmonic)

� FCC Baseband or Primary Baseband (if non-US) 
(Chrominance/Luminance Delay, Differential Gain, and Differential Phase)

� Modulation Depth

� Aural Deviation

� Signal to Noise
If NTSC: S/N NTC-7 Lum Weighted
If PAL: S/N 567 Lum Weighted

� Waveform Distortion (2T K-factor and Luminance Non-linear Distortion)
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Vertical Scroll Bar
The Vertical Scroll Bar moves the spreadsheet up and down, allowing access to
all channels. You can either click on the up or down arrow boxes to move one
step at a time, or click and hold the box, dragging it to the desired position.

Horizontal Scroll Bar
The Horizontal Scroll Bar moves the spreadsheet right and left, allowing access
to all measurements. To use the Horizontal Scroll Bar, either click on the right or
left arrows to move one step at a time, or click and hold the box, dragging it to
the desired position.

Cursor
The cursor can take on one of several shapes depending upon the functions
available to it.

It is a cross when it is in the spreadsheet. From there it can select cells in the
spreadsheet, request a measurement on a selected cell, or go to the Results Detail
display.

It is an arrow if it is in the menu portion of the display. From there it moves
through the menu.

It can also be an hourglass. If the cursor is an hourglass, the software is busy
processing a command. You cannot request any more actions until it turns back
into either an arrow or a cross.

It can be a two-or four-headed arrow for sizing the application window.

If no mouse is available, the cursor is either a box around a cell or command
button, reversed text on the command line, reversed cells in the spreadsheet, or a
two-or four-headed arrow for sizing the window.



Parts of the Worksheet

3–8 CSS50 Cable Television System Software User Manual



CSS50 Cable Television System Software User Manual 3–9

Title Bar Menu Box

The Control menu box contains standard Windows commands used to manipu-
late the application window and change to other applications (see Figure 3–3).
Move the cursor into the title bar area and click the right mouse button.

Figure 3–3: Title Bar menu

Restore
The Restore command returns the CSS50 application window to its previous size
and position. It is often used to change an icon back into a window. It performs
the same functions as the Restore command button on the upper right hand
corner of the worksheet. (See page 3–4.)

Move
Move allows different placements of the CSS50 window. This is equivalent to
clicking on the Title Bar and holding down the left mouse button to reposition
the display. The Move command is only available if the application window is
not at its maximum size (when the Maximize button, in the upper right corner, is
available).

To use Move with the keyboard:

1. Choose Move. (Press ALT+spacebar, then type m.)

2. Press the arrow keys until the window is in the desired position.

3. Press Enter to place the window in the new position or press ESC to stop
moving the window.
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Size
Size allows you to change the size of the application window. Size is not
available when the application window is maximized. (See the Windows
manual.)

To change the size of the window using the keyboard:

1. Press ALT+spacebar to enter the Control menu box.

2. Press s to choose Size. The cursor changes to a 4–headed arrow.

3. Press the arrow keys to change the size of the window. The cursor changes to
a 2–headed arrow.

4. Press Enter to accept the new size or press ESC to cancel changing the size
of the window.

Minimize
The Minimize command changes the application to an icon. The application is
still running but it is no longer the active window. The CSS50 software stays in
the same operating state as when it was converted to an icon. This performs the
same function as the Minimize button (small box with the down arrow) on the
upper right corner of the worksheet. (See page 3–4.)

Maximize
The Maximize command changes an icon to an active window. This also changes
a sized window into one that fills the entire display. Maximize performs the same
function as the Maximize command button (small box with an up arrow) on the
upper right corner of the worksheet. (See page 3–4.)

Close
Close halts any Measurement Sequence in progress, closes the CSS50 applica-
tion window and exits the application.
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Menu Bar

The Menu Bar lists the available menus. There are seven menus: File, Edit,
View, Measure, Configure, Execute, and Help. If you are using a mouse, click on
the word with the left mouse button to open the drop down menu associated with
each. If a mouse is not available, then press ALT+the underlined letter of the
selected menu item to make the drop-down menu available. For example: to get
the File menu, press ALT+f. The following sections describe each menu item.

File
The File menu is used to open, save, import, export and print files (see Fig-
ure 3–4).

Figure 3–4: File menu

New creates a new worksheet. New automatically sets all Measurement Setups
and Limits files to defaults, not what is in the current worksheet. All results in
the current worksheet are either saved to that worksheet or deleted. New also
erases any Measurement Sequences that may have been defined.

There are three fields in the New dialog box; see Figure 3–5. The fields are: Site,
Description, and Channel Table.

New
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Figure 3–5: New dialog box

� Site. Site specifies the location where the measurements take place. The Site
field has a default value of undefined; the Site field can remain undefined.

� Description. Fill this field with anything that may be relevant to this
worksheet. For example, how certain measurements are made and the serial
numbers of the test equipment. You can copy this information to the
Windows’ Clipboard and then attach it to an Excel spreadsheet. Carriage
returns are allowed in this field.

� Channel Table. This field specifies the Channel Table for the worksheet. The
Channel Table defines the channels available, their frequencies, and other
important information. You can change or edit the current Channel Table by
using the Create/Edit Channel Table command button. Editing the Channel
Table without changing the name is not recommended. Please see Appen-
dix C for more information about editing a Channel Table.
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There are two command buttons in the Channel Table field; the command
buttons are Create/Edit Channel Table and Save As Default.

� Create/Edit Channel Table. This command button launches the Channel
Table Editor. Use the Channel Table Editor to add, delete, or change
information in a Channel Table. See Appendix C for more information on
the Channel Table Editor.

� Save As Default. This command button allows you to save the current
Channel Table as the default. This will cause the selected Channel Table to
automatically load every time the CSS50 software starts.

Opens an existing worksheet. (See Figure 3–6.)

Figure 3–6: Open dialog box

The Save command saves the changes made to the present worksheet.

The Save As command saves the present worksheet under a new name. The
worksheet name has the same naming restrictions as any other MS-DOS file (no
more than 8 characters; some names such as LPT1 are not allowed; etc.) See
Figure 3–7 for an example of the dialog box. Notice that existing worksheet
names appear in gray.

Open

Save

Save As
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Figure 3–7: Save As dialog box

The Import command brings in data from another source (see Figure 3–8). An
acceptable source is results data previously exported from the CSS50 software.
Import can be used to load data collected at remote locations such as a
2714/2715 UDP (User Defined Program). If the Channel Table or Site does not
match the present worksheet, you are asked if you want to continue importing
the results. If the Channel Table does not match and you continue to import, the
results will map to the Channel Number, skipping any channel not in the
worksheet’s Channel Table. If the Site does not match, you have the option to
choose if you want to use the worksheet Site or the imported data’s Site.

It is good practice to import into a blank worksheet to minimize the possibility
of conflicts and unexpected data placement. If you don’t write to a blank
worksheet, Import will not overwrite your work. History is automatically turned
on before an Import takes place, and turned off again when Import is complete.
For example, you have data in one cell. Import data into that cell (with Keep
only Last Result set in the Preferences menu). Your data is still there and the
imported data falls into its place in the history stack (either before or after the
current results).

The data is stored in the worksheet according to Date/Time. If the data that you
are importing is older than the current data in the worksheet, then the imported
data is not visible in the worksheet. It is available in Results Detail with View 
History turned on.

Any cell that has no results data or is in Error condition does not get imported.
Cells that have more than one measurement will have all valid data imported and
the Error data results left blank. Also, results from channels that are not in the
worksheet’s Channel Table are ignored.

Import
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The destination channel must also be of the same type (analog or digital) as that
of the imported data. For example, suppose the imported data has an Average
Power result on channel 63; this means that channel 63 is a digital channel. If
channel 63 in the worksheet is an analog channel, the Average Power destination
cell is inactive; thus, the channel 63 Average Power result will not be imported.

Figure 3–8: Import dialog box
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The Export command (see Figure 3–9) sends the results worksheet data out to a
“.wsr” file, so that other applications, such as Excel, can process the data.

Figure 3–9: Export dialog box

The export file includes all Worksheet Header information.

If only certain cells need to be exported, use Copy (under Edit; see page 3–21)
and copy the data to the clipboard.

The main difference between using Copy from the Edit menu (Export Format
option) and using Export is that Export sends data to a named file while Copy
copies the data to the clipboard.

The Print command sends the spreadsheet to the printer. (See Figure 3–10.)
Within the Print dialog box, the Setup command button is identical to choosing
Print Setup from the File menu.

Export

Print
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Figure 3–10: Print dialog box

The Print dialog box allows you to choose if you are going to print out the
worksheet as it appears in the display or with certain columns expanded to
display additional information.

If you do not use the Expand Columns option, the measurement results cells
print just as they are shown in the worksheet. The main concern with using this
method is that some cells only display PASS, CAUTION, or ALARM. You may
need more information.

Printing using Expand Columns fills in all cells with detailed measurements that
would otherwise print only pass/fail. The columns that expand are: CSO, CTB,
Hum, FCC Baseband, and Waveform Distortion. A concern with using this
format is that it produces long reports. (See Table 3–1.) What is printed from
each cell in the expanded mode is all of the results that you would normally find
in the Results Detail display. Since printing using Expand Columns creates such
a long printout, you should use the Measurements and Channels View Filter
from the View menu to limit the measurements printed in each worksheet. For
example, to print out all of the information from a worksheet in a more useful
format, you might print one expanded worksheet of the RF measurements and
one for the Baseband measurements.

NOTE. To print some reports (ones with many columns), you may want to change
from portrait to landscape orientation. Use the Print Setup command to make
the required changes.

You can save paper if you only print out measurements and channels that have
results associated with them. Use the View Used command button from
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Measurements and Channels dialog box in the View menu. (See page 3–37 for
more details.)

Table 3–1: Measurements under each measurement header 

Measurement header Measurements under the measurement header

Visual Carrier Lev (dBmV) Visual Carrier Level (dBmV)

Visual Carrier Freq (MHz) Visual Carrier Frequency (MHz)

Aural Carrier Lev (dBc) Aural Carrier Level (dBc)

Aural Frequency Offset (MHz) Aural Frequency Offset (MHz)

2nd Aural Carrier Lev (dBc) 2nd Aural Carrier Level (dBc)

2nd Aural Frequency Offset (MHz) 2nd Aural Frequency Offset (MHz)

Average Power (dBmV) Average Power (dBmV)

Carrier to Noise (dB) Carrier to Noise (dB)

Desired to Undesired (dB) Desired to Undesired (dB)

CSO (dBc) CSO Loc 1 (dBc)

CSO Offset 1 (MHz)

CSO Loc 2 (dBc)

CSO Offset 2 (MHz)

CSO Loc 3 (dBc)

CSO Offset 3 (MHz)

CSO Loc 4 (dBc)

CSO Offset 4 (MHz)

CSO Loc 5 (dBc)

CSO Offset 5 (MHz)

CTB (dBc) CTB Loc 1 (dBc)

CTB Offset 1 (MHz)

CTB Loc 2 (dBc)

CTB Offset 2 (MHz)

CTB Loc 3 (dBc)

CTB Offset 3 (MHz)

CTB Loc 4 (dBc)

CTB Offset 4 (MHz)

CTB Loc 5 (dBc)

CTB Offset 5 (MHz)

Cross Modulation (dBc) Cross Modulation (dBc)
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Table 3–1: Measurements under each measurement header (cont.)

Measurement header Measurements under the measurement header

Adjacent Channel Lkg. (dBc) Adjacent Channel Leakage (dBc)

In-Channel Response (dB) In-Channel Response (dB)

HUM/LFD (%) Hum/LFD (%)

Hum/LFD Fundamental (%)

Hum/LFD Second Harmonic (%)

FCC Baseband Chroma-Lum Delay (nS)

Differential Gain (%)

Differential Phase (Deg)

Modulation Depth (%) Modulation Depth (%)

Aural Deviation (kHz) Aural Deviation (kHz)

Signal to Noise
(NTSC)

S/N NTC7 Lum Weighted (dB)

Signal to Noise
(PAL)

S/N 567 Lum Weighted (dB)

Waveform Distortion 2T K-factor (%Kf)

Lum Non-linear Distort (%)
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Sets up the printer so that it can properly print worksheets and reports. (See
Figure 3–11.) This is identical to the standard Windows’ printer setup. Please see
the Windows User’s Guide or on-line Help for more information.

Figure 3–11: Print Setup dialog box

NOTE. Most worksheets and reports are more readable if printed using Land-
scape orientation.

Exit closes the CSS50 application.

Print Setup

Exit
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Edit
The Edit menu is used to manipulate the contents of selected cells (see Fig-
ure 3–12).

Figure 3–12: Edit menu

The Copy command (see Figure 3–13) copies the contents of the selected cells to
the Windows Clipboard. You are prompted if you want the cells in Export format
or As Displayed. If you select Export format, you also have a choice of whether
to include the measurement history (if Collect History is selected under
Preferences in the Configure menu). In Export format, not only is the displayed
cell data copied to the clipboard, but also the Results Detail information. If you
chose the As Displayed format, only the data in the selected cells along with the
Measurement and Channels Headers are copied to the clipboard. The result of
copying one cell with history (using export format) into Word for Windows is
given in Table 3–2.

Figure 3–13: Copy dialog box

Copy
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Table 3–2: The results of copying one cell with history into Word for Windows 

Worksheet
File

Site

Tektronix
Beaverton

Channel
Table

Video Stan-
dard

Aural Off-
set

2715.cht NTSC .5

Channel Freq Program Viol LL UL S/N
Weighted
(dB)

Viol LL UL Notes Date/
Time

Test ID

2 .25 ** .8 ** 9/7/1997
13:44:35

Training
Wheels

2 .25 .2 9/7/1997
13:44:22

Training
Wheels

2 .25 .3 9/7/1997
13:44:18

Training
Wheels

2 .25 .7 9/7/1997
13:42:53

Training
Wheels

Below is a description of how Table 3–2 was created:

1. Select one cell from the worksheet.

2. Choose copy from the Edit menu.

3. Select Export format and include measurement history.

4. Choose OK.

5. Open the desired Word for Windows document.

6. Place the cursor in the desired location in the Word document.

7. Choose Paste from the Edit menu, placing the cell information into the
document.

8. Select all of the data that was just pasted into the document.

9. From the Table menu, choose Convert Text to Table.

10. Select “Tabs” as the column spacer.

11. Choose OK.

12. Adjust the column width as necessary.

The As Displayed format only copies the displayed cell contents and Channel
and Measurement Headers associated with the selected cells to the clipboard.



Menu Bar

CSS50 Cable Television System Software User Manual 3–23

The results of copying one cell using the As Displayed format are shown in
Table 3–3.

Table 3–3: Results of copying a cell using the As Displayed format 

Carrier to Noise (dB)

2 55.25 41**

The Clear command (see Figure 3–14) deletes the current value and/or all history
for the selected cells. There is always a warning to verify that you really want to
delete the contents of the cells. Select Cancel if you do not want results deleted.

Figure 3–14: Clear dialog box

The Select All command selects all of the cells in the spreadsheet. If you are
using a mouse, you can obtain the same results by clicking the left mouse button
on the upper left corner of the spreadsheet.

Clear

Select All
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View
The View menu (see Figure 3–15) allows you to see the spreadsheet data
presented in several different ways, such as filtered or consolidated into reports.

Figure 3–15: View menu

Choosing Status Report from the View menu (see Figure 3–16) is the same as
choosing the Status command button on the Button Bar (see page 3–79). A
shortcut for getting to this display is to click the right mouse button on the upper
left corner of the spreadsheet. Any of these methods displays the Status Report
for the current worksheet.

Status Report
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Figure 3–16: Status Report dialog box

The Status Report lists the extremes for all of the measurement results. It is
basically a summary of all Measurement Summaries (see page 3–33). Table 3–4
lists the measurement results given in the Status Report. If there are no results
for a measurement, it is skipped in the Status Report. You can limit the channel
and measurements in the Status Report by using the View Filters (see Measure-
ments and Channels on page 3–37). Optionally, you can include the measure-
ment History.

Table 3–4: The Measurement summaries in the status report 

Measurement Max Min
Max-
Min

Max
Dev

Max
Abs

Visual Carrier Level (dBmV or dBuV)1 x x

Visual Carrier Level Diff. (dB)2 x

Variation (dB)3 x

Visual Carrier Level Adj. (dB)4 x

Visual Carrier Frequency (MHz)5 x

Aural Carrier Level (dBc) x x

Aural Frequency Offset (MHz)6 x
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Table 3–4: The Measurement summaries in the status report (cont.)

Measurement
Max
Abs

Max
Dev

Max-
MinMinMax

2nd Aural Carrier Level (dBc) x x

2nd Aural Frequency Offset (MHz) x

Average Power (dBmV or dBuV)1 x x

Carrier to Noise (dB) x

Desired to Undesired (dB) x

CSO (dBc) x

CTB (dBc) x

Cross Modulation (dBc) x

Adjacent Channel Leakage x

In-Channel Response (dB) x

Hum/LFD (%)7 x

Chroma-Luma Delay (nS) x x

Differential Gain (%) x x

Differential Phase (Deg) x x

Modulation Depth (%) x x

Aural Deviation (kHz) x x

S/N NTC7 Lum Weighted (dB)8 x

S/N 567 Lum Weighted (dB)9 x

2T K-factor (%Kf) x

Lum Non-linear Distortion (%) x
1 Absolute power level.
2 Difference between the maximum and minimum values of all channels measured.
3 If four or more Visual Carrier Levels measurements are being summarized for a

single channel. Difference between the maximum and minimum values for the
several measurements done over time on a given channel. (Variation appears only if
Collect History is selected in the Preferences dialog box.)

4 Maximum difference between two adjacent channels. See Summary Limits Group
(page 2–78 ) to set limits, a definition of Adjacent, and types of channels to include.

5 Maximum deviation from nominal as defined in the Channel Table. The value shown
is the measured frequency, the violated limits are shown as nominal + limit offset as
defined in the Limits file. Variations always include both current and all previous
data, whether history is selected or not.

6 Maximum deviation from nominal as defined in the Channel Table.
7 Total Hum.
8 NTSC systems only.
9 PAL systems only.
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The Result column (see Figure 3–16 on page 3–25) is color coded in the same
manner as the worksheet: green is passing; yellow is Caution; red is Alarm; and
white is no limits defined or no measurements made. Blue is an error.

Blue indicates that an error occurred in the measurement, which makes the
results invalid. The cell will be blue only if all of the results in the cell are
invalid. If any of the results are valid, the cell takes on the color for the worst
case valid measurement. If a measurement is invalid, <undefined> is loaded in
the Results Displays.

The * and ** column replaces the color information on a monochrome display.
The * symbol means that the measurement was in the caution range, while **
means that the measurement was in the alarm range.

Violated Lower Limit is filled in with the lower limit if it was exceeded or
Violated Upper Limit is filled in with the upper limit if the Upper limit was
exceeded.

The 24 Hour Carrier Level Variation is in the Status Report only if there are at
least 4 measurements in the last 24 hours on a single channel, whether or not
history is selected. This is the channel with the worst 24 hour Carrier Level
variation.

There are two command buttons: View Violations and View Results Detail. The
View Violations display is explained next. (Results Detail is explained on
page 3–28.)

View Violations. Display the View Violations dialog box by choosing the View
Violations command button on the Status Report. This dialog box shows all the
measurements and channels that are in error. (They have either a single or double
asterisk, * or **.) Only the individual measurements are in this display (see
Figure 3–17). Passing measurements are not shown here, as they are not in
violation.

This display is sorted by Alarm/Caution, then channel number, and finally by
measurement.

This display can also go to the Results Detail display for a selected cell by using
the View Results Detail command button or clicking the right mouse button on
the desired cell. (Results Detail is explained on page 3–28.)

Return to the Status Report dialog box by choosing the Close command button.
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Figure 3–17: View Violations dialog box

The Results Detail dialog box (see Figure 3–18) displays more information about
a measurement than can be contained in a cell on the spreadsheet. For example:
the FCC Baseband measurement only gives a pass/caution/alarm indication on
the spreadsheet. The Results Detail display lists all the measurements under this
group, along with the numerical results. You can also view the history of the
measurement by using the Next and Previous command buttons.

Results Detail
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Figure 3–18: Results Detail dialog box

You can get to the Results Detail dialog box many ways:

� Click the right mouse button on a cell in the spreadsheet.

� Press the Results command button on the Button Bar.

� Choose Results Detail from the View menu.

� Click on View Results Detail in the Status Report.

� Click the right mouse button on a cell in the Status Report.

� Click on View Results Detail in View Violations.

� Click the right mouse button on a cell in View Violations.

� Click on View Results Detail in the Global View.

� Click the right mouse button on a cell in Global View.

Worksheet Navigation. Use the four arrows to move around in the spreadsheet
while staying in Results Detail. The type of View Filter determines where the
channel and measurement the navigation arrows take you. You cannot move to a
channel or measurement that is not displayed.

� Up arrow. Moves up a channel while staying in the same measurement.

� Down arrow. Moves down a channel while staying in the same measurement.

� Left arrow. Stays in the same channel but moves left one measurement.

� Right arrow. Stays in the same channel but moves right one measurement.
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Select History. Use these command buttons to display measurement history:

� Prev. This command button selects the previous measurement results
(history).

� Next. This command button selects the next most recent measurement
(history).

Measurement Summary. The summary lists the results for each measurement:

� Measurement. Lists the measurements contained under the Measurement
Header in the spreadsheet. For example, FCC Baseband has Chrominance to
Luminance Delay, Differential Gain, and Differential Phase.

� Result. Lists the numerical results of a measurement.

� * and **. Flags whether a given measurement was in violation of either the
Caution limits (*) or the Alarm limits (**).

� Violated Lower Limit. If the results violated the lower limit defined by the
Limits file, then the limit is printed in this column.

� Violated Upper Limit. If the results violate the upper limit defined by the
Limits file, then the limit is printed in this column.

� Date/Time. Date and time of the measurement. This comes from the internal
clock of the instrument making the measurement, unless the measurement is
invalid (an error), then the time comes from the PC. (Use the horizontal
scroll bar to view this column.)

� Test ID. The Test ID when the measurement was made. (Use the horizontal
scroll bar to view this column.)

� Notes. Notes from the test equipment about how a measurement was made.
One note is available for each cell, so it is replicated for each measurement
within a cell. Table 3–5 lists the notes that the instruments (either the 2714
or 2715 or the VM100 or VM101) place in the Notes field for each of the
different measurements.

If the measurement cannot be made, an event number (error number) appears
in the notes field. If the event came from the 2714 or 2715 then it would
appear as “2714/2715 E:###” . If the event came from the VM100 or
VM101 then it would appear as “–###; message” . Use the event
number to cross reference to the instrument documentation (the 2714 and
2715 Spectrum Analyzer Programmer manual or the VM100 or VM101
Video Measurement Set user manual) to find out what failed during the
measurement.

If an RS-232 communication error occurs, a communication error is reported
in the Notes field. If a communication error occurs during a measurement,
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the spreadsheet cell turns blue (error). In the Results Detail view, the
measured value may be displayed but it might not be correct.

Table 3–5: Explanation of the Notes Field 

Measurement Notes field1 Meaning

Visual Carrier Level sddd.d dB ext ofst 2 External attenuation or amplification in dB

Visual Carrier Frequency —

Aural Carrier Level —

Aural Frequency Offset

Average Power sddd.d dB ext ofst 2 External attenuation or amplification in dB

Carrier to Noise sddd.dZ ddd.dZ � 3 Noise Bandwidth and Noise Frequency (in Hz) and 2 dB flag 4 G if gated

Desired to Undesired ddd.dZ �3 Noise Bandwidth (in Hz) and 2 dB flag

CSO #Loc � #Loc  �
Example: 1A� 3R� 4R� 3

#Loc #Loc #Loc  � 3

Stored only

Interactive only

Beat number, location type, and 2 dB flag 4

CTB Same as CSO Beat number, location type, and 2 dB flag

Cross Modulation —

Adjacent Channel Leakage � 3 2 dB flag

In-Channel Response 5,7 sddd.dZ/sddd.dZHz G### 6 Min/Max Frequency Offset and signal type (RF)
G### is the line number of the test line

Fd:dd Test Signal Field, Line #, and Test Signal (BB)

Hum/LFD7 60 Hz (or 50 Hz) Power RF (or
BB)

Line Frequency and signal type (RF or baseband)

ZCR pulse not found The Zero Carrier Reference Pulse was not found. See page 1–7 for
information about setting the ZCR pulse.

FCC Baseband 7 fd:dd Test Signal

Example: F1:16 FCC Compos

Any note is from the VM100 or VM101

Field 1, Line 16, Test signal is FCC Composite

Modulation Depth —

Aural Deviation —

Signal to Noise 7 fd:dd Test Signal

Example: F1:16 FCC Compos

Any note is from the VM100 or VM101

Field 1, Line 16, Test signal is FCC Composite
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Table 3–5: Explanation of the Notes Field (Cont.)

Measurement MeaningNotes field1

Waveform Distortion 7 fd:dd Test Signal

Example: F1:16 FCC Compos

Any note is from the VM100 or VM101

Field 1, Line 16, Test signal is FCC Composite
1 s = sign (+ or –)

d = decimal number
Z or ZHz = frequency (Hz) in engineering notation (kHz or MHz)
# = 1 –5
Loc = A(bsolute) or R(elative)
RF or BB = signal Type RF or Baseband

2 This note is not available for stored measurements retrieved from the 2714 or 2715.
3 If an asterisk is present, the measured value is within 2 dB of the analyzer noise floor. The actual value may be better

than the one indicated.
4 The results of the Carrier to Noise and CSO measurements may be 1000 larger than measurement. This indicates that the

Quiet Lines measured were no longer quiet at the end of the test. The true answer may be better than the one indicated.

The results of the Carrier to Noise and CSO measurements may also be 2000 larger than measured. This indicates that
the mixer level was raised above the optimum to allow the video modulator board to work. The true answer may be better
than the one indicated.

Note also that the 1000 and 2000 flags are additive, so the result could be 3000 above what was measured indicating that
both conditions occurred.

5 The RF or BB signal type indicator may not appear if both offset frequencies are negative. The In-Channel Response
Frequency range is not available for stored measurement retrieved from the 2714.

6 G### is only inserted from the 2715.
7 The most common error messages from the VM100 or VM101 are:

–322 Improper VITS Using the VM100/VM101 manual VITS mode, the line
entered to make a measurement on did not contain a
proper VITS signal.

–325 No VITS signal Using the VM100/VM101 auto VITS mode, an appropriate
VITS signal on this channel could not be found.

–361 No Video The VM100/VM101 was not able to lock onto a video signal.
Check the cable connections.

Exceptions. The Results Detail display generally only gives the results for a
single cell; the exception to this is for the first six cells: the Visual and Aural
Carrier Levels and Frequencies. These measurements are grouped together into
one Results Detail display. Also if there are four or more of the measurements
made in the last 24 hours, then a summary of the Carrier Levels measurements
over the past 24 hours is provided. The summary includes the total visual carrier
level variation and each individual measurement value with a Time/Date stamp.
(See Figure 3–19.)
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Figure 3–19: The 24 hour Carrier Summary display

Select an entire spreadsheet row or column, click on Results (or click on the
Measurement or Channel Header with the right mouse button), then you can
access special displays called Channel Summary (row selected) or Measurement
Summary (column selected). (A right mouse click on the Channel or Measure-
ment Header name also accesses these reports.) These displays are a cross
between Status Reports and Results Detail displays. The View Filter affects these
displays. Information in hidden rows or columns is not contained in the
Measurement or Channel Summaries. The results contained in the measurement
history can also be incorporated into these summaries.

The Channel Summary (see Figure 3–20) displays violations for the selected
channel. You can move to a different channel by using the Select Channel
navigation arrows. You can also select a cell and view the Results Detail for the
measurement for that channel.

Measurement and
Channel Summaries
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Figure 3–20: Example of a Channel Summary

The example in Figure 3–20 gives the Visual Carrier Level Variation. This
information is always present in a Channel Summary if there are four Visual
Carrier Level measurements in a 24 hour period, regardless of whether or not
Include History is selected.
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The Measurement Summary (see Figure 3–21) gives the Status Report informa-
tion for just the selected measurement. You can move to other measurements
using the Navigation arrows. The View Violations command button will go to
the View Violations display for only the selected measurement. The View
Results Detail command button goes to the Results Detail display for the
selected channel measurement. If the Include History check box is checked, then
the worst case of the measurement in this worksheet is displayed. Otherwise, the
worst-case current measurement results are displayed.

Figure 3–21: Example of a Measurement Summary
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 This is a condensed view of the standard spreadsheet display (see Figure 3–22).
All of the measurements and channels are in the same order as the spreadsheet.
This view allows for a quick overview of how the system is doing as a whole.
White blocks indicate that there are no defined limits, or no measurement results.
Green blocks mean the measurement is passing. Yellow blocks indicate that the
measurement is in the Caution range. Red blocks indicate that the measurement
has violated the Alarm limits. Blue means that an error occurred in making the
measurement and the results are invalid. Gray means that the measurement
cannot be performed on that channel (analog–only measurement cannot be taken
on digital channels and digital–only measurements cannot be taken on analog
channels). See Appendix C, Channel Table Editor, for more details on this
Channel Table field.

Figure 3–22: Global View dialog box

Access the Result Detail display along with the Channel and Measurement
Summaries (see page 3–28) from the Global View by selecting a cell, a row, or a

Global View
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column and clicking the right mouse button. You could also use the View Results
Detail command button.

Access the Status Report from the Global View by clicking the right mouse
button at the intersection of the Measurement and Channel header.

The 2714/2715 Screen command displays a copy of what is presently on the
2714 or 2715 screen. This includes displayed traces and readouts.

NOTE. Place the analyzer in Single Sweep mode and be sure the current sweep is
complete before requesting a 2714/2715 Screen. If the analyzer is not in Single
Sweep mode and the current sweep is not complete, there may be inconsistencies
between the marker readout text, the marker positions, and the waveforms,
because the analyzer updates these values asynchronously with respect to the
query for the values.

The Picture command displays a video picture of what is presently on a given
channel (shows a complete active picture). To use the Picture command, you
must have a video board and software driver installed in your PC. (The CSS50
package does not include the video board and driver). This default driver is the
Video Blaster. The video board and driver must be active when the Picture
command is called. The displayed picture is the video source connected to the
video board.

The CSS50.INI file must be edited if any driver other than the Video Blaster is
used. The line “Video Driver=XXXXXX” in the CSS50.INI file must have the
XXXXXX changed to match the title that appears in your video driver’s Title
Bar.

Any other details about the operation of Picture are controlled by your video
driver.

Use ALT+TAB to jump between the video driver application and CSS50
application.

This is a View Filter that determines which channels and measurements are on
the spreadsheet (see Figure 3–23). There are All and Select options for both
measurements and channels. You can select whatever measurements and
channels are important to view at the moment without “losing” any measure-
ments. This allows you to configure the spreadsheet to show only what you need
to see at the moment and eliminate all extraneous information without deleting
anything. All View Filters are mutually exclusive.

2714/2715 Screen

Picture

Measurements and
Channels
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Figure 3–23: Measurements and Channels dialog box

The View Filter status box displays the following message when this filter is on:
View Selected Filter is On. The spreadsheet looks like Figure 3–24 when the
Measurement and Channel View Filter is selected as shown in Figure 3–23.
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Figure 3–24: Worksheet with Measurements and Channel View Filter on

To turn this View Filter off, select the Measurements and Channels command
from the View menu.

NOTE. You cannot select a measurement or channel unless it is viewable.
Therefore, if only some channels and measurements are in view and the Select
All command (from the Edit menu) is used, the “hidden” measurement cells are
not selected. The exception to this rule is the Carrier Level and Frequency
measurement. If you select one of the six measurements, all these measurements
are made, whether they are visible or not.

If you select all channels, by clicking on one of the Carrier Level and Frequency
Measurement headers and the Average Power header, you are still given the
option to do a Carrier Survey, even if all channels are not viewable.

When you return to All for the Measurements and Channels options, the list of
selected measurements and channels remains. You can toggle between the
filtered and full display quickly.

If the View Filter is on and you are trying to Import results that would enter a
hidden row or column, you are warned that all of your imported results are not
immediately viewable.

You can switch to any other View Filter by choosing it from the View menu.

There is a special command button, View Used, for this dialog box. This
command allows you to automatically filter out all channels and measurements
that have no results. View Used is particularly useful for printing out worksheets.
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Use this command button immediately before printing reports to minimize the
amount of blank space.

NOTE. The View Filters also affect the Status Report, Measurement Summaries,
Channel Summaries, and the Results Detail display.

When this filter is active, only those measurements made with the most recent
Measurement Sequence execution are on the spreadsheet. The measurements
displayed are not necessarily the current Measurement Sequence. (See page 3–53
for how to define a Measurement Sequence.) For example, if you have defined
and executed a Measurement Sequence that only measures the Signal to Noise
Ratio for four selected channels, then only those four channels’ S/N measure-
ments are displayed on the spreadsheet when this View Filter is on. The rest of
the measurements are only hidden. They are still part of the worksheet and are
available as soon as the Measurement Sequence Results filter is switched off.

If no measurements on the worksheet are associated with a Measurement
Sequence, then you will get a warning message (see Figure 3–25) telling you that
there are no measurement results associated with a Measurement Sequence and
therefore the View Filter will not be applied.

Figure 3–25: No measurements for sequence message

The View Filter status box has the message View Sequence Filter is On, and
there is a check mark in front of Measurement Sequence Results in the View
menu. To turn the View Filter off, just choose Measurement Sequence Results
from the View menu again, or choose any other View Filter.

The following is a list of commands that are disabled when the Measurement
Sequence View Filter is on:

� Import, from the File menu

� Current Selection from the Measure menu and Meas Sel from the Button Bar

Measurement Sequence
Results
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� Double click on a cell to make a measurement

� Get Stored Results from the 2714 or 2715, from the Measure menu

These commands are disabled because the results are not immediately viewable.

You can switch to any other View Filter by choosing it from the View menu.

This View Filter only displays cells that have measurements tagged with the
currently displayed Test ID. Therefore, if only a few of the measurements on the
current worksheet were made under the current Test ID, then only those few
measurements are displayed. If no measurements on the worksheet were made
under the current Test ID, then a warning message is displayed that there are no
measurements with that Test ID and will not apply the Test ID filter. (This is the
same warning message as Measurement Sequence Results.) Select the Test ID
using the Configure menu. (See page 3–48.)

If the Test ID View Filter is on, then the View Filter Status Box contains the
message View Test ID View Filter is On. There is also a check mark in front of
Test ID Results in the View menu. To turn the Test ID View Filter off, choose
Test ID Results from the View menu again or choose another View Filter.

If the Test ID Results View Filter is on and you are trying to import results that
would enter a hidden row or column, you are warned that all of your imported
results are not immediately viewable.

You can change which Test ID you are viewing. In the Test ID dialog box, select
one of the Used in Worksheet Test IDs and the View Filter will automatically
switch to that Test ID. You can only select from the Used in Worksheet Test IDs.

The Row Header Fields command allows you to select what information is given
in the Channel Header (see Figure 3–26). You can display the Channel Number
& Tag, the Program Name, and/or the Channel Frequency. You must select at
least one. Initially all three options are always chosen. When all three are
selected, the Header column width is slightly larger than if one or two of the
options is selected.

Figure 3–26: Row Header Fields dialog box

Test ID Results

Row Header Fields
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NOTE. There is no Program Name for any channel in any Channel Table as
shipped from Tektronix. Use the Channel Table Editor to add the Program
Names as needed.

Measure
The Measure menu (see Figure 3–27) is used to make measurements, tune the
demodulator and the 2714 or 2715 to a specific channel, and recall results from
2714 or 2715.

Figure 3–27: Measure menu

The Current Selection makes the measurements for the selected cells. This is true
with the exception of the Visual, Aural Carrier Level, and Frequency cells. Select
any of these measurements and all six are performed for the channel. To perform
all measurements for a single channel, select the entire row. Conversely, if you
want one measurement for all channels, select the entire column. This is the
same as Meas Sel from the Button Bar (see page 3–79). For a single cell, you
can achieve the same result as Current Selection by double-clicking on the cell
with the left mouse button. For a single row or column, you can achieve the
same results by double-clicking on the measurement or channel name.

If at least one of the Carrier Levels and Frequencies measurements (Visual
Carrier Levels, Visual Carrier Frequency, Aural Carrier Level, Aural Frequency
Offset, Second Aural Carrier Level, or Second Aural Frequency Offset) is
selected for all analog channels and Average Power measurements are selected
for all digital channels, a message is displayed to allow the user to do a Carrier
Survey instead of a series of individual carrier level and Average Power
measurements.

Current Selection
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The advantages and disadvantages of selecting the Carrier Survey are listed
below.

Advantage:

� Faster measurement execution

Disadvantages:

� The Pause For New Channel preference will not pause for new channels
within the survey

� All measurement results are tagged with the same date and time

� The CSS50 display is not updated until the survey is finished. (You might
think that the software has crashed.)

Whether you select individual measurements or the survey, the measurements
will still be made in the mode specified in the Measurement Setups dialog box.

If a Measurement Sequence is available (see Measurement Sequence, page 3–53),
then selecting Sequence performs the Measurement Sequence. This is the same
as clicking on Meas Seq in the Button Bar (see page 3–79).

Note that the computer is not strictly dedicated to the CSS50 application while
performing a Measurement Sequence. You can switch to other applications
during a Measurement Sequence.

Tune to Channel tunes the demodulator and the 2714 or 2715 to the selected
channel. It will also set the Channel Table in the instrument, if it is not already
active. Select the channel by selecting a cell from the desired channel, then
choose Tune to Channel. It will report an error if the channel cannot be tuned.

Use this menu item (see Figure 3–28) to retrieve all the CATV measurement
results currently stored in the NVRAM of the connected 2714 or 2715. The
Notes field is not as complete as if it was done directly from the CSS50
application. The results are not erased from the 2714 or 2715 memory after they
are retrieved. Results can only be erased using specific 2714 or 2715 front panel
keystrokes.

Sequence

Tune to Channel

Get Stored Results from
2714/2715
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Figure 3–28: Get Stored Results dialog box

Since results from the 2714 or 2715 can come from multiple Channel Tables and
Sites, the measurement results are grouped according to Site and Channel Table
name. Ordering within the directory is alphabetical by site name. Count is the
actual number of measurement results contained in the group specified by the
Site and Chan Table columns. Results File is the name of the results file to
which a particular group of results has been exported.

Use the Export Results command button to export the results from the instru-
ment’s NVRAM into a results file, *.wsr. Use the Import Results command
button to bring the results file into a CSS50 worksheet.

When the Export is complete there will be a “.wsr” file in the Results File
Column in the Get Stored Results dialog box. This file is ready to be imported
into a worksheet.

The Import Results dialog box (see Figure 3–29) gives several choices of how
the data is imported into the worksheet:

� Exact channel information match only

� Use blank channel information as wildcards

� Verify mismatched channel information
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Figure 3–29: Import Results dialog box

The top two choices will automatically load as much data as it can without any
user intervention. The last option allows you to check and verify all information
before loading any data.

Generally, when using Import to get results from an instrument into a worksheet,
“Use blank channel information as wildcards” is the most efficient option since
there will rarely be an exact match. This is because the instrument only stores the
channel number as the channel ID, while the CSS50 software stores the channel
number, program name, and nominal visual carrier. You could go through and
verify each channel if desired, to make sure that the channel numbers match, but
generally, the “Use blank channel information as wildcards” selection would be
the most efficient way to load the data, because it will reduce further prompts.

NOTE. If any of the results that you are importing contain results from CSO or
CTB measurements, you may end up importing more results than listed in the
results column because of the way that the CSS50 software distinguishes results
(with older firmware versions of the 2714).

Any cell without results data or in Error condition will not be imported. Cells
that have more than one measurement will have all valid data imported and the
Error data results left blank.

If you are Importing results from a Channel Table that has mismatches in the
Channel Header, you are flagged during the import process so that you are aware
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of any problems and can fix them. The only exception to this is if the Channel
Number does not exist in the import worksheet Channel Table. In this case, you
are warned at the end of the import process with the message given in Fig-
ure 3–30.

If you are importing results from a channel table that has mismatches in the
channel header, no destination channel, an inactive destination cell, or a user
requested skip, you are warned at the end of the import process as shown in
Figure 3–30.

Figure 3–30: Imported results messages

Configure

Use the Configure menu (see Figure 3–31) to set up worksheets, measurements,
and test equipment.

Figure 3–31: Configure menu
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Worksheet Info edits the Site, Channel Table, and description for the current
worksheet. (See Figure 3–32.)

Figure 3–32: Worksheet Info dialog box

Site. The Site combo box defines the location where the measurements are made.
Only one Site is allowed per worksheet. If you change the Site, you are queried
whether you want to save the worksheet under a new name or overwrite the old
Site name. If you choose to overwrite the old name all of the history previously
collected under the old Site name will now be tagged with the new Site name.

<Undefined> is an acceptable Site name. “Blank” (nothing in the field at all) is
not acceptable and an error message will appear if “blank” is in the Site field.

Channel Table. This associates a certain Channel Table with a worksheet. The
Channel Table is a list of all of the available channels, their frequency, their
program name, etc. Only one Channel Table is allowed per Worksheet. If you
want to change the Channel Table, start with an empty worksheet.

Worksheet Info
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Create/Edit Channel Table. See Appendix C: Channel Table Editor for more
information and warnings on editing the Channel Table. Edit the Channel Tables
with caution.

Save as Default. This command button allows you to save the Channel Table in
the combo box as the default Channel Table. When starting the CSS50 software,
the default Channel Table loads automatically.

Description. Put any information that might be relevant into this field. How the
measurements were made, the serial numbers of the equipment used, who did the
measurements, and the dates are examples of things that you might want to load
into this field. This field is limited to 500 characters. Carriage returns are
allowed.

Use this field is to meet the FCC documentation requirements by entering:

� Identification of instruments (make, model, most recent calibration date)

� Description of procedures utilized

� Statement of qualifications of the person(s) performing the tests

The field is fully editable. The information can be copied to the clipboard using
CNTRL+INSERT or CNTRL+C, and then attached to the worksheet name cell
in Excel as a text note.

The Test ID is the name of the operator, test point, or whatever identifier is most
appropriate. The Test ID dialog box consists of a combo box and a list box: All
Test IDs and Worksheet Test ID (see Figure 3–33). All Test IDs lists all of the
Test IDs that have ever been used. Enter new Test IDs here. Worksheet Test IDs
are the IDs used in the current worksheet.

Test ID
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Figure 3–33: Test ID dialog box

Use this field to flag certain measurements and then use the View Filter, so only
cells that have a measurement associated with the selected Test ID are displayed.
To quickly change the Test ID you want to filter, select the Test ID from the
Worksheet Test IDs group and the View Filter will switch to that Test ID.

Also change the Test ID using the Test ID command button from the Button Bar
(see page 3–79).

This dialog box (see Figure 3–34) sets the way results are collected and
displayed.

Preferences
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Figure 3–34: Preferences dialog box

Measurement History. History (the previous measurement results) can be
collected or only the most recent measurement saved. If History is turned off and
then turned back on, the measurements are saved beginning with the current
measurement displayed on the worksheet. Turning history off does not erase any
results previously stored when history was on. For an illustration of how this
works, see Figure 3–35.

3
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1

7 7
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3

2

1

3

2

1
Measurements

in the “stack”

Turn history off here

Stack after 4 more
measurements

Turn history on.
Make 2 more measurements

Figure 3–35: How measurements are saved when history is turned off, then on
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Power Level Units. Choose one of the two formats to display the Visual Carrier
Level and Average Power units:

dBmV [referenced to 1 mV (10–3 volts)]
dBuV [referenced to 1 �V (10–6 volts)]

Measurement Execution. These check boxes determine whether the measurements
will stop and flag certain conditions, and how you are notified of these condi-
tions.

The first option is Prompt for Signal Connection. It is used if your RF feed to the
test equipment is on a switch instead of a splitter. If it is on a switch you need to
be able to switch the RF feed into either the 2714 or 2715 or the demodulator as
needed. If this check box is selected, the measurement order is changed from:
left to right then top to bottom — to: left to right and top to bottom for the RF
measurements, then left to right and top to bottom for the baseband measure-
ments. This is done so that the user only has to change the connection once.

The second option is Pause on New Channel. It is used when the pre-selector
needs to be tuned for each channel or some other manual adjustment needs to be
done whenever the channels change.

The third option is a set of options that determine how non-standard conditions
are treated. The “non-standard” conditions include: measurement results in
Caution, Alarm, or Error. The Caution and Alarm conditions are set through the
limits file that is associated with a particular channel. The Limit files are set
using the Measurement Limits command from the Configure menu. See
page 3–61 for more information on the Measurement Limits. The Error condition
only occurs if a measurement cannot be made or the measurement results from
the instrument are out of the allowable range.

The ways these “non-standard” conditions could possibly be handled include:
Report out RS-232, Pause Execution, or Log To File.

Pause Execution is appropriate for user interactive measurements. You can watch
it make the measurements and fix any problems that occur. If the measurements
are stopped because this is set, you have two choices: OK continues making
measurements; Cancel drops out.

Report out RS-232 sends a Violation Report out the Com Port (set with
Connections, from the Preferences menu). Based on the conditions selected, the
following information is sent: Site Name, Measurement Column Heading,
Channel Number/Tag/Program, Condition Type (alarm, caution, or error), and
Date/Time. This information is tab delimited and packetized ASCII text.
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Each Violation Report is one packet and each packet consists of three items:

� A one byte Byte Count that gives the number of bytes in the Violation
Report (this includes the checksum)

� The Violation Report in ASCII text

� A one byte checksum (simple addition, including the Byte Count)

An additional reporting option is to broadcast a message to all active Windows
applications that have registered to intercept this message. This function allows
you to perform additional processing when an alarm occurs. To receive these
messages, your Windows application must execute the following line of code:

)�' +(�,$ � �"$&,-"+�&)!*/�",, $"�������������������������

The variable nAlarmMsg represents the unique Windows message number. To
intercept it, simply test for nAlarmMsg in the main messaging loop. The severity
of the nonstandard condition is indicated by msg.lParam (Action = 1, Alarm = 2,
and Error = 3). For example:

��� (,$
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NOTE. This option is not “set” anywhere. It is automatically available whenever
an alarm, caution, or error result is encountered.

Log To File sends a violations report to a log file when any of the selected
conditions occur. The Log To File options are only available if a worksheet has
been named and saved. See Setting Up a Worksheet beginning on page 2–13.

The log file is created in the same directory as the worksheet file and has the
same base name, with a “.log” extension. The same information, in the same
format, is logged to the file as is sent out RS-232.

The information recorded in the log file is the site name, measurement name,
channel (number, program, and tag), condition encountered (alarm, caution, or
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error), and the date and time it occurred. Each of these fields is tab separated to
allow easy importing into other applications such as Excel.

To help ensure that measurements are being performed, a keep-alive message is
also logged. This message is logged whenever a group of measurements
(including a single measurement) is started and whenever an iteration of a
measurement sequence is started. This is useful when performing repetitive
measurement sequences.

The Measurement Sequence dialog box (see Figure 3–36) allows you to program
a set of measurements to execute every time you click on Meas Seq in the Button
Bar or Measurement Sequence is chosen from the Measure menu. This allows a
regularly used set of measurements to be invoked with a single mouse click
instead of running each individual measurement one at a time.

Figure 3–36: Measurement Sequence dialog box

 Measurement Sequence
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An “X” in a cell indicates that the channel and measurement are part of the
Measurement Sequence. Select as many or few cells as needed to define a
Measurement Sequence. When all of the desired cells are selected, click on OK;
the Measurement Sequence immediately loads and is stored under the Meas Seq
command button.

To speed up the process for likely groups of measurements, there are four
predefined “Auto Selection” Measurement Sequences. They are: FCC Pre-and
Post Converter Measurements, FCC Headend Measurements, and 24 Hour
Measurements. If the country is not United States, then only the 24 Hour Test
automatic selection button is available. The Country is selected from the
Windows Control Panel, International icon. Table 3–6 give a list of measure-
ments included in the Auto Selections. These measurements are executed on the
channels selected by the user. Whenever one of these Auto-Selection command
buttons is chosen, it loads the measurements immediately into the Measurement
Sequence. Additional measurements are then added or deleted as desired by the
user to complete a Measurement Sequence.

Table 3–6: Auto Configure buttons 

Auto Selection Button

Channels
FCC
pre-converter

FCC 
post-converter

FCC
headend 24 hour test1

All Channels Carrier Levels
and Frequencies

Carrier Levels
and Frequencies

Carrier Levels
and Frequencies

Carrier Levels
and Frequencies

Selected 
Channels

ICR Carrier to
Noise Ratio

FCC
Baseband

Selected 
Channels

CSO

Selected 
Channels

CTB

Selected 
Channels

Cross
Modulation

Selected 
Channels

Hum

1 The 24 Hour Test automatically includes 4 repetitions at 6-hour intervals.

There are other options on the Measurement Sequence menu. They include:
Carrier Survey, Edit Time Parameters, Generate 2714/2715 UDP, and Clear
Sequence.

If you want to make the Carrier Levels and Frequencies measurements (Visual
Carrier Levels, Visual Carrier Frequency, Aural Carrier Level, Aural Frequency
Offset, Second Aural Carrier, and Second Aural Frequency) and Average Power
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measurements on all channels in the Measurement Sequence, then you can do a
Carrier Survey instead of a series of individual measurements. (A carrier survey
makes all of the Aural, Visual Carrier Amplitude, Frequency, and Average Power
measurements first, and then the rest of the selected measurements.) The
advantages and drawbacks of selecting the Carrier Survey are as follows:

Advantages:

� Faster measurement execution

� Smaller UDP size (allows for more measurements to be loaded before
exceeding the UDP size limit)

Disadvantages:

� The Pause For New Channel preference will not pause for new channels
within the survey

� All measurement results are tagged with the same date and time

Whether you select individual measurements or the survey, the measurements
will still be made in the mode specified in the Measurement Setups dialog box.

The Edit Time Parameters dialog box tells the sequence when to start, and how
many times to run. (See Figure 3–37.)

Figure 3–37: Edit Time Parameters dialog box

Run Continuously runs the Measurement Sequence in an infinite loop. It runs
through the entire Measurement Sequence and then starts over again until you
click on Cancel.
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Run Immediately starts the Measurement Sequence whenever the Meas Seq
command button (or equivalent) is chosen.

If the Run Immediately check box is not selected, then the Start Day needs to be
selected from the list box. Your options are Any or a particular day of the week.
Any means “today.”If running continuously, Any means “every day.” If a
specific day of the week is selected, then the Measurement Sequence will not
start until the computer’s internal clock reaches that day. Enter the starting Hour
and Minute (in 24-hour time) that you want it to start in the Hour and Minute
text box.

Please note that the Start Time is only defined by the internal clock for the PC
running the CSS50 software, if the Measurement Sequence is run directly from
CSS50 application. If a UDP is generated and the Measurement Sequence is run
from a remote location, then the internal clock of the 2714 or 2715 is used as the
timing reference. (All time/date stamps for a measurement are from the internal
clock of the 2714 or 2715.)

Use the Run N Times text box, if you want the Measurement Sequence not to
run continuously. You enter the number of times in the Run N Times text box
and the Repeat Interval in its text box. If you only want the sequence to run
once, enter “1” in the Run N Times box and “0” in the Repeat Interval text box.

If you are running a Measurement Sequence several times and the Measurement
Sequence is longer than the Repeat Interval, the Measurement Sequence will
simply start the next run as soon as the previous one completes.

The Repeat Interval must be an integer number of hours. The Repeat Interval
counts from the Measurement Sequence start time.

Create 2714/2715 UDP. If a Measurement Sequence is being defined for a 2714 or
2715 to use at a remote location, then you use the Create 2714/2715 UDP (User
Defined Program) command button. This command button converts the CSS50
Measurement Sequence into a UDP and immediately loads it into the 2714 or
2715. The instrument can then use the UDP to make measurements later at a
remote location. You can load the results back into the CSS50 application using
the Get Stored Results from 2714/2715 command (located in the Measure menu,
see page 3–43).

Up to nine UDPs can be stored in each 2714 or 2715. If the 2714 or 2715 will
not load a UDP, it may already have nine UDPs. The CSS50 software allows up
to 28 characters with no commas or semicolons for the UDP title (see Fig-
ure 3–38).
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Figure 3–38: Generate 2714/2715 UDP dialog box

When running a UDP, the preferred amplitude units may not be reflected on the
2714 or 2715 display. This does not make a difference, since the units convert to
the desired value when the results load into the CSS50 worksheet.

Be careful when defining a Measurement Sequence for a UDP. Remember that
all header and preference information must be correct before the UDP is loaded
into the 2714 or 2715. The information sent includes: Channel Table, Measure-
ment Execution Preferences (Pause on New Channel and Prompt for Signal
Connection), Start Day and Time, Repeat Interval, Repeat Count (Run N Times),
Visual Carrier Level Units, and Test ID (Operator Field in the 2714 or 2715 –not
editable at the 2714 or 2715). See Table 3–7 for a complete list of what is loaded
into the 2714 or 2715 when a UDP is created.

Table 3–7: Information loaded into the 2714 or 2715 when creating a UDP 

Parameter Where edited

Title User entered at the Generate 2714/2715 UDP prompt

Run N Times The Edit Time Parameters, from the Measurement
g C g

Repeat Interval
Sequence dialog box (Configure menu)

Start Day

Start Hour

Start Minute

Prompt for Signal Connection From Preferences in the Configure menu

Pause on New Channel From Preferences in the Configure menu

Channel Table From the Worksheet Info dialog box (Configure menu)

Test ID From Test ID (Configure menu)

Reference Level Units From Preferences (Configure menu)

Measurement Setups1 
(for the individual channels)

From the Measurement Setups dialog box (Configure
menu)

Power Line Frequency From the Measurement Setups dialog box (Configure
menu)
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Table 3–7: Information loaded into the 2714 or 2715 when creating a UDP (cont.)

Parameter Where edited

External Attenuation/Amplification From the Measurement Setups dialog box (Configure
menu)

Preamp From the Measurement Setups dialog box (Configure
menu)

Measurements on Channels2 From the Measurement Sequence (Configure menu)
1 If the Gated option is selected for one or more measurements and you are trying to

send the UDP to a 2714, you are given a warning that Gated is not supported and
allowed to continue with Auto mode.

2 If a digital measurement (Average Power, Desirable to Undesirable, or Adjacent
Channel Leakage) is selected for one or more channels and you are trying to send
the UDP to a 2714 or 2715 that does not support digital measurements (2715 if
firmware version 09-30-94 or earlier) a warning is displayed that digital measure-
ments are not supported and will be skipped.

If a baseband video test is selected and you are trying to create a 2714/2715 UDP,
you are given a warning that baseband video tests (FCC Baseband, Signal to Noise,
and Waveform Distortion) are not supported by the 2714 or 2715, and the tests will
be skipped.

If any of the conditions described in notes 1 or 2 were encountered, a summary of
the warnings is displayed. You will be given a chance to continue generating the
UDP, with the problems handled as indicated, by selecting OK, or you can quit
generating the UDP by selecting CANCEL.

UDPs are not necessarily fully automated. Many measurements require operator
input to collect results. Table 3–8 lists the measurements that may require
operator input, the type of input required, and the circumstances that cause the
operator input to be required.

Table 3–8: Measurements that require operator input 

ea e e

Operator input required

Measurements
Turn carrier 
on/off

Turn modulation
on/off

Turn scrambling
on/off

Turn test signal
on/off

Carrier to Noise 1 6

Desired to Undesired 2

CSO 1 6

CTB 1

Cross Modulation 2

ICR 6 5

Hum/LFD 3 (RF only)
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Table 3–8: Measurements that require operator input (cont.)

Measurements

Operator input required

Measurements
Turn test signal
on/off

Turn scrambling
on/off

Turn modulation
on/off

Turn carrier 
on/off

Modulation Depth 3 (RF only)

Aural Deviation

Audio 7

ALL 4

Explanations 1. Auto with Pause or Single Sweep only. (Change via Measurement Setups from the Configure menu.)

2. Always prompts.

3. Only prompts if the channel is flagged as scrambled in the Channel Table.

4. Always prompts you to turn off scrambling as soon at it reaches a measurement that requires the
scrambling turned off. Will also prompt you to turn the scrambling back on after making all measurements
for that channel.

5. Only if this measurement is not made using Gated.

6. Only if this measurement is made using Gated and the channel is flagged as scrambled in the channel
table.

7. Audio measurements may require that the ASG100 Test Sequence be started.

To generate a user defined program (UDP) that will run unattended, select the
measurement modes shown in Table 3–9. Desired to Undesired and Cross
Modulation always require user intervention; they cannot be run unattended in a
UDP.

Table 3–9: Modes for unattended UDPs 

Measurement Mode

Carrier Levels and Frequencies Any mode

Average Power Accurate Amplitude

Carrier to Noise Auto or Gated1

CSO2 Auto3 or Gated1

CTB Auto3

Adjacent Channel Leakage Any mode

In-Channel Response Gated4

Hum/LFD Any mode4
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Table 3–9: Modes for unattended UDPs (cont.)

Measurement Mode

Modulation Depth Any mode4

Aural Deviation Any mode
1 For Gated mode to work without user intervention in Carrier to Noise and CSO

measurements, the channel must not be scrambled. If the channel is scrambled,
Carrier to Noise and CSO must be run in Auto mode to avoid user intervention.

2 On digital channels, CSO and CTB always run in Auto with Pause mode. This mode
requires user intervention. To avoid user intervention, make sure CSO and CTB are
not selected for digital channels.

3 Measure Beat in an empty adjacent channel.
4 If the channel is scrambled, ICR, Hum/LFD, and Modulation Depth cannot be run

without user intervention.

The selected Channel Table must exist in the instrument when the UDP is run or
an error message will occur. The Channel Table is not loaded into the instrument
by the UDP. Use the Channel Table Editor to load the Channel Table into the
instrument. (See Appendix C: Channel Table Editor.)

The Site is not part of the UDP and it is the operator’s responsibility to correctly
load it into the instrument before the UDP is run. This way the same UDP can be
run at several Sites.

Measurement Sequences in Non-US Countries. If you are using the CSS50
software in a country other than the U.S., your Measurement Sequence dialog
box will probably look different. See Figure 3–39. (The operating country is
defined in the Regional Setting Properties specified in the Window Control
Panel.) The differences are due to FCC (a US regulatory body) requirements. If
you want to use the FCC Auto Selection buttons, change your country to United
States, delete the CSS50.ini file, and restart the CSS50 application.

NOTE. Deleting the CSS50.ini file allows the software to create a new .ini file to
update the decimal symbol used to display measurement values.

For example, setting the Regional Setting to the United States produces values
displayed as �������. Regional Settings for many countries other than the
Untied States produces values displayed as �������.
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Figure 3–39: Measurement Sequence dialog box (non-U.S.)

The Measurements Limits file defines the alarm and caution levels for the
measurement results. There are two default Limits files (ntsc.lim and pal.lim)
that come with the CSS50 application, but you can edit the files to conform to
your needs. Each channel can have a different Limits file assigned (for example,
one for premium channel, one for local, and one for cable access) or one Limits
file for all the channels. Attach a Limits file to a channel using the <--Select
Limits File command button. See Figure 3–40.

Measurement Limits
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Figure 3–40: Measurement Limits dialog box

Clear Limits File. The Clear Limits File command button removes the limits file
from selected channels. You can still make measurements and save results
without a Limits file, but there will be no Caution, Alarm, or Passing flags in the
results. As soon as a Limits file is attached to a channel all of the measurement
results made for that channel are flagged according to that Limits file.

<--Select Limits File. This command button attaches the selected Limits File in the
Limits file combo box to the selected channel. All results for that channel are
flagged according to the new Limits file (including all history).

Edit Limits File. This command button allows you to edit the selected Limits file
from the Limits File list box shown in Figure 3–41.

CAUTION. Any changes made by editing a Limits file affect all worksheets using
that Limits file, not just the current worksheet.
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Figure 3–41: Edit Limits File dialog box

NOTE. The Visual Carrier Frequency, Aural Frequency Offset, and Second Aural
Frequency Offset are specified in deviation from nominal.

If you want to edit a Limits file, start by making a copy of one of the provided
Limits files and edit the copied file rather than the original. To copy the file
select the Save As Limits File command button, enter a new name for the Limits
file, and then click on OK.

The Limits file must be in the Limits sub-directory under the directory that
contains the CSS50.exe file. The Limits file should end in “.lim” to help
simplify your file management.

You can’t edit the Range columns or the Units (they are shown for user
information only), but the Limits columns are editable. Figure 3–42 shows how
the Upper and Lower Limits work to flag measurement results. Those four
columns are editable, but they are limited by the Range Limits. If you attempt to
enter a value outside those defined by the Range limits, you will get an error
message, that cell will be highlighted, and it will expect a correct value to be
entered.
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43 45 dB

Aural carrier frequency

Carrier to noise

ICR

Upper and lower
limits

Only upper limits

Alarm AlarmCaution CautionGood

–5 5–3 3

Only lower limitsAlarm Caution Good

AlarmCautionGood

kHz

21.5 dB

Figure 3–42: How the upper and lower limits work

The command buttons in the Edit Limits File dialog box are:

� Open Limits File. The Open Limits File command button allows you to
select a different Limits File to edit. The name of the Limits file that you are
currently editing is in the Title Bar for the Edit Limits dialog box.

� Save As Limits File. Save As Limits File command button saves any
changes made to the current Limits file (the one whose name is in the Title
Bar). Don’t forget that any changes made to this Limits file are reflected in
every worksheet that uses that Limits file.

� Get Defaults. Get Defaults places all of the default values into the Edit
Limits dialog box.

� Save As Defaults (See Figure 3–43). This command button takes all of the
current values in the Limits file and saves them to a new Limits file which is
then used as the default Limits file. The default Limits file values are loaded
into the current Limits file using the Get Defaults command button. It also is
used as the Limits file for all channels whenever a new worksheet is defined
or you start making measurements without defining any worksheet. This new
Limits file can have the same name as the file you were editing but it would
help your file management to call it, “Default” or something similar, so that
you can remember what you are using as the default Limits file.
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Figure 3–43: Save As Defaults dialog box

� Clear Limits. This command button clears all of the limits from all of the
measurements. If this is done by accident, you can recover by choosing the
Cancel Command button.

Summary Limits. The Summary Limits at the bottom of the Limits window are
global parameters in that they apply to all channels (see Figure 3–44).

Figure 3–44: Summary Limits (part of the Measurement Limits dialog box)

Visual Carrier Level Differences defines the range that the Visual carrier can vary
across all channels. Adjacent Visual Carrier Level Difference is the amount of
variation in amplitude between two channels that are next to each other in
frequency. The Adjacent results may be misleading if a View Filter is on because
channels next to each other in the worksheet are not necessarily next to each
other in frequency.
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NOTE. If a View Filter is on, some measurement results can be misleading. Take
note of the View Filter Status when interpreting results.

These parameters are not visible on the worksheet; rather they are part of the
Status Report, Results Detail, and Measurement Summary.

The Get Defaults command button loads the default values into the Summary
limits. The Save As Defaults button sets the current values as the defaults.

Click on Parameters to set the window for adjacent channels. This dialog box
(see Figure 3–45) defines what constitutes an adjacent channel. Any adjacent
channels that are outside of this frequency window are not included in the
calculations. Select what is required for your system and then click on OK.

NOTE. This is not used by the Adjacent Channel Leakage measurement. ACL
selects adjacent channels based on the width of the digital channel under test.

Figure 3–45: Parameters dialog box

There are many different ways that test equipment can be set up. The configura-
tion tells the CSS50 software how your system is set up to retrieve the correct
results. Find this item under the Configure menu, Measurement Setups. There
are setups that affect all channels and some that are channel specific. The
Measurement Setups dialog box is shown in Figure 3–46.

Measurement Setups
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Figure 3–46: Measurement Setups dialog box

All Channels Group. The All Channels group allows you to customize measure-
ments. The All Channels group categories include Get Defaults, Save As
Defaults, VM100/VM101, Power Line Frequency, and 2714/2715.

� 2714/2715 Sub-group. This group allows you to set up the software to match
your equipment setup.

External Attenuation/Amplification. Enter the necessary attenuation or
amplification (in dB) needed to compensate for losses or gains in your
system in this text box. For example, if a measurement is being made at a
20 dB down test point, enter –20 in the text box.

Preamp. Select the On or Off option button to match your equipment setup.
The Preamp is generally “on” in low-level signal conditions to improve the
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resolution of the measurements. Set the Preamp according to the specifica-
tions in the 2714 manual. The 2715 automatically uses the optimum preamp
setting and then resets it back to the value selected to this option button.

Carrier Levels Mode. This setup specifies the mode used when making
carrier level measurements. The options are: Accurate Frequency and
Amplitude, Accurate Amplitude Only, and Fast Amplitude Only. The
selection applies to individual carrier level measurements as well as surveys.

NOTE. It is recommended that you use Accurate Frequency and Amplitude for
any FCC measurements.

� VM100/VM101 Sub-group. This group allows you to set the
VM100/VM101 Average Mode on or off for measurements. If on, measure-
ments will be slower (depending on the Signal-to-Noise on the input signal)
but more accurate and with less variation. If off, measurements will be faster.

� Power Line Frequency subgroup. Select either 50 or 60 Hz to match the
power line frequency of your system. (60 Hz is not selectable if the channel
table video standard is set to PAL.)

Get Defaults. This command button loads all of the previously saved default
values into the All Channels group text boxes and option buttons.

Save As Defaults. This command button saves all of the current text box and
option button settings as the default values. The default values are automatically
loaded whenever a new worksheet is created. They are also available through the
Get Defaults command button.

Selected Channels Group. The Selected Channels Group allows you to continue
customizing measurements down to the individual channel. The categories found
under Selected Channels are: Carrier to Noise, VM100/VM101 VITS, ACL,
HUM, CSO, CTB, and In-Channel Response.

Edit the individual channels by choosing the Edit Setups command button. The
dialog box is shown in Figure 3–47.

NOTE. The VM100/VM101 VITS group in the Edit Setups dialog box is slightly
differenct for CSS50 software versions below 2.0. See Appendix  H: Version 1.0
Software about these differences.
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Figure 3–47: Edit Setups dialog box (NTSC)

Carrier to Noise Group. Select the Auto, Auto with Pause, or Gated option button.
Auto with Pause requires that the carrier be turned off in order to make the
measurement. The measurement will stop and prompt you to turn off the carrier
and wait for you to respond that the carrier is off before it will continue making
measurements. Auto makes the measurement without taking the channel out of
service or requiring any operator interface. Gated makes the measurement on a
non-modulated line, therefore there is no requirement to turn the carrier off or
take the channel out of service. Gated is only available for the 2715.

Enter the bandwidth for the noise calculation in the Noise Bandwidth text box.
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Hum Group. Select either Baseband or RF option buttons for how to make the
Hum measurement. If Baseband, the VM100 or VM101 makes the measurement.
If RF, then the 2714 or 2715 makes the measurement.

NOTE. The demodulator’s Zero Carrier Pulse must be turned on and set to the
appropriate Line and Field in the Demodulator Setups dialog box. See page
3–76 for more information about the demodulator setup.

CSO Group. Select the way you want the CSO measurement performed by
selecting Auto, Auto with Pause, Single Sweep, or Gated option Buttons. For
digital channels, only Auto with Pause is available. Gated is called “in service”
on the 2714 or 2715 instruments. This allows measurements to be made on-line
with no modulation.

Enter up to five relative test locations for the CSO measurement in the Test
Locations text boxes. Be sure to take into consideration the way that the 2714 or
2715 handles CSO and CTB measurements if you are doing a measurement
setup for a UDP.

VM100/VM101 VITS Group. Select either Auto or Manual mode.

Auto mode causes the VM100 or VM101 to automatically search for the
appropriate test signals (the Line and Field boxes are not editable). If an
appropriate signal is found, the measurement is run using that line for the test
signal. If an appropriate signal is not found, the measurement fails. Auto is the
recommended mode.

Manual mode is provided for experienced users who need precise control over
which test signals are used for the baseband measurements. For each of the five
baseband measurements, the user can specify exactly which Line and Field to
use for obtaining the test signal. (Field is removed if the channel table video
standard is set to PAL.) If an appropriate signal is found on the specified line, the
measurement is run using that line for the test signal. If an appropriate signal is
not found on the specified line, the measurement fails.

Table 3–10 lists the five baseband measurements you can enter the Line and
Field when using Manual mode. The table also provides the individual measure-
ments made and the allowable values for Line and Field for each baseband
measurement.

NOTE. The VITS group in the Edit Setups dialog box is slightly different for
CSS50 software versions below 2.0. See Appendix  H: V1.0 Software about
these differences.
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Table 3–10: VITS Line and Field ranges 

Baseband measurements Measurements and ranges

Baseband Applies to the Chroma-Luma Delay, Differential Gain, and
Differential Phase measurement

NTSC: Line = 9 – 263 Field = 1 or 2
PAL: Line = 6 – 310 or 318 – 623

Sig-to-Noise Applies to the Signal-to-Noise measurement

NTSC: Line = 9 – 263 Field = 1 or 2
PAL: Line = 6 – 310 or 318 – 623

In-Chan Resp Applies to the In Channel Response measurement

NTSC: Line = 9 – 263 Field = 1 or 2
PAL: Line = 6 – 310 or 318 – 623

2T K-Factor Applies to the 2T K-Factor measurement in the waveform
distortion group

NTSC: Line = 9 – 263 Field = 1 or 2
PAL: Line = 6 – 310 or 318 – 623

Lum Non-Lin Applies to the Luminance Non-Linear Distortion measurement
in the waveform distortion group

NTSC: Line = 9 – 263 Field = 1 or 2
PAL: Line = 6 – 310 or 318 – 623

See the VM100 or VM101 Video Measurement Sets user manual for more
detailed explanations on these measurements and values.

NOTE. HUM does not use a VITS signal so is not included in the VM100/VM101
VITS group. In order to do the HUM measurement, the demodulator’s Zero
Carrier Reference Pulse must be turned on and set to the appropriate Line and
Field in the Demodulator Setups dialog box. In the Configure menu bar, select
DS1000 under Demodulator to obtain the demodulator setup dialog box. See
page 3–76 for more information about the demodulator setup.

CTB Group. Select the way you want the CTB measurement made using the
Auto, Auto with Pause, or Single Sweep option buttons. For digital channels,
only Auto with Pause is available.

Enter up to five test locations for the CTB measurement in the Test Locations
text boxes. Select either the Rel (relative) or Abs (absolute) option buttons for
each test location. Again, be sure to take into consideration the way that the 2714
or 2715 handles CSO and CTB measurements if you are doing a measurement
setup for a UDP.
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ACL Group. Measures the power in the channels adjacent to the digital channel
under test. This is a headend test with the 2715 connected to the test port of the
modulator. Select Upper to measure the power in the upper adjacent channel
only, Lower to measure the lower adjacent channel only, or Both to measure both
the upper and lower channels.

In-Channel Response Group. Selects how you want the In-Channel Response
(ICR) measurement executed.

Select either the Baseband or RF option button. The baseband option uses the
VM100 or VM101 while the RF uses the 2714 or 2715 to make the ICR
measurement. Sometimes, you only have one or the other piece of equipment
available and this measurement can be made either way.

If you select the RF option you can also make that measurement Gated. Gated is
called “in service” on the 2715 instruments. This allows measurements to be
made on-line with no modulation.

If you select the RF option, enter the relative frequencies where you want the
measurement calculated (six locations must be entered) in the Test Locations text
boxes.

Command Buttons for the Edit Setups for Channel XX Dialog Box. There are three
special command buttons located on the upper right hand corner of the Edit
Setups for Channel dialog box. They are Get Defaults, Save as Defaults, and
Copy to All Channels.

Get Defaults. The Get Defaults command button takes the default values and
places them in the text boxes. It also sets the option buttons to the default values.
The dialog box below appears, allowing you to decide what measurements
should get the default values. (See Figure 3–48.)
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Figure 3–48: Get Defaults dialog box

Save as Defaults. This command button takes the current entries in the text boxes
and selected check boxes and stores them as the default values. Load these
default values into selected channels using the Get Defaults command button
when you are editing the setups for those channels. These become the default
values whenever a new worksheet is created. (See Figure 3–49.)

Figure 3–49: Save As Defaults dialog box

Copy to All Channels. The Copy to All Channels command button takes all of the
settings for the selected measurements and copies the current values to all
channels. (See Figure 3–50.) Note that CSO and CTB settings are handled in a
special way. If the current channel is digital, CSO and CTB setups are copied
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only to digital channels. Similarly, if the current channel is analog, CSO and
CTB setups are copied only to analog channels.

Figure 3–50: Copy to All Channels dialog box

The Connections dialog box sets up the GPIB and RS-232 control connections.
The allowable GPIB addresses are from 0 to 29. Figure 3–51 shows the
Connections dialog box if the DS1000 demodulator has been selected in the
Demodulator menu. If None (no demodulator) is selected in the Demodulator
menu, then the whole demodulator group is grayed out.

Choosing No Instruments Selected allows the application to simulate measure-
ments for learning purposes.

CAUTION. To ensure proper operation and prevent software conflicts, verify that
no two instruments are assigned to the same port or GPIB address. This applies
even if an instrument is not connected or used.

Connections
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Figure 3–51: Connections dialog box

2714/2715 Spectrum Analyzer Group 

� GPIB. If your system uses the GPIB, enter the address of the 2714 or 2715
in the GPIB Address text box.

� RS-232. If your 2714 or 2715 uses RS-232 instead of GPIB, select the
correct Com port from the Com Port list box and the correct baud rate from
the Baud Rate list box.

VM100/VM101 Group 

� RS-232. Select the correct Com port from the Com Port list box and the
correct baud rate from the Baud Rate list box.

DS1000 Group 

� RS-232. Select the correct Com port from the Com Port list box. The baud
rate is fixed at 9600.

RS-232 Violations Reporting Group. This group sets the parameter for a port that
will receive error messages from the CSS50 application if one of the measure-
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ments is in a “non-standard condition”. Select the Com Port and the Baud Rate.
For more information on the RS-232 Violations report, please see page 3–51.

The Demodulator command selects between a DS1000 series demodulator or
None (see Figure 3–52).

Figure 3–52: Demodulator menu

If None is selected, then during measurement execution, no checking is made for
a demodulator. If the demodulator is selected, then during measurements the
following occurs:

� If making a baseband measurement and the specified demodulator is not
found, an error message is displayed and the measurement is terminated.

If the DS1000 is selected, then an additional dialog box appears, as shown in
Figure 3–53.

Figure 3–53: Demodulator Setups dialog box

Set these values as required for your system. Zero Carrier Pulse is used for Hum
measurements and must be on for Hum measurements. These values automati-
cally override the front panel instrument settings.

For NTSC, the Line entry must be in the range of 10 to 20 and the Field set
to 1 or 2. Baseband Hum measurements use Field 1 only.

Demodulator
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For PAL, the Line entry must be in the range of 6 to 16 or 319 to 329. The
Field entry is disabled (grayed out). Baseband Hum measurements use the
Line range of 6 to 16 only.

Zero Carrier Pulse must be set to On for Baseband Hum measurements.
Select a quiet line in the video signal to put the zero carrier pulse on.

Position is where within the video line the pulse is placed. The range is 0 to
4 where 0 is at the start of the video line and 4 is at the end.

Execute

The Execute menu allows you to launch the Channel Table Editor without
leaving the CSS50 application.

The Channel Table Editor is a separate application that allows you to edit and
create Channel Tables to load into the instruments. This command launches this
application or, if it is already started, this command switches to it. For more
information on this application, please see Appendix C.

Help

The Help menu (see Figure 3–54) provides access to the CSS50 online help.

Figure 3–54: Help menu

Contents lists all of the available help topics (see Figure 3–55). These topics are
accessed by scrolling until the desired topic is highlighted and then clicking on
OK or double clicking on the name. There are some general topics, then all the
menus and their associated commands are listed. At the end of the list are the
measurement help files. The measurement help files give a brief description of
the measurement, and the files have room for you to add your own notes about
the measurements. For details on editing these Help files, see Adding Informa-
tion to the Help Files, in Appendix E, on page E–2.

Channel Table Editor

Contents
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Figure 3–55: Help Contents dialog box

These same topics are available from the Help command buttons in most dialog
boxes.

Make sure that you close the Help dialog box when you are finished. Only one
open dialog box is allowed at a time. Close the Help dialog boxes by choosing
Close from the Help Window Control Box or by pressing ALT+F4.

The About dialog box gives the version number of the CSS50 software and other
information (see Figure 3–56). Click on OK to leave this dialog box.

About
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Figure 3–56: About dialog box

Button Bar

The same as Open in the File menu on the Menu Bar. (See page 3–13.)

The same as Save in the File menu on the Menu Bar. (See page 3–13.)

The same as Global View in the View menu on the Menu Bar. (See page 3–36.)

The same as Results Detail in the View menu on the Menu Bar. (See page 3–28.)

Same as the Status Report in the View menu on the Menu Bar. (See page 3–24.)

Same as Current Selection in the Measure menu on the Menu Bar. (See
page 3–42.)

Same as Measurement Sequence in the Measure menu on the Menu Bar. (See
page 3–43)

Same as Test ID in the Configure menu on the Menu Bar. (See page 3–48.)

Same as Measurement Setups in the Configure menu on the Menu Bar. (See
page 3–66.)

Same as Measurement Limits from the Configure menu on the Menu Bar. (See
page 3–61.)

Same as Print in the File menu on the Menu Bar. (See page 3–16.)
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Appendix A: Menu Map

This chapter is a quick reference to all of the commands available from the
CSS50 Menu Bar along with a brief description of what they do.

Table A–1: CSS50 Menu Bar menu map 

Menu Command DescriptionÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

File
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

New
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Creates a new worksheet. All Measurement Setups and Limits files are automatical-
ly set to defaults, instead of what is in the current worksheet.

ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁOpen

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁOpens an existing worksheet and makes it active.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁSave

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁSaves all changes made to the current worksheet.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁSave As

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁSaves the current worksheet under a new name.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁImport

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁImports data from stored results files into the current worksheet.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Export
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Exports the worksheet results data out to a “.wsr” file so that applications (such as
Excel) can process the data.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁPrint

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁPrints the worksheet on the selected printer.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁPrint Setup

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁSets up the printer.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Exit
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Exits the CSS50 application.

ÁÁÁÁÁ
ÁÁÁÁÁ

Edit ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Copy ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Copies the contents of the selected cells into the Windows Clipboard.

ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Clear ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Deletes the current value and/or all history for the selected cells.

ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select All ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Selects all of the cells in the spreadsheet.

ÁÁÁÁÁ
ÁÁÁÁÁ

View ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Status Report ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

The Status Report lists the extremes for all of the measurement results.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Results Detail ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

The Results Detail dialog box displays more information about a measurement than
can be contained in a cell on the spreadsheet. Also used to summarize individual
measurements and channels.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁGlobal View

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁThis is a condensed view of the standard spreadsheet display.

2714/2715 Screen Displays a copy of what is displayed on the 2714 or 2715 screen.ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Picture
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

The Picture command displays a video picture of what is presently on a given chan-
nel. (Requires video display hardware.)ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Measurements and Channels
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

This is a View Filter that determines which channels and measurements are on the
spreadsheet. (Hides rows and columns on the spreadsheet.)

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Measurement Sequence 
Results

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

This is a View Filter that displays only those measurements made with the most
recent Measurement Sequence execution.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Test ID Results ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

This is a View Filter that displays only cells that have measurements tagged with the
currently selected Test ID.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Row Header Fields ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

This command determines what channel information is given in the row header. It
can include any combination of the following: Channel Number and Tag, Program
Name, or Channel Frequency.
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Table A–1: CSS50 Menu Bar menu map (cont.)

Menu DescriptionCommand
ÁÁÁÁ
ÁÁÁÁ

Measure
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Current Selection
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Executes measurements for the currently selected cells.
ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁSequence

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁExecutes the currently defined Measurement Sequence.ÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁTune to Channel

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁTunes the instruments to the selected channel.ÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Get Stored Results from
2714/2715

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Retrieves all the CATV measurement results currently stored in the NVRAM of the
connected 2714 or 2715.

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

Configure
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Worksheet Info
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Enables you to specify worksheet Info such as the Site, Channel Table, and descrip-
tion for the current worksheet.

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Test ID ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Brings up a dialog box that enables you to specify a test identifier such as Techni-
cian Name, Test Number, etc. There are two groups in the dialog box: All Test IDs
and Worksheet Test ID. The All Test IDs group lists all of the Test IDs that have ever
been used. The Worksheet Test IDs are the IDs used in the current worksheet.ÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁPreferences

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁEnables you to set preferences in the way results are collected and displayed.ÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Measurement Sequence
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Brings up a dialog box that enables you to program a set of measurements that will
be executed as a Measurement Sequence. This allows a regularly used set of mea-
surements to be called with a single keystroke.

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Measurement Limits ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Brings up a dialog box that enables you to define the Alarm and Caution levels for
the measurement results.

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Measurement Setups ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Brings up a dialog box that enables you to control how measurements are executed
in the instruments.

ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Connections ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Brings up a dialog box that enables you to set the GPIB and RS-232 control connec-
tions.ÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁDemodulator

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁThis command selects the demodulator.ÁÁÁÁ

ÁÁÁÁExecute
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁChannel Table Editor

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁAllows you to switch to or start the Channel Table Editor application.ÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁ

Help
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Contents
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Lists all of the available help topics.

ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

About ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Displays the CSS50 version number and other information.
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Appendix B: Error, Warning, and Informational Messages

The tables in this appendix explain the various types of messages you may
encounter when using CSS50. In the following tables, the term XX represents
information that is dependent on the situation. In practice, XX is replaced by an
instrument name, filename, or number, as appropriate.

Error Messages
Error messages tell you when CSS50 was unable to complete a task as required.
These messages can occur because of equipment malfunctions, corrupted files, or
missing information that must be supplied before CSS50 can continue.

Table B–1: Error messages 

Error 
number Error message Explanation

E61 No GPIB0 Board Found GPIB is not installed or the name of the GPIB board is not “GPIB0”.

E62 GPIB is not System Control GPIB card is not configured for System Controller.

E63 GPIB Write Error A device on the GPIB has prevented data transfer. Check all instruments.

E64 GPIB Read Error A device on the GPIB has prevented data transfer. Check all instruments.

E65 No Listener on Bus No GPIB devices are connected to the controller or they are all turned off.

E66 GPIB Timeout, device not responding Device too slow in responding to command. Instrument may need to be
initialized.

E67 GPIB DOS Error GPIB.DLL not found or incorrect version.

E68 GPIB General Failure Problem with GPIB driver. Refer to National Instrument’s GPIB manual for
troubleshooting and possible reinstallation.

E103 RS-232 Write Error Unable to write to the RS-232 device. Check Cable and device RS-232
settings.

E104 RS-232 Read Error Unable to read from the RS-232 device. Check Cable and device RS-232
settings.

E105 RS-232 Timeout, device not responding RS-232 device not responding in sufficient time. Device may need to be
reinitialized.

E106 RS-232 port not available for this
application.

RS-232 is in use by another application. Close down all other applications
that use RS-232.

E220 Cannot communicate with XX. Cannot communicate with specified instrument. Check that the settings in
the Connections dialog match match the instrument. Check that the cabling
is correct.

E221 Unknown 2714/2715 firmware version. The firmware version of the 2714 or 2715 is not recognized by the CSS50
software and therefore the current operation cannot proceed. Obtain the
correct firmware version.



Appendix B: Error, Warning, and Informational Messages

B–2 CSS50 Cable Television System Software User Manual

Table B–1: Error messages (cont.)

Error 
number ExplanationError message

E222 Cannot allocate memory for 2714 /2715
stored results

System running low on memory. Try closing other applications.

E223 Stored results in 2714/2715 are corrupt The results file(s) in the 2714/2715 are corrupt. The results could not be
retrieved. You may need to delete all stored results from the 2714/2715.

E224 Existing 2714/2715 stored results partially
loaded

Some, not all, existing 2714/2715 stored results were successfully loaded
from the instrument. Usually indicates corrupt stored results. Remove the
stored results from the 2714/2715.

E225 Cannot load existing 2714/2715 stored
results

None of the stored results currently found in the 2714/2715 could be loaded.
Usually indicates corrupt stored results. Remove the stored results from the
2714/2715.

E226 The selected channel cannot be set in the
2714/2715

2714/2715 failed to tune to the channel requested. Channel Table may be
incorrect.

E228 The selected channel table cannot be set
in the 2714/2715

Problem occurred in loading a Channel Table to the 2714/2715. Verify
Channel Table with the Channel Table Editor (CTLOADER) application.
Either the channel table is invalid, or there is no available slot in the
instrument.

E230 You must manually delete duplicate UDP
title: ’XX’ first and then retry

There already is a UDP with that name loaded into the 2714/2715. If you
really want to use that name delete the old name first.

E231 The UDP menu is full. You must manually
delete a UDP from the 2714/2715 first
and then retry.

The 2714/2715 only has room for 9 UDPs. Delete one or more before trying
to load the UDP again.

E232 Reserved

E233 UDP is too large to load, aborting
operation

There is a limit on the number of measurements that can be in a UDP.
Delete some of the measurements and try to reload.

E234 UDP may be too large to execute in the
2714/2715

Delete the UDP from the 2714/2715, remove some of the measurements
from the Measurement Sequence, then reload the UDP.

E235 Gated setup option not available with
2714. Use Auto instead?

Gated Carrier to Noise and CSO measurements can only be made on the
2715. Enter Yes to run in Auto mode instead.

E236 Gated setup option not available with
2714. Turn gated off?

Gated In Channel Response measurements can only be made on the 2715.
Enter Yes to run without Gated mode.

E237 Reserved
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Table B–1: Error messages (cont.)

Error 
number ExplanationError message

E239 The following problems were found in the
Measurement Sequence:

The Gated setup option is not supported
by 2714s. C/N, CSO and ICR will be run
in the non-gated mode

Digital measurements are not supported
by the attached 2714/2715. All digital
tests (Avg Pwr, D/U and ACL) will be
skipped

Only RF measurements are supported by
the 2714s and 2715s. All non-RF
measurements (FCC Baseband, S/N, and
Wfm Dist) will be skipped

See the Create 2714/2715 UDP help
topic for additional details

When creating a 2714 UDP, one or more Carrier to Noise, CSO, or In
Channel Response measurements specified Gated measurement setups.
Since this is not supported by the 2714, the setup was changed to run
without the gated option.

One or more Average Power, Desired to Undesired, or Adjacent Channel
Leakage measurements were requested. These digital tests are not
supported by 2714s and are not supported by 2715s with Firmware Version
09.30.94 or earlier. The UDP may still be generated, but the digital
measurements will be skipped.

E240 Reserved

E241 Reserved

E242 Unknown response received from
2714/2715

The content of the query response was not what was expected. Try the
operation again.

E243 The selected channel’s frequency cannot
be set in the DS1000

The frequency setting for the channel to be measured is outside the tuning
range of the DS1000 series demodulator.

E244 VM100 firmware version is older than
minimum requirement of 2.17.

CSS50 supports VM100 firmware versions 2.17 and higher. Please update
your VM100 in order to perform baseband measurements.

E245 NTSC/PAL Video Standard mismatch
detected between Demodulator, Video
Measurement Set and Channel Table

These three items must be consistent for NTSC or PAL. If the Video
Standard for the channel table is set to NTSC, a VM100 and an NTSC
DS1000 demodulator must be used. If the Video Standard for the channel
table is set to PAL, a VM101 and a PAL DS1000 demodulator must be used.

E300 Error initializing CSS50. The file has become corrupted. Try reloading the application from the
master disk.

E301 CSS50 already running. Only one copy of the CSS50 software can be run at a time. Use the
software that is already open.

E302 Error creating window. Running low on memory. Try closing other applications.

E303 Memory allocation error, operation
canceled.

Running low on memory. Try closing other applications.

E304 Instrument connections could not be
initialized.

Check the instrument’s connections and the cabling. Make sure that the
address is correct.

E305 Error opening file: XX. The file is corrupt or not in the proper format. File cannot be found.
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Table B–1: Error messages (cont.)

Error 
number ExplanationError message

E306 Error closing file: XX The file as been corrupted or the computer is out of memory space.

E307 Error writing file: XX Possibly out of disk
space.

Free some disk space and then try again.

E308 Corrupted data in file: XX. The file is not in the correct format.

E309 End of file encountered in file: XX. The file has been corrupted.

E310 XX file XX is not valid The file is corrupt or the wrong file type. File is found but it is the wrong file
type.

E311 One or more Limits files not found or
invalid

The limits files requested in the current worksheet either are not in the
correct directory, in the correct format, or don’t exist. Limits files must be in
the Limits sub-directory of the executable file.

E312 Error writing CSS50.INI file Out of memory or the application is corrupted.

E313 Error writing WIN.INI file File has been corrupted.

E314 Invalid number The text box is expecting either a number or a letter and received the other.
Retry with valid data.

E315 Number out of range. Enter a number
between XX and YY

Enter a valid number.

E316 CSO offset fell within CTB range of +/-
XX MHz

Change the CSO offset so that it is outside of the CTB range or change the
CTB range.

E317 Site cannot be blank Blank is not a valid Site name. Enter one or select <undefined>.

E318 Test ID cannot be blank Blank is not a valid test ID. Enter one or select <undefined>.

E319 UDP title cannot contain commas or
semicolons, and cannot be blank

Change the UDP title in the text box to remove the invalid characters.

E320 Undefined measurement ID The measurement ID does not exist.

E321 Creation and loading of UDP ’XX’ failed The UDP could not load. Check the 2714/2715 for adequate UDP (NVRAM)
space.

E322 Maximum number of measurements
stored in Worksheet, operation canceled

A Worksheet will only hold 16,000 measurements. Any measurements
previously made have been loaded. Create a new Worksheet or delete
some measurements before continuing.

E323 Maximum amount of clipboard data has
been exceeded

Try using the Export command instead of the Copy command to move data
into other applications, or select smaller blocks of data to copy.

E324 An error occurred while copying data to
the clipboard

The clipboard data is invalid. Try again.

E325 An error occurred while clearing measure-
ment for row XX column XX

The measurements could not be cleared.

E326 Select a cell, entire column, or entire row The Results Detail display needs to know what information you want.

E327 No Limits file selected Select a Limits file from the combination box, before choosing Select Limits
File.

E328 Select at least one measurement and
channel for viewing

The View Filter will not allow a blank data display. Pick at least one
measurement and one channel from the selections.
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Table B–1: Error messages (cont.)

Error 
number ExplanationError message

E329 No stored results selected Select one of the stored results directory entries from the 2714/2715 to
export.

E330 Error initializing help Files are corrupted.

E331 Only 1 help window may be open at a
time

Close the open help window before trying to open another one. The Help
window may be under another window.

E332 Help topic not found The Help file has been lost. Make sure that there is a help sub-directory in
the CSS50 executable directory. Check to see if there are any *.hlp files in
that sub-directory.

E333 Video driver XX not active The Video driver must be running before Picture, from the View menu, can
activate. Make sure that your Video driver is one that is supported by this
application. Make sure that the Video driver title from the Switch To window
for the Video driver is the same name as is in the CSS50.INI file.

E334 Channel Table Editor not found The Channel Table Editor application (CTLOADER) is not in the CSS50
executable directory.

E335 Error printing report An error occurred printing a report. Ensure that print options were
appropriately selected and the printer is correctly connected to the PC.

E336 Channel Table file XX not found or is
invalid

The Channel Table requested either cannot be found or is corrupt. Request
another Channel Table and try again.

E337 Default Channel Table file ‘XX’ is not
found or is invalid

The default Channel Table either cannot be found or is corrupt. Request
another Channel Table and try again.

E340 Limits relationship violated: XX >= YY Caution and Alarm lower and upper limits must adhere to the relationship:
Alarm lower limit < Caution lower limit < Caution upper limit < Alarm upper
limit.

E341 Select one or more check boxes Select at least one check box to indicate which item(s) should be used.

E342 Error loading file xx.dll The indicated DLL could not be loaded; probably because it isn’t in the
CSS50 working directory.

E343 Number out of range. Enter a number
between XX1 and YY1 or between XX2
and YY2.

Enter a valid number in either of the two ranges.

E1000 Error opening file: ’XX’ The file is corrupt or not in the proper format.

E1001 Memory allocation error, operation
canceled

Running low on memory. Try closing other applications.

E1011 Number out of range. Enter a number
between XX and YY

Enter a number between the stated limits.

E1012 Error writing file: XX Possibly out of disk
space

The stated file could not be written.

E1013 XX file XX is not valid The stated file is corrupt or of the wrong type.

E1014 Error initializing help Help files are corrupted.

E1015 Only 1 help window may be open at a
time

Close the open Help window before trying to open another one. The Help
window may be under another window.
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Table B–1: Error messages (cont.)

Error 
number ExplanationError message

E1016 Help topic not found The Help file has been lost. Make sure that there is a help sub-directory in
the CSS50 executable directory. Check to see if there are any *.hlp files in
that sub-directory.

E1017 Error creating window Running low on memory. Try closing other applications.

E1018 Error writing CTLOADER.INI file Out of memory or the application is corrupted.

E1019 Error writing WIN.INI file File has been corrupted.

E1020 CTLOADER already running Only one copy of CTLOADER can be run at a time. Use the copy that is
already open.

E1023 Error printing spreadsheet An error occurred printing a report. Ensure that print options were selected
appropriately, and that the printer is properly connected to the PC.

E1024 Invalid channel table name The channel table filename specified is not valid.

E1025 Attempted write to read-only file The Channel Table file is write protected. Select a different save file name.

E1026 Table Info was incomplete in the selected
file

A Channel Table file must have table information for at least one channel.
The file may be corrupt.

E1027 Selected file has too many channels ––
truncated

The Channel Table file has more channels than the application can handle.
All possible channels were loaded.

E1028 Error initializing CTLOADER One or more executable files have become corrupted. Try reloading the
application from the master disk.

E1029 Select at least one item or press CAN-
CEL

This dialog requires a selection.

E1030 Selected table name is too long or
contains incompatible characters

A Channel Table being read into the application from an instrument has a
name which cannot be converted into a DOS-compatible file name.

E1031 No channel tables found in instrument For Transfer:Delete operation, there are no Channel Tables in the specified
instrument which can be deleted. For Transfer:From operation, there are no
Channel Tables in the instrument of any type.

E1032 GPIB is non-functional or not installed GPIB was selected for communicating with the selected instrument, but is
not installed for Windows.

E1033 Cannot expand table further (500
Channels Max)

The application cannot handle more channels.

E1034 No filename has been defined –– Save
file first

CTLOADER cannot send a Channel Table to an instrument until a filename
has been defined (since this is where the table name is derived from). Save
the Channel Table to a file first, then transfer to an instrument.

E1035 Channel Table ’XX’ contains one or more
invalid fields. Use Limit Check to verify.

When opening the Channel Table file, one or more fields were found to not
meet the limits or data type requirements. Use Limit Check to find out which
field(s) were invalid.

E1040 Channel Table File Read Error: XX The Channel Table is corrupt at the specified line and column.

E1041 Directory read error in XX Could not read the Channel Table directory in the specified instrument.

E1042 Attempted write to read-only table in XX The specified Channel Table cannot be overwritten. Select a new file name,
from which the instrument Channel Table name is derived.
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Table B–1: Error messages (cont.)

Error 
number ExplanationError message

E1043 All channel table slots used in XX. Delete
a table first

Cannot send a table to the specified instrument, since all Channel Table
slots are used.

E1045 Channel Table name too long for XX (YY
characters max)

The Channel Table name is too long for the specified instrument. Select a
shorter file name and retry.

E1046 Incompatible video standard for XX The Video Standard for the stated channel is incompatible with the stated
instrument.

E1047 Incompatible channel width for XX. Enter
a number between XX and YY

The Channel Width for the stated channel is incompatible with the stated
instrument.

E1048 Incompatible aural offset for XX. Enter a
number between XX and YY

The Aural Offset for the stated channel is incompatible with the stated
instrument.

E1049 Incompatible channel number for XX.
(record YY) Enter a number between XX
and YY

The Channel Number for the stated channel is incompatible with the stated
instrument.

E1050 Incompatible visual frequency for XX.
(record YY) Enter a number between XX
and YY

The Visual Carrier Frequency for the stated channel is incompatible with the
stated instrument.

E1051 Incompatible lower channel edge for XX.
(record YY) Enter a number between XX
and YY

The lower channel edge for the stated channel is incompatible with the
stated instrument. The lower channel edge is calculated by adding the
Channel Edge parameter with the Visual Carrier Frequency parameter.

E1052 Incompatible channel type for XX. (record
YY)

The Channel Type for the stated channel is incompatible with the stated
instrument.

E1053 Incompatible test pulse offset frequency
for XX. (record YY) Enter a number
between XX and YY

The test pulse offset frequency for the stated channel is incompatible with
the stated instrument.

E1054 Incompatible channel-specific aural offset
for XX. (record YY)

The Aural Offset for the stated channel is incompatible with the stated
instrument.

E1055 Channel Edge out of range for XX.
(record YY) Enter a number between XX
and YY

The channel edge for the stated channel is incompatible with the stated
instrument.

E1056 Incompatible channel tag for XX. (record
YY)

The tag for the stated channel is incompatible with the stated instrument.

E1057 Incompatible second aural offset for XX.
(record YY) Enter a number between XX
and YY

An invalid value was detected for the second aural offset. Enter a valid
selection.

E1058 Incompatible C/N bandwidth for XX.
(record YY) Enter a number between XX
and YY

The C/N bandwidth for the stated channel is incompatible with the stated
instrument.

E1059 Incompatible amplitude offset for XX.
(record YY) Enter a number between XX
and YY

The amplitude offset for the stated channel is incompatible with the stated
instrument.

E1060 Channels must be in frequency order for
XX. (record YY)

All channels for the stated instrument must be listed in order of ascending
visual carrier frequency. The stated channel (at least) is out of order.
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Table B–1: Error messages (cont.)

Error 
number ExplanationError message

E1061 Too many channels in XX, table XX The Channel Table in the specified instrument contains more channels than
the application can handle.

E1062 Too many channels in file XX The Channel Table file has more channels than the application can handle.

E1063 Too many channels for XX The specified instrument cannot store all of the channels in the current
Channel Table.

E1064 Incomplete channel table information The application read all of the Channel Table information possible, but was
not able to read all channels.

E1065 Channel Table XX is unavailable. Select it
in the YY and try again

The read-only channel tables in the 2714/2715 are not readable via RS-232
or GPIB unless they are selected first. Select the table via the 2714/2715
menu system and try again.

E1066 Transfer was incomplete –– Unknown
Error

The channel table was transmitted to the instrument, but was not found in
the instrument when checked at a later time.

E1067 Invalid GPIB Address for XX Check the Connections information for the instrument in the Transfer:
Connections menu selection.

E1068 Channel Table is in use in instrument XX
and cannot be deleted or overwritten

Select a different table in the instrument before attempting to delete or
overwrite the table.

E1069 Channel Table name is incompatible with
XX

Some of the characters in the Channel Table name are inappropriate for the
stated instrument.

E1070 Channel Tables in the XX are incompat-
ible with this version

All channel tables in the stated instrument are incompatible with the current
version of CTLOADER.

E1071 Channel Table XX already exists. Delete
it first

When attempting to transfer a channel table to an instrument, a channel
table with the same name was found. Delete it from the instrument first.

E1072 Cannot overwrite an XX NVRAM Fixed
table

When attempting to transfer a channel table to an instrument, a fixed
channel table of the same name was found. Enter a different name to
transfer the table to the instrument.

E1073 Incompatible second aural offset for XX.
(record YY)

For the 2714/2715, the second aural offset must be a number within the
acceptable range.

E1074 Incompatible quiet line with XX. (record
YY) Enter a number between XX and YY

Enter a number within range.

E1075 Incompatible white line with XX. (record
YY) Enter a number between XX and YY

Enter a number within range.

E1076 Incompatible ICR test line with XX.
(record YY) Enter a number between XX
and YY

Enter a number within range.

E1078 Duplicate channel numbers are not
allowed for XX. (There are duplicate
channel number YY’s.)

Assign unique channel numbers to each channel.

E1080 Multiple channel widths are incompatible
with THIS 2714/2715 (1st difference at
record nnn)

2714 and 2715 instruments with firmware versions 09.29.94 and earlier will
not accept multiple channel widths. Use the Copy Field to End command to
make all widths the same.
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Warning Messages
Warning messages tell you when CSS50 needs additional information from you
before it can continue or that, if you continue, there may be a loss of information
or settings because of the action being taken.

Table B–2: Warning messages 

Warning 
number Warning message Explanation

W350 Worksheet has changed. Do you wish to
save it?

Save your changes or they will be deleted.

W351 Limits have changed. Do you wish to
save them?

Save the changes or they will be deleted and the Limits file will revert to its
previous values.

W352 Attempt to save the Worksheet and exit
the application

Memory is getting full. Save what you can and exit CSS50. Then attempt to
restart the application.

W353 Selected items will be copied to all
channels. Proceed?

Whatever was previously in those channels will be overwritten.

W354 Import site: XX does not match worksheet
site: XX Continue importing results?

All of the data being imported will be given the current worksheet Site if the
import continues.

W355 Should worksheet site: XX be changed to
import site: YY ?

You can change the worksheet Site name to match the import site name. If
you do, any data previously in the worksheet will be associated with the new
Site name.

W356 Import channel table: XX does not match
worksheet channel table: YY Continue
importing results?

The results will be loaded into any channel numbers that match. Data
without a channel match in the worksheet is ignored.

W357 Do you want to turn the Sequence view
filter on?

The Sequence View Filter will allow you to see only the results of the
Measurement Sequence and not the entire spreadsheet.

W358 Do you want to turn measurement history
collection on?

Older data will be overwritten if the Measurement History collection is not
turned on.

W359 If you have edited your worksheet
Channel Table, changes will not take
effect until you create a new worksheet

The Channel Table was edited and has changed (although the name has not
changed); you should put the edited Channel Table in a new Worksheet.

W360 No channels found which match the
specified Carrier Level Difference
Parameters

This would occur if the Channel Table included all analog channels and you
selected the Digital Channels Only from the Parameters dialog box. It
affects the Max, Min, and Max-Min values which would be displayed as
blanks.

W361 No channels found which match the
specified Adjacent Channel Difference
Parameters

This would occur if either no adjacent channels fell within the specified
adjacent channel window, or if there weren’t two channels within the range
which were of the specified channel type. The results will be displayed as
blanks.

W362 If you edit your worksheet channel table,
changes will not take effect until you
create a new worksheet

When making most changes to the worksheet channel table, it is necessary
to create a new worksheet to have those changes take effect.
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Table B–2: Warning messages (cont.)

Warning 
number ExplanationWarning message

W363 Carrier levels have been selected on all
channels. Run Survey instead?

Your measurement selection includes carrier levels on all channels. You can
run a survey substantially faster. Possible drawbacks are that all results
have the same date/time stamp and the spreadsheet is not updated until the
survey completes. Select Yes to run the Survey, or No to run individual
carrier level measurements on each channel.

W1100 Channel Table changed. Do you wish to
save it?

Answer YES, if the current Channel Table is to be saved to a file.

W1101 Multiple channel widths are incompatible
with some 2714/2715 (first difference at
record nnn)

The channel table contains more than one channel width. 2714 and 2715
instruments with firmware versions 09.29.94 or earlier will not accept a
channel table with multiple channel widths. (See error 1080 on page B–8.)

Informational Messages
Informational messages tell you when something has changed; for example,
when a file import has been completed.

Table B–3: Informational messages 

Message Explanation

Instrument connections have been changed. The connection information of the equipment has been changed in the Channel
Table Editor.

Import complete. XX results imported. The data has been loaded into the worksheet.

Import complete. XX results imported.

Note: Some results were not imported due to
Channel Header Mismatch.

This message appears at the end of an import. It only appears if there were
mismatches in the Channel Table Header (channel number, frequency, tag, or
program). For most of these cases, mismatches are flagged during the import
process and you are allowed to overwrite any mismatches. The exception is
channel number. If the channel number does not match, then it is simply
skipped and you are not flagged except for this message.

There are no measurements for the selected view. The View Filter must have some valid measurements and channels before it is
allowed to be enabled.

There are no more measurements for the selected
view. Removing View Filter.

After clearing the selected cells, the View Filter is no longer valid. It will revert
back to normal view.

A tunable channel cannot be determined from
current selection.

More than one channel has been selected. Select one cell, then try again.

No stored results were retrieved from the 2714/2715. No results files or they were empty.

Only a sequence may be executed when the
sequence view filter is active.

No other measurement can be made.

A sequence has not been defined. You cannot run a Measurement Sequence. Use Measurement Sequence, from
the Configure menu, to create a Measurement Sequence.
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Table B–3: Informational messages (cont.)

Message Explanation

Some of the imported results may not be displayed
due to an active view filter.

You may have imported more data than is displayed. Turn the View Filter off to
display all of the data.

Default Limits file XX not found or invalid. Create a new Limits default file by choosing the Save As Default Limits
command button, from the Edit Limits File dialog box

Limit check passed for specified instrument. All parameters in the Channel Table were within limits for the 2714/2715.
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Appendix C: Channel Table Editor

The purpose of Channel Table Editor is to create and edit Channel Tables. You
create Channel Tables in the Channel Table Editor and then load them into the
test equipment for automated testing and measurement gathering. Although
CSS50 can call the Channel Table Editor, it is also a standalone application.

What’s in this appendix:

� Starting the Channel Table Editor

� Creating a new Channel Table

� Editing an existing Channel Table

� Loading a Channel Table into the test equipment

� Notes on usage

� Channel Tables provided with CSS50

� Overview of the Channel Table Editor commands
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Starting the Channel Table Editor
To start the Channel Table Editor, select Channel Table Editor from the Execute
menu or Create/Edit Channel Table from the Worksheet Info dialog box of the
Configure menu. The Create/Edit Channel Table command button calls the
Channel Table Editor.

NOTE. When starting from the Worksheet Info dialog box, it is not good practice
to type a name into the combo box on the Worksheet Info dialog box before going
into the Channel Table Editor. Select a name from the list provided. You can
change Channel Tables once you’ve entered the Channel Table Editor. Always
include the “.cht” filename extension.

The results (with the standard Channel Table std.cht loaded) are in Figure C–1.

Figure C–1: Main window of the Channel Table Editor
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Creating a New Channel Table
Use the following procedure to create a new channel table which is not based on
an existing channel table.

From the File menu, choose New. This clears the Channel Information and loads
the default values into the Table Information.

1. Choose the Edit Table Information command button from the Button Bar.
This displays the Edit Table Information dialog box as shown in Figure C–2.

Figure C–2: Edit Table Information dialog box

2. Enter a name for the new Channel Table in the Table Name text box (for this
example, enter �����). The ���� filename extension is added automatically.

3. Enter the number of channels.

4. Enter the appropriate Aural Offset value for your system.

5. Select the correct Video Standard option button, either NTSC or PAL.

6. Click on OK to save the changes and exit the Edit Table Information dialog
box.

Clear the Channel Table

Edit the Table Information
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1. Start with the first channel as shown in Figure C–3.

Figure C–3: Test1.cht Channel Table before beginning the edits

2. Enter data into the Chan #, Program, Tag, and Visual Frequency text boxes.

3. Fill in the rest of the data by selecting the cell and either selecting from the
drop-down list box or entering data in the text box. (See page C–23 for more
details on the various Channel Table fields.)

NOTE. If you are using the keyboard, use ALT+� to open the field’s drop-down
list boxes.

4. Click on Save. The application window now looks similar to Figure C–4.

Edit a Channel
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Figure C–4: Channel Table Editor with one channel’s data entered

Creating a Channel Table from an Existing Channel Table
In the previous section you learned how to create a Channel Table. While you
can create a channel table from scratch, it would take a long time to do so,
editing one channel at a time. It is much easier to take an existing Channel Table
and edit it to conform to your needs.

1. From the File menu, choose Open. The dialog box shown in Figure C–5
appears.

Figure C–5: Open dialog box

Editing an Existing
Channel Table
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2. Select “std.cht” from the File Name list box. This Channel Table comes with
the CSS50 application.

3. Click on OK. The Channel Table will load and will appear similar to
Figure C–6.

Figure C–6: The std.cht Channel Table

4. From the File menu, choose Save As. The dialog box looks similar to
Figure C–7.
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.

Figure C–7: Save As dialog box

5. Enter �������� in the File Name text box.

NOTE. The Channel Table Editor automatically adds the “.cht” filename
extension.

6. Click on OK to save the changes and leave the Save As dialog box. Changes
are made in your learners.cht and not the std.cht file.

7. Select the first channel and make any changes that might be required for
your system.

8. Repeat these steps for all channels in your system.

9. If any fields are the same for all channels, click on Copy Fields in the Button
Bar. Figure C–8 shows the resulting dialog box.
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Figure C–8: Copy Fields to End dialog box

10. Select all of the fields you want to be the same as the channel that you are
editing.

11. Click on OK to copy these fields to all channels below it in the Channel
Table.

12. If there are any channels that are not in your system, select the channel (by
clicking on the REC # cell) and click on Delete to remove them.

13. From the File menu, choose Save to save the edited Channel Table.

Loading a Channel Table into the Test Equipment
Now that you have created a custom Channel Table for your system, you must
load it into the test equipment.

1. From the Transfer menu, choose To.

2. The channel table will be downloaded to the 2714 or 2715.

These are the basics that you need to use the Channel Table Editor application
with the CSS50 application.

Channel Table Cautions
When creating or using a channel table, follow these cautions to ensure that the
software functions properly.
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The Channel Table used by the software must match the Channel Table in the
2714 or 2715. Also, the Channel Tables used by the software and the equipment
must match the cable system connected to the equipment. If any of the three do
not match, measurements you take will be incorrect, errors will be returned, or
the software will behave unpredictably.

The 2714 will not run digital measurements, but uses the same channel table
format as the 2715. If the software attempts to take a measurement on digital
channels using the 2714, measurements returned will be incorrect, errors will be
returned, or the software will behave unpredictably.

For the CSS50 measurements to execute properly, the corresponding Channel
Table in the 2714 or 2715 must be identical to the Channel Table specified in the
CSS50 Worksheet Header. If the CSS50 software finds that the Channel Table in
the 2714 or 2715 does not match (by NAME) the channel table that the CSS50 is
using, the CSS50 loads the Channel Table it is using into the 2714 or 2715.

This scheme allows you to easily switch to different named Channel Tables as
follows:

1. Choose Worksheet Info from the Configure menu.

2. In the Channel Table group, select a new table from the combo box.

3. Click on OK to end the worksheet Info dialog. At this point a new worksheet
is created. A message appears, allowing you to save the old worksheet.

4. When a measurement executes on this new worksheet, the CSS50 software
automatically selects the new Channel Table in the 2714 or 2715. If the
named Channel Table does not exist in the instrument, the Channel Table
loads into the instrument before making the measurement.

The CSS50 software detects Channel Table mismatches by comparing the
Channel Table name only. It does not compare the contents of the Channel
Tables. Therefore, use caution when editing named Channel Tables. For instance,
assume the current worksheet is using a Channel Table named MYSYS-
TEM.CHT and that this Table exists in the 2714 or 2715. Now suppose the
Channel Table is edited, using the Channel Table Editor to add channel 78, and
then saved under the same name, MYSYSTEM.CHT. Upon returning to the
CSS50 worksheet, notice that the new channel is not present in the spreadsheet.
Also notice that the new channel will not be present in the MYSYSTEM table in
the 2714 or 2715. So that even if a new worksheet is created, which includes the
edited Channel Table, the new channel will still not be accessible in the
instrument for the measurements. This is because the CSS50 compares Channel
Table names and not contents.

Use the following guidelines for editing existing Channel Tables:

Matching Channel Tables
in the CSS50, Test

Equipment, and the 
Cable System

Channel Table Names
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If an existing Channel Table is edited in any way, it is easiest to save it under a
different name. Then create a new worksheet to use this Channel Table.

If an existing Channel Table must be edited and saved to the same name, perform
the following steps:

1. Start with the Channel Table as the current one in the worksheet. (Its name is
in the Worksheet Header.)

2. Choose Worksheet Info from the Configure menu. The current Channel
Table is already selected in the Channel Table Group combo box.

3. Click on Create/Edit Channel Table to start the Channel Table Editor.

4. The Current Table is in the editing buffer of the Channel Table Editor. Edit
the Table as required and then save the Channel Table, using the same name.

5. If a Channel Table using the same name currently exists in the 2714 or 2715,
delete it from the 2714 or 2715.

NOTE. You can’t delete a channel table from the 2714 or 2715 if it is the selected
table.

6. Use To, from the Transfer menu, to transfer the edited Channel Table to the
2714 or 2715.

7. Exit the Channel Table Editor and return to the CSS50 Worksheet Info
dialog box.

8. Click on Cancel to return to the CSS50 worksheet.

9. Choose New from the file menu to create a new worksheet to use the
“edited” Channel Table.

The Channel Table fields have limits. If these limits are exceeded you will be
able to open the Channel Table but will be given a warning that there is a
problem with the file. Use the Limits Check, from the Transfer menu, to find the
problems and correct them.

The Channel Table Editor is an application that can be used independently of the
CSS50. However, do not perform any Channel Table Loader operations while
measurements are taking place using CSS50. Do not change or load a Channel
Table while an instrument is using the table.

If you enter the Channel Table Editor from CSS50 via the Create/Edit Channel
Table command button and you make a new Channel Table, the Channel Table
list is not immediately updated in the Worksheet Info dialog box when you

Out of Bounds Limits

Independent Operation

Channel Table Names
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return to the CSS50 application. You must close the dialog box and open it again
before the new Channel Table appears in the list.

The Channel Table is not changed unless you create a new worksheet. This
prevents you from corrupting data on the current worksheet.

The software does not download Channel Tables into the DS1000 series
demodulators as it does with the 2714 or 2715. When the demodulator needs to
be tuned to a different channel, that channel’s frequency is obtained from the
channel table and then the demodulator is tuned to that frequency.

Channel Tables Provided
Channel Tables provided with CSS50 represent Channel Tables pre-loaded in the
2714 or 2715. The only exception is STDOFST.CHT, which is not associated
with any instrument. If you must edit a Channel Table, you should rename it,
being careful not to use a name from the list in Table C–1.

Table C–1: Channel Tables provided with CSS50 

From what 
instrument

Channel table
name Contents/function

2714 or 2715 STD.CHT1 United States CATV standard channels

HRC.CHT United States CATV HRC (Harmonically Related
Carriers) channels

IRC.CHT United States CATV IRC (Increment-Related Carriers)
channels

None B-CAST.CHT North America VHF/UHF Broadcast channels

CATV-HRC.CHT United States CATV HRC (Harmonically Related
carriers) channels

CATV-IRC.CHT United States CATV IRC (Increment-Related Carriers)
channels

CATV-KOR.CHT Korean CATV standard channels

CATV-STD.CHT United States CATV standard channels (no
T-Channels)

CHINA-DK.CHT China system D/K UHF/VHF

CHIN_DK.CHT China system D/K UHF/VHF

DS1000 Series and
Channel Tables
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Table C–1: Channel Tables provided with CSS50 (cont.)

From what 
instrument Contents/function

Channel table
name

EUR-BG.CHT European system B/G UHF/VHF and CATV

EUR-I.CHT European system I UHF

EUR_I.CHT European system I UHF

EUR_I1.CHT European system I UHF

JAPAN-M.CHT Japan system M UHF/UHF

JAPAN_M.CHT Japan system M UHF/UHF

SDTOFST.CHT United States CATV standard channels with common
frequency offsets applied

STNDRD.CHT United States CATV standard channels (no
T-Channels, frequency limited to channel 94)

1 The tuning range of a DS1000 series demodulator is 55.25 MHz to 801.25 MHz for
NTSC and 45.25 MHz to 860.25 MHz for PAL. Attempting to tune to channels outside
this range, like the T-Channels (907 – 913) will result with the error message “The
selected channel’s frequency cannot be set in the DS1000.”

Overview
This section goes through each of the menu commands and gives a brief
description of what they are and how they work.

Figure C–9: Title Bar menu

Restore. The Restore command returns the Channel Table Editor application
window to its previous size and position. It is often used to change an icon back
into a window. It will also change the window between two different sizes and
positions. It performs the same functions as the Restore command button (small
box with both up and down arrows) on the upper right hand corner of the
worksheet.
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Move. Move allows different placements of the Channel Table Editor window.
This is equivalent to clicking on the Title Bar and holding down the left mouse
button to reposition the display. The Move command is only allowed if the
application window is not at its maximum size.

To use Move with the keyboard:

1. Choose Move. (Press ALT+spacebar, then type m.)

2. Press the arrow keys until the window is in the desired position.

3. Press ESC to stop moving the window.

Size. Size allows you to change the size of the application window.

Minimize. The Minimize command changes the application to an icon. The
application is still running but it is no longer the active window. Channel Table
Editor stays in exactly the same operating state as when it was converted to an
icon. This performs the same function as the Minimize button (small box with
the down arrow) on the upper right hand corner of the worksheet. (See Fig-
ure 3–1 on page 3–3.)

Maximize. The Maximize command changes the application from an icon back to
the active window. This also changes a sized window into one that fills the entire
display area. Maximize performs the same function as the Maximize command
button (small box with an up arrow) on the upper right corner of the worksheet.

Close. Closes the Channel Table Editor application window and exits the
application.

The Menu Bar of the Channel Table Editor (see Figure C–10) provides access to
all of the Channel Table Editor’s functions.

Figure C–10: Menu Bar

File. The File menu (see Figure C–11) contains the basic Windows file manipula-
tion commands, described in the following paragraphs.

Menu Bar
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Figure C–11: File menu

� New. New empties the Channel Table and gives you a blank Channel Table.
New prompts for save if the current Channel Table has been modified.

� Open. Open loads a previously existing Channel Table. A dialog box
prompts for a file. See Figure C–12.

Figure C–12: Open dialog box

� Save. Saves the changes made to the Channel Table to the file specified in
the main Window caption. If the Channel Table has no name, it will prompt
you for one.

� Save As. Saves a Channel Table under a new name. See Figure C–13.
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Figure C–13: Save As dialog box

� Print. Prints the current Channel Table. See the Windows manual for more
information on this dialog box. See Figure C–14.

Figure C–14: Print dialog box

� Print Setup. The Print Setup dialog box allows you to configure the printer
as required. See Figure C–15. This is the same dialog box accessed through
the Setup command button in the Print dialog box.
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Figure C–15: Print Setup dialog box

� Exit. Closes the Channel Table Editor application. Prompts for confirmation
if the current Channel Table has been modified.

Edit. The Edit menu (see Figure C–16) contains the commands used to modify
the Channel Table. They are: Insert, Delete, Append, Copy Fields to End, Edit
Table Info, and Sort.

Figure C–16: Edit menu

� Insert. The same as Insert from the Button Bar. Insert places a blank row into
the Channel Table (only the default values are filled in). The channel is
placed just before the selected (active) channel.
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� Delete. Removes the selected channel from the Channel Table. Same as
Delete from the Button Bar. This command is only available when a channel
has been selected.

� Append. Functions the same as Insert, except it adds the new channel to the
end of the Channel Table.

� Copy Fields to End. This command allows you to copy the selected channel
fields to all of the channels below the selected one in the Channel Table. See
Figure C–17. Use this command to quickly make “universal” changes.

Figure C–17: Copy Fields to End dialog box

� Edit Table Info. Edit Table Info opens the Edit Table Information dialog box
filled with the information that is standard throughout the Channel Table.
See Figure C–18.

Figure C–18: Edit Table Information dialog box



Appendix C: Channel Table Editor

C–18 CSS50 Cable Television System Software User Manual

Table Name. The name of the Channel Table.

Number of Channels. The number of channels in the Channel Table. If you
edit this number to increase the number of channels, blank channels are
added to the end of the Channel Table. The maximum number of channels
available is 500. If you decrease the number of channels, the channels are
deleted beginning with the last channel in the Channel Table and working
backward.

NOTE. The maximum number of channels that the instruments can handle is 200.

Aural Offset. The nominal difference between the visual and aural carriers.
The 2714 or 2715 uses this parameter.

Video Standard. Either NTSC or PAL.

� Sort. You can sort the channel table three ways:

By Channel Number. Sorts the entire Channel Table using the channel
number as the sort key.

By Frequency. Sorts the entire Channel Table by frequency.

By Program. Sorts the entire Channel Table by program.

Transfer. The Transfer menu loads the Channel Table into the 2714 or 2715 and
can also extract or delete Channel Tables from the instrument. The commands in
the Transfer menu are shown in Figure C–19.

Figure C–19: Transfer menu

� To 2714/2715. Takes the current Channel Table and loads it into the 2714 or
2715.
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NOTE. If the Channel Table is currently in use by the instrument, this command
will be refused.

� From 2714/2715. Extracts an existing Channel Table from the 2714 or 2715
and puts it in a format the Channel Table editor can use. It prompts for
confirmation if the current Channel Table has been modified, but not saved
to a file, since it will be overwritten during this operation.

The dialog box shown in Figure C–20 appears. It lists all of the Channel
Tables currently in the 2714 or 2715. Select which Channel Table you want
copied, then click on OK. The Channel Table is then copied from the 2714
or 2715 to the Channel Table Editor window.

Figure C–20: From (Select Table) dialog box

� Delete. Deletes a Channel Table from the 2714 or 2715.

The dialog box shown in Figure C–21 appears. Notice this list is different
than the one in Figure C–20 for the From command. The From command
lists all of the Channel Tables, while the Delete command only lists
user-created Channel Tables. This prevents accidentally erasing built-in
Channel Tables.

NOTE. If the Channel Table is currently in use by the 2714 or 2715, this
command will be refused.
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Figure C–21: Delete (Select Table) dialog box

� Select. This command allows you to make a specific Channel Table in the
2714 or 2715 active. You are given a list of the current Channel Tables in
that instrument similar to the From list in Figure C–20. You select the
desired Channel Table from that list.

To update a channel table that is in use:

1. Select a channel table other than the one in use.

2. Delete the channel table you intend to update from the 2714 or 2715.

3. Send the updated channel table to the 2714 or 2715.

4. Select the updated channel table in the 2714 or 2715.

� Limit Check. Limit Check checks all of the Channel Table data for compati-
bility with the 2714 or 2715. If any problems are found with the Channel
Table data, a message box is displayed, describing the first problem found.
See Figures C–22 and C–23.

Figure C–22: Multiple channel widths are incompatible with 2714 and 2715 warning
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Figure C–23: Limit Check passed message

� Connections. Use the Connections dialog box (shown in Figure C–24) to set
the GPIB and RS-232 port addresses for the 2714 or 2715 in the Channel
Table Editor. This is for loading and retrieving Channel Tables in the 2714 or
2715 NVRAM. If the 2714 or 2715 settings were correct in the CSS50
application they will not need to be edited here. (Any changes in this dialog
box affect both applications.).

Figure C–24: Connections dialog box

Help. The Help menu contains access for on-line help.

� Contents. Contents displays information about Channel Table Editor,
including a description of the main window.

� About. Displays the version number and copyright information. See
Figure C–25.
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Figure C–25: Channel Table Editor About dialog box

Button Bar

Opens an existing Channel Table. Same as Open from the File menu. (See
page C–14.)

Updates the Channel Table information. Same as Save from the File menu. (See
page C–14.)

The same as Insert from the Edit menu. (See page C–16.)

The same as Delete from the Edit menu. (See page C–17.)

The same as Copy Fields to End from the Edit menu. (See page C–17.)

This is the information that is the same for every channel of a Channel Table: the
Name, Number of Channels, Aural Offset, and the video standard. This
command button is the same as double-clicking on the Table Information list box
or choosing Edit Table Info, from the Edit menu. (See page C–17.)

Open

Save

 Insert

Delete

Copy Fields

Edit Table
 Info
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Channel Table Fields

Chan # . The commonly known number of this channel.

Program. A 6-character identifier for the channel, used for the channel’s call
letters or abbreviated name.

Tag. A 3-character designation for the channel, such as “AAA” or “2 B”. It must
be uppercase alphanumeric (0-9 and A-Z, space is OK as long as there are
additional valid characters).

Visual or Center Freq. The visual carrier frequency in MHz or the channel’s center
frequency for digital channels.

Channel Width. The width of the channel. In 2714 or 2715 instruments with
firmware version 09.29.94 or earlier, only one channel width can be specified
and it applies to all channels. To unambiguously determine a channel width
when sending to one of these instruments, all channel widths must be the same.
You can use the Copy Field to End command to make all channel widths the
same.

Channel Edge. The frequency difference between the visual or center frequency
and the lower bound of the frequency allocation. For example, for analog
channel 2 in the USA, the Visual or Center Freq is set to 55.25 MHz, the
Channel Edge is set to –1.25 MHz, and the Channel Width is set to 6.0 MHz.
For digital channels, the Channel Edge should be one-half of the Channel Width.
For example, a digital channel centered between 57 and 60 MHz should have the
following values in the channel table: Visual or Center Freq set to 58.5 MHz,
Channel Width set to 3 MHz, and Channel Edge set to –1.5 MHz.

2714/2715 Channel Type. The type of signals transmitted on this channel: CATV,
FM, Pilot, or Digital.

2714/2715 Second Aural. The offset between the visual carrier and the second
aural carriers. This value must be at least 200 kHz above the first aural carrier
and below the channel edge. Only used by the 2715 and firmware version
1.12.94 and later of the 2714.

Scramble. Whether or not this channel is scrambled.
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Use White. Selects whether the white line or the whole field should be used in the
amplitude measurements.

White Line. The location of the white line.

Use Quiet. Selects whether the quiet line or the whole field should be used in the
Carrier to Noise and CSO measurements. If Use Quiet Line is NO, then the
instrument will auto search for unmodulated lines on which to make Carrier to
Noise and CSO measurements. If Use Quiet Line is YES, then the instrument
will use the line number supplied in the Quiet Line field (below). (2715 only.)

Quiet Line. The quiet line in the video signal used for making the Carrier to Noise
and CSO measurements. It must be between 9 and 525.

Use ICR. The ICR measurement should be made using the specified test line. If
Use ICR is NO, then this measurement is skipped. If you attempt to make a
measurement on a channel with Use ICR set to NO, the instrument will try to
execute the measurement, but color the results cell blue to indicate that there was
a problem with the measurement. (2715 only.)

ICR Test Line. The location of the ICR test line in the video signal. This line
number is placed in the Notes field for the measurement results. The test line can
be either multiburst or Philips GCR ghost canceling signal or Sin(x)/x. You can
change the ICR Test Line from the 2715’s front panel and the value will be
stored in the instrument’s Channel Table (2715 only).

Video Polarity. Polarity of the video signal.

Sync Polarity. Polarity of the sync pulse.
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Appendix D: FCC Measurements

NOTE. The methods given in this chapter are just suggestions. It is the operator’s
responsibility to comply with FCC requirements.

This chapter discusses how to perform FCC Headend and Field measurements.
Most of the information is not applicable outside of the Unites States. Use it as a
starting point to help you define your own procedures to meet FCC Measurement
requirements. This chapter assumes you are familiar with the following concepts:

� Configuring Worksheets

� Defining Measurement Sequences

� Generating 2714/2715 UDPs

� Getting 2714/2715 Stored Results

� Importing/Exporting Measurement Results

� Viewing Results

� Using the Clipboard

Organizing Worksheets and Measurement Results
The FCC testing requirements result in large numbers of measurement results,
even for modest systems. Organizing these results in a reasonable way allows for
quick access to the results for verification, analysis, and reporting. The directory
structure shown in Figure D–1 is a good example of how to organize FCC
performance test results. The remainder of this chapter describes how to create
this structure, fill it with test results, and access the results for verification,
analysis, and reporting.

For example, create the directory structure shown in Figure D–1, using the
Windows Explorer. You can place this directory tree anywhere, but not in your
LIMITS directory for CSS50. It is good practice not to put anything in the
Limits directory except Limits files.
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HEADEND.WRK

FCCTESTS

JULY95

HEADEND

HEADEND.WSR

FIELD

FIELD.WRK

TP132.WSR

TP146.WSR

TP132–PC.WSR

TP146–PC.WSR

1

2

3

5

6

4

7

8

Figure D–1: Organization of files for logical record keeping

1. FCCTESTS is a directory that contains all of the FCC type measurement
results.

Group each test session by the month and year performed. A test session is
defined as all the FCC required twice-yearly performance tests for a
particular system.

2. JULY95 is a sub-directory of the FCCTESTS directory that contains all of
the measurement results for July of 1995.

Group the performance tests by those required at the Headend (output of
modulating or processing equipment) and those required at the field test sites
(for example, subscribers’ terminals).

3. HEADEND is a sub-directory of JULY95 that contains the results of the
Headend measurements for that month. (Notice that there are no files above
this level – only directories.)

4. FIELD is a sub-directory of JULY95 that contains all of the field measure-
ments made that month. (Again, notice that there are no files above this level
– only directories.)

5. HEADEND.WRK is the worksheet used to define, control, and collect
results for this Headend test session.

6. HEADEND.WSR contains the actual results from this Headend test session.
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7. FIELD.WRK is the worksheet used to define, control, and collect results for
this field test session.

8. The rest of the files are the actual measurement results from the TP132 and
TP146 test Sites (Test IDs) collected during this session.

FCC Headend Measurements
The FCC Headend measurement requirements consist of a series of RF and
baseband measurements taken on a set of channels at the Headend.

The following describes how to use a Measurement Sequence to perform all the
available Headend measurements and how to collect and present the measure-
ment results.

Configure a new worksheet to match the system and testing methods.

1. Choose New, from the File menu.

� Set the Channel Table and Site name to match the system. For example,
use STD.CHT for Channel Table and Headend name for Site.

2. Set up the worksheet items listed below from the Configure menu:

� Test ID – Set to a test session identifier or operator name such as
“Headend Test 7-16-1995”.

� Preferences – Measurement History is not required for this example, so
set it to Keep Last Result Only.

� Measurement Limits

� Measurement Setups

Define the Measurement Sequence used to execute the required measurements.

1. Choose Measurement Sequence from the Configure menu.

2. Define the measurements by choosing the FCC Headend Msmts command
button. This provides a method to easily select the required measurements.
Carrier Levels and Frequencies are automatically selected for all channels.

3. Select specific test channels for the FCC Baseband measurements (which
includes chroma-luma delay, differential gain, and differential phase) using
the Select command button. These are the system-specific test channels
chosen to comply with the FCC regulations on number of test channels
based on system frequency limit.

Configure a New
Worksheet

Define the Measurement
Sequence
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4. Select the OK button when the selected test channel list is correct. The
Measurement Sequence dialog box displays the selected FCC Headend
measurements.

5. Define the Measurement Sequence execution time parameters by choosing
the Edit Time Parameters command button.

6. Set it up to run immediately, 1 time.

7. Select OK to return to the Measurement Sequence dialog.

8. Select OK to return to the worksheet.

9. Execute the Measurement Sequence using the Exec Seq command button on
the Button Bar, or Measurement Sequence, from the Measure menu.

The Measurement Sequence executes the FCC Headend measurements.

10. When the sequence is complete, answer Yes to turn on the Measurement
Sequence View filter. The worksheet displays only the results from the
Measurement Sequence just completed (that is, the FCC Headend perfor-
mance tests).

1. Choose Global View, from the View menu, to look for measurement cautions
and/or alarms.

2. Display a Status Report by selecting all of the cells in the Global View and
choose the Results Detail command button.

3. If you wish, print the report using the Print button.

4. Choose Close to leave the Status Report.

5. Choose Close to leave the Global View.

6. Choose Export, from the File menu, to save the measurement results to a
results file for archiving and importing to other report tools.

a. In the directory list box select: FCCTESTS/JULY95/HEADEND.

b. In the File Name, enter HEADEND.WSR.

c. Choose OK to export the results.

7. Optionally, use Select All and then Copy, from the Edit menu, to copy the
results to the Clipboard for transfer to other tools, (for example, MS-Excel,
or MS-Word). Once the results are exported or copied, use other data
analysis tools (such as MS Excel) to generate complete FCC Proof Reports.

Summarize the
Measurement Sequence

Results
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Use Save As, from the File menu, to save the worksheet for future reference.

1. Choose Save As from the File menu.

2. In the directory list box, select FCCTESTS/JULY95/HEADEND.

3. In the File Name box, enter HEADEND.WRK.

4. Select OK to save the worksheet.

FCC Field Measurements
The FCC field measurement requirements consist of a series of, primarily, RF
measurements taken on a channel set at various points in the system. Since the
2714 or 2715 Spectrum Analyzer can make all of the required measurements, the
following describes how to define and use 2714 or 2715 User Defined Programs
(UDPs from Measurement Sequences) to perform the field measurements and
how to collect and present the measurement results.

FCC field testing uses three separate UDPs: one for the pre-converter perfor-
mance tests, one for the post-converter performance tests, and one for the visual
carrier 24-hour variation and 30M Carrier Level Performance Test.

NOTE. The CSS50 package is transportable to field test sites for collection of
performance test results at RF and Baseband using a Measurement Sequence.
This is a direct extension of the procedures explained in previous chapters and
further discussion is not included.

Use the three UDPs at each of the required test Sites. Note that since the
measurement setup parameters (for example, external attenuation/amplification)
are loaded into the UDPs, these parameters are set the same for each test Site. If
each Site needs different parameters, create separate UDPs for each test Site. For
example, the external attenuation/amplification setup defines the test point loss
for the Carrier to Noise measurements. The FCC requires levels measured at the
subscriber terminals and at the end of cable drops (locations with 0 dB offset).

Using the UDP measurement method described, remove the 2714 or 2715 from
the CSS50 package and take it to the various test Sites for measurement
execution and storage of results (in the 2714 or 2715 NVRAM). Later, reconnect
the 2714 or 2715 to the CSS50 package for results collection and presentation.

Save the Worksheet
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Configure a new worksheet to match the system and testing methods used for the
FCC Post-Converter measurements. Use File/New and set up the worksheet
items listed below.

1. In the Worksheet Info dialog box, select the Post-Converter Channel Table,
STD_PC.CHT, in the Worksheet Info dialog.

NOTE. Measurements taken at the output of the converter require a Channel
Table that retains the channel identifier (that is, channel number) but has the
visual carrier frequency for each channel set to the output visual carrier of the
converter. The procedures below assume that the STD.CHT Channel Table is the
primary table and the post-converter table exists as STD_PC.CHT (Standard
Table, Post-Converter). You must create STD_PC.CHT to fit your own needs.

Define the Site name later from the 2714 or 2715 front panel at each test Site.

2. In the Preferences dialog box, the Pause on New Channel preference can be
used to allow manual tuning of the set top converter for each new test
channel.

3. Use the Measurement Setups dialog box to specify whatever is required for
your system and test methods.

NOTE. This worksheet is only used to define the FCC Post-Converter UDP and
will not be saved (it is not necessary to save the file to create the UDP).
Therefore, it is not necessary to define measurement limits at this time.

1. Set the Test ID for the worksheet to “FCC Post-Converter” using the Test ID
button on the Button Bar or the Test ID selection from the Configure menu.

2. Choose Measurement Sequence, from the Configure menu.

3. Define the measurements by selecting the FCC Post-Converter button.

a. Carrier Levels and Frequencies are automatically selected for all
channels.

b. Select the specific test channels in the Select Channels group using the
Select command button. These are the system specific test channels
chosen to comply with the FCC regulations on number of test channels
based on system frequency limit. Select the channels that require these
additional measurements:

� Carrier to Noise

� CTB

Define the FCC Field
Measurements

Post-Converter Worksheet

Define the Post-Converter
UDP
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� CSO

� Cross-Modulation (coherent disturbances)

� Hum (mode set to RF for all channels)

c. Select the OK button when the selected test channel list is complete. The
Measurement Sequence dialog box displays the selected FCC Post-Con-
verter measurements.

4. Define the Measurement Sequence execution time parameters by selecting
the Edit Time Parameters command button.

a. Set to run immediately, 1 time.

b. Select OK to return to the Measurement Sequence dialog.

5. Create a 2714 or 2715 UDP from the current Worksheet and Measurement
Sequence setup using the Create 2714/2715 UDP button.

a. Enter FCC Post-Converter for the UDP title and select OK.

b. The UDP is created and loaded into the 2714 or 2715.

c. Verify that the selected Channel Table (STD_PC.CHT) exists in the 2714
or 2715. This is not done automatically at UDP generation time — it
must be explicitly done using the Channel Table Loader (see Appen-
dix C).

d. Select OK to return to the Worksheet.

Use New, from the File menu, to select the STD.CHT Channel Table. This will
result in a new worksheet being created (the worksheet used to define the FCC
Post-Converter UDP was only necessary for that task and does not need to be
saved). Configure the items listed below for the new worksheet to match the
system and testing methods:

1. Create a new worksheet by selecting New from the File menu.

2. In the Worksheet Info dialog box, select the Pre-Converter Channel Table,
STD_PC.CHT, in the Worksheet Info dialog.

3. Define the measurements from the Measurement Sequence dialog box by
selecting the FCC Pre-Converter button.

4. Set preferences as required in the Preferences dialog box. (For example,
select “Pause on New Channel” if an external preselector is used. This
allows for manual tuning of the preselector for each channel.)

Define the Pre-Converter
Worksheet
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5. Specify the Measurement Limits. Limits are not formally part of the
generated UDP but are defined here to support importing the measurement
results.

6. Specify the Measurement Setups (select Edit Setups from the measurement
Setups dialog box). Verify that the required test channels have In-Channel
Response set to RF measurement method.

NOTE. Define the Site name later from the 2714 or 2715 front panel at each test
Site.

1. Set the Test ID for the worksheet to FCC Pre-Converter using the Test ID
button on the button bar or Test ID selection, from the Configure menu.

2. Select Measurement Sequence from the Configure menu.

3. Select the Clear Sequence command button.

4. Define the measurements by selecting the FCC Pre-Converter button. This
selection provides an easy method to select the required measurements:

a. Carrier Levels and Frequencies are automatically selected for all
channels.

b. In-Channel Response is selected for all the test channels in the Selected
Channels list box. (Verify that the In-Channel Response measurement
setup is RF for each of the required test channels.)

5. Select the specific test channels in the Select Channels group using the
Select button. These are the system specific test channels chosen to comply
with the FCC regulations on number of test channels based on system
frequency limit.

6. Choose the OK button when the selected test channel list is correct. The
Measurement Sequence dialog box now displays the selected FCC Pre-Con-
verter measurements.

7. Define the Measurement Sequence execution time parameters by selecting
the Edit Time Parameters command button. Set to run immediately, 1 time.

8. Select OK to return to the Measurement Sequence dialog.

9. Create a 2714 or 2715 UDP from the current Worksheet and Measurement
Sequence setup using the Create 2714/2715 UDP button.

a. Enter “FCC Pre-Converter” for the UDP title and click on OK. This
creates the 2714 or 2715 UDP and loads it into the 2714 or 2715.

Define the Pre-Converter
UDP
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b. Verify that the selected Channel Table (STD) exists in the 2714 or 2715.
This is not done automatically at UDP generation time — it must be
explicitly done using the Channel Table Loader (see Appendix C).

c. Select OK to return to the Worksheet.

Define the Measurement Sequence for the visual carrier level and level variation
(30M cable) measurement.

1. Set the Test ID for the worksheet to “FCC Visual Level/Var (30M)” using
the Test ID button on the Button Bar or the Test ID item, from the Configure
menu.

2. Optionally, if any measurement setups or preferences need changing (based
on system test methods), enter the new parameters using Measurement
Setups and Preferences, from the Configure menu. For example, the Pause
for New Channel preference may have been selected for the pre-converter
measurements (assuming the use of an external preselector). Now, for the
visual level and level variation measurements, you are not likely to want to
pause on each new channel.

3. Choose Measurement Sequence, from the Configure menu.

4. Choose the Clear Sequence command button.

5. Define the measurements by choosing the 24 Hour Test command button.
This selection provides easy selection of the required measurements. (Carrier
Levels and Frequencies are selected for all channels)

6. Define the Measurement Sequence execution time parameters by selecting
the Edit Time Parameters command button.

7. Verify that Run Immediately, Run 4 Times, and Repeat Interval = 6 Hours
are selected. These parameters are set automatically when using the 24 Hour
Test button.

8. Select OK to return to the Measurement Sequence dialog.

9. Create a 2714 or 2715 UDP from the current Worksheet and Measurement
Sequence setup using the Create 2714/2715 UDP command button.

a. Enter “FCC Visual Level/Var (30M)” for the UDP title and select OK.
This creates the UDP and loads it into the 2714 or 2715.

b. Verify that the selected Channel Table (STD) is loaded in the 2714 or
2715. This is not done automatically at UDP generation time — it must
be explicitly done using the Channel Table Loader (see Appendix C).

c. Select OK to return to the Worksheet.

Define the UDP for Visual
Carrier Level and Level

Variation (30M)
Measurements
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10. Use Save As, from the File menu, to save the worksheet for future reference.

a. In the directory list box select FCCTESTS/JUL95/FIELD

b. In the File Name box enter FIELD.WRK.

c. Select OK to save the worksheet.

Once the UDPs are defined and loaded, the 2714 or 2715 can be removed from
the CSS50 package and taken independently to each test Site for measurement
execution and results collection. (Remember to load the correct Channel Tables
into the 2714 or 2715.)

The 2714 or 2715 has limited on-board results storage capacity. Therefore, it
may be desirable to remove all currently stored measurement results before
executing the UDP at the first test Site. See the 2714 or 2715 manual for more
information on its measurement storage capacity. Also, in order to provide more
on-board storage capacity, remove additional items such as stored settings and
waveforms, unused Channel Tables, etc., from the 2714 or 2715 NVRAM. See
the 2714 or 2715 user manual for specifics on these operations.

1. At each test Site, first enter the Site name into the 2714 or 2715 using the
2714 or 2715 front panel keys (see the 2714 or 2715 user manual for
specifics on this operation). This allows tagging each measurement result
with the correct measurement Site. Use these Site name tags to encapsulate
measurement results by individual Sites. For this example, we are collecting
results at only two test Sites (TP132 and TP146). The FCC requires a
minimum of six test Sites; for explanation purposes we are only using two.
Enter Site name “TP132” before starting any UDPs at the first Site, and
“TP146” at the second Site.

2. After entering the Site name, execute each UDP, by selecting the UDP name
in the 2714/2715 USER DEF menu. The 2714 or 2715 will sequence
through the measurements and store the results. (The UDP automatically
stores all measurement results in the 2714 or 2715 NVRAM.) Depending on
the chosen preferences and measurement setups, the 2714 or 2715 may
present various prompts for user action during the execution of the UDP.

3. Repeat step 2 for the second test Site. Remember to enter the new Site name
in the 2714 or 2715.

1. When finished collecting data at the test Sites, re-connect the 2714 or 2715
to the CSS50 package.

2. Open the Worksheet used to create the FCC field test UDPs using Open,
from the File menu.

a. In the directory list box, select FCCTESTS/JUL95/FIELD.

Execute the UDPs at Each
Test Site

Collecting and Presenting
Measurement Results
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b. In the File Name box, enter FIELD.WRK.

c. Select OK to open the worksheet. Check that the Channel Table is
STD.CHT. If it is not, select that Channel Table before continuing. Also,
for the importing of results, as described below, enable Measurement
History. Select the Collect History button in the Measurement History
group of the Preferences dialog box, from the Configure menu.

Retrieve the Stored Results Use the following procedure to retrieve stored results:

1. Retrieve the stored FCC field test results from 2714 or 2715 using Get
Stored Results from 2714/2715, from the Measure menu.

2. The CSS50 software will retrieve all measurement results from the 2714 or
2715 and present a directory of results grouped by Site name and Channel
Table name. The listed Sites should match the two test Sites (TP132 and
TP146) and the Channel Table names should match the system (STD and
STD_PC.CHT for this example).

3. Use the Export button to save each group of results into separate results files,
as shown in Table D–1, for later importing into the worksheet or other
programs.

Table D–1: How the results are exported from the 2714 or 2715 

Site Channel table Results file

TP132 STD TP132.WSR1

TP132 STD_PC TP132_PC.WSR2

TP146 STD TP146.WSR3

TP146 STD_PC TP145_PC.WSR4

1 FCC Pre-Converter and Visual Level/Var (30M) results for TP132.
2 FCC Post-Converter results for TP132.
3 FCC Pre-Converter and Visual Level/Var (30M results for TP146.
4 FCC Post-Converter results fro TP146.
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Export the results groups as follows:

a. From the directory list box, select FCCTESTS/JUL95/FIELD.

b. In the File Name box, enter the Results File names as shown in
Table D–1 for each results group.

c. Note that the Import button can be used to load results into the work-
sheet after the results have been exported to a results file. (Import, from
the File menu, can be used the same way.)

� Worksheets always contain results for a single Site and single
Channel Table. This effectively encapsulates the results into the
particular measurements taken at a particular Site.

� Grouping of results on a per Site basis implies that results from
several Sites must be imported and summarized individually on a
Site by Site basis.

d. For this example, we will use the File/Import menu item to load,
analyze, and report the measurement results. Select Close to return to the
worksheet.

4. Now that the FCC field test results have been retrieved from the 2714 or
2715 and stored into results files, we have all the measurement results
analysis and summarization capabilities of the CSS50 at our disposal. First,
import the results from TP132 using File/Import.

a. Choose Import, from the File menu.

b. From the directory list box, select FCCTESTS/JUL95/FIELD.

c. In the File Name box, enter TP132.WSR.

d. Select OK to import the results.

� We want to make the worksheet Site name match the Site name of
the results we are importing. Therefore, select Yes when prompted
about changing worksheet Site to match import Site. (This prompt
will appear only if the worksheet Site does not match the Site of the
results being imported.)

� The 2714 or 2715 stores only the channel number as a channel ID.
The CSS50 stores Channel Number, Letter (Tag), Program Name,
and Nominal Visual Carrier Frequency. Therefore, a channel
mismatch message is displayed. Select the “Use blank channel
information as wildcards” option button in the Import Channel
Criteria group. This will allow importing of all appropriate results
without further prompts. Select the Use Channel Results button to
continue.
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e. The results from TP132.WSR are loaded into the worksheet. These are
the FCC Pre-Converter and FCC Visual Level/Var (30M) results. To
import the FCC Post-Converter results, repeat steps 4, a-d above using
File Name TP132_PC.WSR. Note that the Site name override prompts
are not presented since the Site name is the same as the results previous-
ly imported.

f. Answer Yes to the prompt about Channel Table name mismatch. We
want to import the results regardless of whether they were generated
with std.cht or std-pc.cht.

NOTE. The FCC Post-Converter results were generated using the special
post-converter Channel Table as described above. Here we are importing those
results into a worksheet that uses the normal STD Channel Table. This is
acceptable because the 2714 or 2715 stores only the channel number as the
channel identifier and therefore all the results are placed into the correct
spreadsheet cells without conflict. However, since the “Post-Converter” Channel
Table we used had all the visual carrier frequencies set to a single value, the
counted visual carrier frequencies for the FCC Post-Converter results will
reflect that one single channel frequency value and will not match the STD
Channel Table values. This will result in alarm status for the visual carrier
frequency results for the Post-Converter measurements. Therefore, a worksheet
status report done without any Test ID Results view filter in place will result in
unwarranted alarms for the visual carrier frequency results. The remainder of
the procedure describes how to use the Test ID Results view filter to prevent this
situation.

5. At this point, all the measurement results for Site TP132 have been loaded
into the worksheet. Remember that each set of results (as generated by the
FCC Pre-Converter, FCC Post-Converter, and FCC Visual Level/Var (30M)
UDPs) has been tagged with a different Test ID. The results from each UDP
can be viewed separately using the View/Test ID Results menu item.

6. Select FCC Pre-Converter for the worksheet Test ID.

7. Use View/Test ID Results to enable the Test ID Results view filter.

8. The displayed results are now only those generated from the FCC Pre-Con-
verter UDP at test Site TP132.

9. The Global View (from the View menu) can be used to pinpoint trouble
channels. The Status Report and Results Detail screens can be used to further
analyze data. Copy, from the Edit menu, and Export, from the File menu, can
be used to transfer data or results files to other analysis tools.

10. Once the results are copied or exported, other data analysis tools (such as
MS Excel or MS Word) can be used to generate complete FCC Proof
Reports.
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11. Steps 3 through 10 can be repeated as needed for each set of results.

Results from other test Sites can be imported and analyzed using the same
procedure.
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Appendix E: CSS50 Files

This appendix covers the following topics:

� Naming conventions

� Starting CSS50 with special worksheets

� Adding information to the Help files

� How to archive worksheets

� The CSS50.ini file

File Naming Conventions
CSS50 has very few restrictions on its file names. However, there are defaults,
and it is good practice to use them to avoid confusion. All worksheets should
end in “.wrk” and all exported data results should end in “.wsr”. Table E–1 gives
the general conventions.

Table E–1: Types of files associated with CSS50 and
their naming conventions 

Type of file Naming conventions

Worksheet *.wrk

Exported Results File *.wsr

Limits File *.lim

Channel Table File *.cht

User Aids
There are a few methods that you can use to make using CSS50 quicker and
easier for your application.

You can have CSS50 start with a worksheet already loaded. This is ideal if you
like to start each session with a new worksheet to keep the measurements
separate. The problem is that many of your channels have special Limits files
assigned to them and different Measurement Setups. You don’t want to take the
time to remember which ones they are and set them. Make a “template”
worksheet that defines all these things and then automatically load it every time
CSS50 runs.

Start CSS50 with a
Specific Worksheet
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The easiest method to do this is from a CSS50 shortcut icon.

First, create the template.wrk worksheet.

1. Create a shortcut to the CSS50 application.

2. From the Windows 95 desktop, select the CSS50 shortcut icon.

3. Click the right mouse button and choose Properties, from the File menu.

4. In the Target box, after CSS50.EXE, type: “template.wrk”.

NOTE. The template.wrk file (or any .wrk file you name) must already reside in
the CSS50 directory in order for the shortcut to start with the named worksheet.

5. Choose OK.

The next time you start CSS50 from that shortcut icon, your template worksheet,
“template.wrk”, will automatically load and be ready to run. (Make sure that you
save it under a new file name right away to avoid changing template.wrk
unexpectedly.) You could create and define several CSS50 shortcut icons, each
one with a different template ready to go for the different uses. For example, you
can have one for getting stored results from the 2714/2715 and one for local data
gathering.

The help files are completely editable using a basic text editor. (They were
created using Notebook from Windows.) The only restriction is that only 80
characters per line are allowed.

There are several reasons why you might want to edit the help files, for example:

� To put a check list in the UDP help text to make sure that all of the
appropriate preferences are set before the UDP is generated.

� To put reminders of which channels need to have special Limits files
attached to them in the Limits file dialog box.

There are also help topics at the end of Contents in the Help menu for you to fill
in with your own information. These are the help files for the measurements.
They are there for you to note how the tests are to be performed, how often, what
time of day, and so forth—whatever you might need to put in these files. The
help topics and the files that you need to edit for each topic are listed in
Table E–2.

Adding Information to the
Help Files
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Table E–2: Help topics and their associated files 

Help topics File to edit

Adjacent Channel Leakage acl.hlp

Aural deviation aurdev.hlp

Average Power avgpwr.hlp

Carrier Levels and Frequencies levfreq.hlp

Carrier to Noise carnoise.hlp

Cross Modulation crossmod.hlp

CSO cso.hlp

CTB ctb.hlp

Desired to Undesired desundes.hlp

FCC Baseband fccbase.hlp

Hum/LFD hum.hlp

In Channel Response icr.hlp

Modulation Depth moddepth.hlp

Signal to Noise signoise.hlp

Waveform distortion wfmdist.hlp

Sometimes you may want to use CSS50 for demonstrations or training without
any equipment installed. It would also be nice if some results (even if they are
meaningless) were generated. CSS50 has a “dummy” mode available that will
generate somewhat random numbers for results. Select No Instruments Selected
in Configure/Connections.

NOTE. You cannot make any measurements when in the No Instruments Selected
mode.

How to Archive a Worksheet
There are times when you want to save a worksheet someplace other than where
you have been working with it, either for archiving purposes or to send the
results or setups to someone else.

For example: an MSO (Multiple System Operator) may want to define particular
Limits files and Measurement Sequences for the individual operators to use.
There could be one worksheet for the Pre-converter Measurements, one for the
Post-converter measurement, and another for 24 Hour Variation. These could be

No Instrument Mode
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the “master worksheets” so that the individual operators don’t have to waste time
creating them. Also, when the results return to the MSO, the data will drop right
into their worksheet for evaluation.

To properly archive a worksheet, you must save several files. The following is a
list of files required to properly save and then completely reconstruct a work-
sheet.

The Worksheet File. It should end in “.wrk”. It is the name in the Worksheet entry
in the Worksheet Header.

The Channel Table File. It should end in “.cht”. Find the name in the Channel
Table entry in the Worksheet Header.

All Attached Limits Files. Find them in the sub-directory “limits” under the
directory that contains the CSS50.exe file. You can find the needed Limits files
by scrolling through the Channel - Limits list box in the Measurement Limits
dialog box.

NOTE. When you reconstruct a worksheet from archived files, make sure that the
limit files are placed into a sub-directory called “limits” under the directory that
contains the CSS50.exe file.

CAUTION. Make sure you don’t overwrite any existing files during reconstruction.

The WIN.ini File
The Cable TV Software and the Channel Table Editor place initialization settings
in the WIN.ini file under the heading of CSS50 Connections. Initialization
settings are only inserted in the file when necessary.

If the initialization settings in the WIN.ini file become corrupt for some reason,
the CSS50 Connections section of the file can be completely deleted (but not
while the application is running). The next time the software is run it will create
a new CSS50 Connections section in the WIN.ini file when necessary.

Which Files to Save



Appendix E: CSS50 Files

CSS50 Cable Television System Software User Manual E–5

The CSS50.ini File
The CSS50.ini file is created when the CSS50 program is started for the first
time. The CSS50.ini saves your preferences for the program. This file is then
used every time you restart the program.

This section lists all of the lines in a typical CSS50.ini file, how they affect the
application, and where they are editable. They can always be edited at the
CSS50.ini file itself, but that is not a good practice, because it is error prone and
CSS50 provides access to most of the parameters anyway. Unless that particular
field can only be edited in the CSS50.ini file, edit them in the CSS50 applica-
tion. (An example is the Demodulator topics that can only be edited via the
CSS50.ini file.)

Sometimes you may want (or need) to delete this file to cause the creation of a
new CSS50.ini file. For example if you want to change the decimal and grouping
symbols used for measurement values (or the file was corrupted).

The file can be completely deleted (not while the application is running, though)
and the next time that CSS50 is run, a new CSS50.ini file will be created. Some
defaults may then need to be recreated to match your previous preferences.

Table E–3: Contents of the CSS50.ini file 

Line in CSS50.ini file Description

[CSS50] General control of the CSS50 application window

Maximized=0 0 = Main window not maximized
1 = Main window maximized

Position=172,28,797,498 The last location of the upper left and lower right corners of the main application
window in xy coordinates

[Sites] This topic lists all of the Sites. This list of Sites continues to grow as you add more
Sites in the Worksheet Info dialog box. The only way to remove Sites is to delete
them from this file.

Num Sites=2 Total number of Sites in the list

Site Index=0 Which Site is loaded whenever a new worksheet is created or CSS50 is initially
loaded

Site0= Site names

Site1=Tektronix

[Test ID] This topic lists all of the Test IDs in your list. This list of Test IDs continues to grow as
you add more Test IDs in the Test ID dialog box. The only way to remove Test IDs is
to delete them from this file.

Num Test IDs=4 Number of Test IDs in the list

Test ID Index=0 Which Test ID is the default. The default is loaded for all new worksheets or when
CSS50 is first started.

Test ID0=Learner’s Permit Test ID names
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Table E–3: Contents of the CSS50.ini file (cont.)

Line in CSS50.ini file Description

Test ID1=

Test ID2=Training Wheels

Test ID3=TP888

[File Defaults] Default Channel Table file and Picture driver

Channel Table File=c:\css50\std.cht This is the Channel Table file used for new worksheets. Update this with the
Worksheet Info dialog box (under the Configure Menu).

Video Driver=VIDEO KIT Used by View Picture. It can only be edited here. The Video Driver should be in the
caption displayed by the Program Manager. This is the name of the Video Blaster
board.

[Preferences] These remember the last settings from the Preference dialog box (in the Configure
menu).

Units=0 0 = dBmV
1 = dBV

History=1 0 = Save only most recent measurement
1 = Save History

Signal Connect=0 0 = Do not prompt for signal connection
1 = Prompt for signal connection

Pause on Channel=0 0 = Do not pause on new channel
1 = Pause on new channel

Pause on Alarm=0 0 = Do not pause on measurement alarm
1 = Pause on measurement alarm

Pause on Caution=0 0 = Do not pause on measurement caution
1 = Pause on measurement caution

Pause on Error=0 0 = Do not pause on measurement error
1 = Pause on measurement error

Report out RS232 on Error=0 0 = Do not report out the RS-232 port on measurement error
1 = Report out the RS-232 port on measurement error

Report out RS232 on Alarm=0 0 = Do not report out the RS-232 port on measurement alarm
1 = Report out the RS-232 port on measurement alarm

Report out RS232 on Caution=0 0 = Do not report out the RS-232 port on measurement caution
1 = Report out the RS-232 port on measurement caution

[Measurement Limits] Edit these from the Configure menu, Measurement Limits.

Default Limits File=ntsc.lim Can update via the Save As Defaults command button in the Edit Limits dialog box

Sys Vis Car Level Caution UL=6 Edit this in the Summary Limits in the Measurement Limit Dialog box using Save As
Defaults.

Sys Vis Car Level Alarm UL=10 Edit this in the Summary Limits in the Measurement Limit Dialog box using Save As
Defaults.

Adj Vis Car Level Caution UL=2 Edit this in the Summary Limits in the Measurement Limit Dialog box using Save As
Defaults.
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Table E–3: Contents of the CSS50.ini file (cont.)

Line in CSS50.ini file Description

Adj Vis Car Level Alarm UL=3 Edit this in the Summary Limits in the Measurement Limit Dialog box using Save As
Defaults.

[Measurement Setups] Edit these parameters using the Measurement Setups command from the Configure
menu. These values are the ones that have been stored using “Saved As Default”.

Ext Atten Amp=0 The value in dB of the 2714 external attenuation/amplification

2714/2715 Preamp=0 0 = off
1 = on

Power Line Freq=60 60 = 60 Hz
50 = 50 Hz

Carrier Levels Mode=0 0 = Accurate Frequency and Amplitude
1 = Accurate Amplitude only
2 = Fast Amplitude only

VM100 Average Mode=1 0 = averaging off
1 = averaging on

Carrier Noise Mode=0 0 = Auto
1 = Auto with Pause
2 = Gated

Noise Bandwidth=4e+006 In Hz

CSO Mode=0 0 = Auto
1 = Auto with Pause
2 = Single Sweep
3 = Gated

CSO Loc1=–1.25e+006

CSO Loc2=–750000

CSO Loc3=750000

CSO Loc4=1.25e+006

CSO Loc5=UNDEFINED

CTB Mode=0 0 = Auto
1 = Auto with Pause
2 = Single Sweep

CTB Loc1=0

CTB Loc1 Abs/Rel=1 0 = Abs
1 = Rel

CTB Loc2=UNDEFINED

CTB Loc2 Abs/Rel=1 0 = Abs
1 = Rel

CTB Loc3=UNDEFINED

CTB Loc3 Abs/Rel=1 0 = Abs
1 = Rel

CTB Loc4=UNDEFINED
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Table E–3: Contents of the CSS50.ini file (cont.)

Line in CSS50.ini file Description

CTB Loc4 Abs/Rel=1 0 = Abs
1 = Rel

CTB Loc5=UNDEFINED

CTB Loc5 Abs/Rel=1 0 = Abs
1 = Rel

ICR Mode=0 0 = RF
1 = baseband

ICR Gated=0 0 = not gated
1 = gated

ICR RF Loc1=–500000

ICR RF Loc2=500000

ICR RF Loc3=1e+006

ICR RF Loc4=2e+006

ICR RF Loc5=3e+006

ICR RF Loc6=3.58e+006

ACL Mode=2 0=Upper
1=Lower
2=Both

Hum Mode=0 0 = RF
1 = baseband

VITS Mode=1 0 = Automatic
1 = Manual

NTSC Multiburst Line=17 VITS information

NTSC Multiburst Field=1

NTSC Composite Line=18

NTSC Composite Field=1

NTSC Combination Line=17

NTSC Combination Field=2

NTSC Noise Line=12

NTSC Noise Field=1

NTSC Color Bars Line=17

NTSC Color Bars Field=2

PAL Baseband Line=19

PAL Signal-to-Noise Line=6

PALIn-Chan Resp Line=18

PAL2T K-Factor Line=17

PAL Lum Non-Lin Line=17
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Table E–3: Contents of the CSS50.ini file (cont.)

Line in CSS50.ini file Description

[Demodulator]

Demod=3 0 = N/A
1 = N/A
2 = N/A
3 = DS1001
4 = none

ZCP State=1 1 = on
0 = off

ZCP Line=13 Video line on which to place the zero carrier pulse, 10 to 20.

ZCP Field=1 Video field on which to place the zero carrier pulse, 1 or 2.

ZCP Position=2 Position within the video line where the zero carrier pulse is placed. Values are 0
through 4. 0 places the pulse toward the beginning of the video line and 4 places the
pulse toward the end.
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Appendix F: Cable Diagram

Figure F–1 shows how to connect the CSS50 Cable Television Measurement
Package to the test equipment. CSS50 can operate with only some of the test
equipment connected, but it cannot make measurements requiring those
instruments not present. See Table 1–2 on page 1–3 for a list of equipment
required to make measurements.

Monitor

Keyboard

Printer

Mouse

System Controller

Video display card
(optional)***

COM n

GPIB

Video

VM100 or VM101

Video

RF in
(75 �)

DS1000

GPIB*

RS-232*

2714 or 2715

RF in
(75 �)

*One, not both
**RF signal can be manually switched between the 2714 or 2715 and DS1000
***For View Picture only

RF splitter
(optional)**

RF signal
(distributed)

RS-232

RS-232COM n

COM n

COM n Violations reporting
(optional)

Figure F–1: Cable diagram
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Appendix G: Controlling a 2714 or 2715 Over a Modem

This section describes a method of using the CSS50 Cable Television System
Software to control a 2714 or 2715 analyzer remotely over modems. This section
assumes you are using the Windows Hyper Terminal program; however, you can
use any equivalent program. The Windows Hyper Terminal program is used to
dial the modem and establish communication with the remote modem and
analyzer. The Hyper Terminal program is then exited and the CSS50 software is
started. The Software doesn’t know or care whether it is talking to the analyzer
directly or if there are modems in between. When the user is done using the
software, it is exited and the Hyper Terminal program is restarted and used to
hang up the modems.

To ensure reliable operation, you should use modems that support hardware flow
control and error correction. Some operations (for example, sending a large
channel table) send large binary files to the 2714 or 2715. At baud rates of 2400
and higher, the 2714 or 2715 may not be able to keep up with the PC. If any data
is lost or corrupted, the 2714 or 2715 may operate unpredictably. This is
especially inconvenient if the analyzer is at a remote location. Using hardware
flow control and error correction allows reliable performance.

The details of the setups for the PC, modems and 2714 or 2715 follow. The
modem commands listed are from the standard Hayes command set. If the
commands for your modems are different, use the appropriate commands to
configure the features as described below.

Terminal Program Settings
Set the Terminal communications settings as shown in Table G–1.

Table G–1: Settings for Windows Terminal
program 

Communication setting Value

Baud rate 9600

Data bits 8

Stop bits 1

Parity none

Flow control hardware

Parity check unchecked

Carrier detect unchecked

Connector com2
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A baud rate of 9600 is the fastest the 2714/2715 can handle. The port can be set
to use whatever baud rate is available.

The CSS50 Software Connections settings must match the port and baud rate
selected in the Windows Terminal program.

Local Modem Settings
Set up the local modem with the commands shown in Table G–2.

Table G–2: Settings for local modem 

Command Description

Baud rate Since the PC starts by sending ‘‘AT’’ commands to the modem, the modem
determines the rate of the incoming ‘‘AT’’ characters and communicates with
the PC at that rate. 9600 is recommended.

AT &F Start with known factory settings.

AT \N3 AutoReliable connection. Makes the fastest possible connection and uses
the best possible error correction and data compression. (Optional).

AT &K3 Enable RTS/CTS hardware flow control.

AT &Q5 Use asynchronous error correction mode.

AT &D0 Ignore on-to-off transitions of DTR. This keeps the modem from hanging up
when the Terminal program is exited and the PC drops DTR before the
CSS50 software is started.

AT N1 Connect at the highest rate supported by both modems. (Optional).

AT &W0 Write these settings in profile 0. This profile is loaded and used when the
modem is turned on.

Remote Modem Settings
Connect the remote modem to a terminal to establish these settings and store
them. Set up the modem with the following commands:

Table G–3: Settings for remote modem 

Command Description

Baud rate The modem determines the rate based on the incoming “AT” commands
sent to it during configuration. The rate at which the terminal talks to the
modem during this configuration session is remembered by the modem and
is the rate at which the modem will communicate with the device at the
remote end. A baud rate of 9600 is recommended.

AT &F Start with known factory settings.
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Table G–3: Settings for remote modem (cont.)

Command Description

AT \N3 AutoReliable connection. Makes the fastest possible connection and uses
the best possible error correction and data compression. (Optional).

AT &K3 Enable RTS/CTS hardware flow control.

AT &Q5 Use asynchronous error correction mode.

AT N1 Connect at the highest rate supported by both modems. (Optional).

AT S0=n Sets the modem to auto-answer on the nth ring. Note that the “0” in “S0” is a
zero.

AT Q1 Disable results codes. The 2714/2715 does not understand results codes
and will generate syntax error messages if it receives them.

AT E0 Inhibit command echo. The 2714/2715 should not be sending anything to
the modem before the link is established, so this is just an added
precaution.

AT &W0 Write these settings in profile 0. This profile is loaded and used when the
modem is turned on.

2714 or 2715 Settings
Press the UTIL/4/0/2 keys to get to the RS-232 settings menu. Configure the
2714 or 2715 as shown in Table G–4.

Table G–4: Settings for the 2714 or 2715 

Setting Value

0 STATUS ONLINE

1 BAUD Must match the remote modem setting

2 DATA BITS 8

3 PARITY NONE

4 EOL CRLF

5 FLOW CONTROL HARD (RTS/CTS)

6 ECHO OFF

7 VERBOSE OFF
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Appendix H: Version 1.0 Software

This appendix provides additional information that pertains only to software
version 1.0.

Edit Setups Dialog Box
The Edit Setups dialog box for version 1.0 software is slightly different than
version 2.0. The VITS group was slightly modified. Figure H–1 shows the
version 1.0 dialog box and a description of the VITS group follows.

Figure H–1: The Edit Setups dialog box (version 1.0)
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VM100 VITS Group. Select Auto or Manual to enter the locations of the various
VITS lines in the Line and Field text boxes. Auto causes the VM100 to
automatically search for the appropriate test signals. Manual always has the
VM100 use the specified line for the test signal. If the required signal is not
present, the measurement will fail.

For example, running In-Channel Response uses the Line and Field locations
entered in the Multiburst row. The VITS signal in the specified Line and Field
does not have to be a Multiburst signal but it does have to be a signal appropriate
for the measurement. Refer to the VM100 User manual for a list of test signals
the VM100 can use for measuring Frequency Response.

The VITS signals selectable for making the measurements in the NTSC
measurement list are: Multiburst, Composite, Combination, Noise (Quiet), and
Sin(x)/x. You don’t have to enter the VITS locations for Auto mode; the VM100
will search for them whenever they are required to make a measurement.

The CSS50 baseband measurements are arranged into five groups, with each
group requiring a particular test signal as given in Table 3–10.

Table H–1: Required VITS signal for each measurement 

Group Required Test Signal

Waveform Distortion Group Any one of lines F1:9–20 or F2:9–20.

This is the 2T K-Factor and Luminance Nonlinearity
measurements in the VM100.

Uses the Line and Field locations entered in the Composite
row using manual mode.

Baseband Group Any one of lines F1:9–20 or F2:9–20.

This is the Chroma-Luma Delay, Differential Gain, and
Differential Phase measurements in the VM100.

Uses the Line and Field locations entered in the Composite
row using manual mode.

In-Channel Response Group Any one of lines F1:9–20 or F2:9–20.

This is the Frequency Response measurement in the VM100.

Uses the Line and Field locations entered in the Multiburst row
using manual mode.

Signal to Noise Group Any one of lines F1:9–20 or F2:9–20.

This is the Signal-to-Noise Ratio in the VM100.

Uses the Line and Field locations entered in the Noise (Quiet)
row using manual mode.
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Glossary

Accuracy
The closeness of the indicated value to the true value.

ACL (Adjacent Channel Leakage)
The power in the channels adjacent to the channel under test that is due to
leakage from the channel under test.

Aural Deviation
The peak FM deviation measured for the selected channel.

Average Power
The integral of the power spectral density of all screen locations between the
edges of the channel.

Carrier Levels and Frequencies
Carrier levels is the peak amplitude with the preamp off. Carrier Frequencies
is the frequency measured against the frequency of the internal counter of the
instrument.

Carrier to Noise
The ratio of the carrier to noise amplitude with the default noise floor
normalized to 4 MHz relative to the visual carrier peak.

Cross Modulation
The peak fundamental component of 3rd order distortion at the horizontal
sync frequency (AM) measured on the unmodulated visual carrier.

CSO (Composite Second-Order)
Distortion from second-order intermodulation distortion.

CTB (Composite Third-Order or Triple Beat)
Distortion from third-order intermodulation distortion.

Desired to Undesired
The ratio of the average power of the desired signal to the average power of
undesired signals.

Hum/LFD
Hum/Low Frequency Disturbance is the power line frequency measured on
an unmodulated visual carrier and low frequency disturbance measured on
the modulated carrier.

In Channel Response
The maximum variance in amplitude within a specified frequency range
within a particular channel, given a flat input over that same range.
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Modulation Depth
The percent amplitude modulation measured from sync tip to the lowest
white level in 10 sweeps.

UDP (User Defined Program)
A measurement sequence loaded into a 2714/2715 and run at a remote
location.
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Average Power, Glossary–1

B
Blue, 2–22, 3–27, 3–36
Button Bar, 3–79

Channel Table Editor, C–22

C
Cable Diagram, F–1
Carrier Amplitude Units, Preferences, 3–51
Carrier Levels and Frequencies, Glossary–1
Carrier Levels Units, 2–49
Carrier Survey, 2–32

UDP, 3–43, 3–55
Carrier to Noise, 2–42, Glossary–1

Auto, 2–42
Auto with Pause, 2–42
Edit Setups, 3–69
Gated, 2–42

Caution, 2–59, 3–36
Limits, 2–75, 3–61

Cell Color, 2–22
Cells, Selecting, 2–11
Chan Table, 2–5
Channel Edge, C–23
Channel Header, 3–5

Number, 3–5
Program, 3–5
Tag, 3–5
Visual Frequency, 3–5

Channel Number, B–7, C–23
Channel Summary, 3–33

from Global View, 3–36
Channel Table, 2–45, 3–4, 3–12, B–2, B–5, B–9, B–11

Automatic Loading, C–9
Cautions, C–8
Clear, C–3
Copy Fields to End, C–8, C–17
Create a New, C–3
Get 2714 Stored Results, 3–44
Get 2714/2715 Stored Results, 2–85
Loading, C–10
Names, C–9
Transfer To, C–8
UDP, 3–57
Worksheet Info, 3–47

Channel Table Editor, C–1, C–2
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Channel Table File, E–4
Channel Table Mismatches, C–9
Channel Table Names, C–10
Channel Tables, Provided, C–11
Channel Width, B–7, C–23
Clear, 3–23
Clear Limits, Edit Limits File, 3–65
Clear Limits File, Measurement Limits, 3–62
Close, 3–10

Channel Table Editor, C–13, C–16
Help, 3–78

Color, of Cells, 2–22
Configure, 3–46
Connections, 2–38, 3–74

Channel Table Editor, C–21
Contents

Channel Table Editor, C–21
Help, 3–77

Copy, 2–62, 3–21, B–4
As Displayed, 2–63, 3–21
Compared to Export, 3–16
Export Format, 2–62, 3–21

Copy to All Channels, Edit Setups, 2–45, 3–73
Create/Edit Channel Table, 3–12, 3–48
Cross Modulation, Glossary–1
CSO, 2–43, B–4, E–7, Glossary–1

2714 Displaying CTB, 2–58
Edit Setups, 3–70
Get 2714 Stored Results, 3–45

CSS50
Application Shortcut, E–1
Starting with a worksheet, E–1

CSS50.INI, E–5
Error Message, B–4

CTB, 2–43, B–4, E–7, Glossary–1
Edit Setups, 3–71
Get 2714 Stored Results, 3–45

CTLOADER, B–5
Current Selection, 2–17, 3–42
Cursor, 3–7
Customer Support, xii

D
Decimal Symbol, Setting, 2–24, 3–60
Delete, Channel Table Editor, C–17, C–19
Demodulator, 3–76

CSS50.INI, E–9
Selecting, 1–6, 2–37

Demodulator Command, 3–76
Demonstration mode, E–3

Description, 3–12
Worksheet Info, 3–48

Desired to Undesired, Glossary–1
DS1000

Channel Tables, 2–47, C–11
Selecting, 2–37

DS1000 Demodulators, 1–4

E
Edit, 3–21

Channel Table Editor, C–16
Edit Channel Info, Channel Table Editor, C–22
Edit Limits File, Measurement Limits, 3–62
Edit Setups, Measurement Setups, 2–41, 3–68
Edit Table Info, Channel Table Editor, C–3, C–17,

C–22
Edit Time Parameters

Measurement Sequence, 3–55
UDP, 2–80

Error, 3–27
Get 2714 Stored Results, 3–45
Import, 3–14

Error Messages, B–1
Excel, 2–63, 2–64
Exit, 3–20
Expand Columns, 2–35, 3–17

Printing, 3–17
Export, 2–66, 3–16, B–4
Export Format, Copy, 3–21
Export Results

Get 2714 Stored Results, 3–44
Get 2714/2715 Stored Results, 2–83

External Attenuation/Amplification, 2714 Measure-
ment Setups, 3–67

F
FCC 24 Hour Measurements, 3–54
FCC Field Measurements, D–5

Collecting and Presenting Measurement Results,
D–10

Defining, D–6
Execute UDPs, D–10
Post-Converter UDP, D–6
Pre-Converter UDP, D–8
Pre-Converter Worksheet, D–7
Visual Carrier Level & Level Variation (30M) UDPs,

D–9
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FCC Headend Measurements, 2–29, 3–54, D–3
Summary, D–4

FCC Post-Converter, 2–29, 3–54
FCC Pre-Converter, 2–29, 3–54
File, 3–11

Channel Table Editor, C–13
Files, Naming Convention, E–1
Flags

Alarm, 2–50
Caution, 2–50
Errors, 2–50

G
Gated

Carrier to Noise, 2–42
CSO, 2–43

Generate 2714 UDP, 3–56
Get 2714 Stored Results

Export Results, 3–44
Import Results, 3–44

Get Defaults
Edit Limits File, 3–64
Edit Setups, 3–72
Edit Setups , 2–44
Measurement Setups, 2–40, 3–68

Get Stored Results from 2714, 3–43
Get Stored Results from 2714/2715, 2–83
Global, Button Bar, 3–79
Global View, 3–36
GPIB, 2–38, 3–74, B–1, B–6, B–8, C–21
Gray, 2–22, 3–36
Green, 2–22, 3–27, 3–36

H
Hardware Installation, 1–2
Hardware Requirements, PC, 1–1
Help, 3–77, B–5

Channel Table Editor, C–21
Tektronix Help Line, xii

Help Files, Adding Information, E–2
History, 2–48, 2–61, 2–66, B–9, E–6

Copy, 3–22
Import, 3–14
Limits Files, 3–62
Preferences, 3–50
Results Detail, 3–28

Navigation, 3–30
Status Report, 3–25

Horizontal Scroll Bar, 3–7

Hum, 2–42
Edit Setups, 3–70

Hum Measurement
Baseband, 1–7, 3–77
Zero Carrier Pulse, 1–7, 3–77

Hum/LFD, Glossary–1

I
ICR, E–8
ICR Test Line, C–24
Import, 3–14, B–9

Channel Number, 3–14
Channel Table, 3–14
Error, 3–14
History, 3–14
Site, 3–14
View Filter, 3–39

Import Channel Criteria, Get 2714/2715 Stored Results,
2–86

Import Results
Get 2714 Stored Results, 3–44
Get 2714/2715 Stored Results, 2–84

In Channel Response, 2–44, Glossary–1
Edit Setups, 3–72

Insert, Channel Table Editor, C–16
Intercepting an Alarm, 2–50, 3–52

L
Limit Check, Channel Table Editor, C–20
Limits

Button Bar, 3–79
Lower, 2–75, 3–63
Out of Bounds, C–10
Upper, 2–75
Visual Carrier Level Differences, 2–78

Limits command button, 2–74
Limits File, 2–22, 2–74, 3–61, B–4, E–4

Attach to a Channel, 2–77
Edit, 2–77
Remove from a Channel, 2–78

Limits Sub-directory, 3–63
Line Range Settings

NTSC, 1–7, 3–76
PAL, 1–7, 3–77

Load a Channel Table, C–8
Log To File, Error, Caution, Alarm, 2–50, 3–52
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M
Maximize, 3–10

Channel Table Editor, C–13
Maximize Button, 3–4
Meas Sel, 2–17

Button Bar, 3–79
Meas Seq, 3–43, 3–53

Button Bar, 3–79
Measure, 3–42
Measurement, Setups, Hum, 2–42
Measurement Execution, 2–49
Measurement Header, 3–6
Measurement Limits, 2–74, 3–61
Measurement Sequence, 2–72, 3–53, B–3, B–10

Disabled Commands, 3–40
FCC Headend Measurements, D–3
Generate 2714 UDP, 3–56
Results, 2–70, 3–40
Switching to Other Applications, 2–28
UDP, 2–81
View Filter, 2–28

Measurement Setups, 2–38, 3–66
Carrier to Noise, 2–42
CSO, 2–43
CTB, 2–43
In Channel Response, 2–44
UDP, 2–80
VITS, 2–43, 3–70, H–2

Measurement Summary, 3–35
From Global View, 3–36
Results Detail, 3–30
Status Report, 3–25

Measurements, Switching to Other Applications, 2–20
Measurements and Channels, 2–67, 3–37

View Used, 3–39
Memory, B–3, B–9
Menu Bar, 3–11
Minimize, 3–10

Channel Table Editor, C–13
Minimize Button, 3–4
Modulation Depth, Glossary–2
Mouse, 3–7
Mouse Button, Right, 2–21, 2–56, 2–60, 3–24, 3–29
Move, 3–9

Channel Table Editor, C–13

N
Navigation, Results Detail, 3–29

New, 3–11
Channel Table, 3–12
Channel Table Editor, C–14
Description, 3–12
Site, 3–12

Non-US countries, Measurement Sequence changes,
2–29

Notes, Contents, 3–30
NTSC, Setting Channel Table, C–3
Number, Channel Header, 3–5
Number of Channels

Edit Table Info, C–18
Maximum, C–18

Numerical Display, Decimal Symbol, 2–24, 3–60

O
Open, 3–13

Button Bar, 3–79
Channel Table Editor, C–14

Open Limits File, Edit Limits File, 3–64
Operator Input, UDP, 3–58
Organizing, D–1
Out of Bounds Limits, Channel Table Editor, C–10

P
PAL, Setting Channel Table, C–3
Parameters, 2–79, 3–66
Pasting into Word for Windows, 3–22
Pause Execution, 2–50
Pause on Measurement Alarm, E–6

Preferences, 3–51
Pause on New Channel, 2–50, E–6

Preferences, 3–51
Picture, 2–33, 3–37, B–5
Power Line Frequency, 2–40, 3–68, E–7
Preamp

2714 Measurement Setups, 3–67
2714/2715, 2–40

Preferences, 2–47, 3–49
Carrier Levels Units, 2–49
History, 2–48
Measurement Execution, 2–49
Pause Execution, 2–50
Pause on New Channel, 2–50
Prompt for Signal Connection, 2–49
UDP, 2–80, 3–57
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Print, 2–33, 3–16
Button Bar, 3–79
Channel Table Editor, C–15
Portrait or Landscape, 2–34, 3–17

Print Setup, 3–20
Channel Table Editor, C–15

Printing, Expand Columns, 2–35, 3–17
Program, C–23

Channel Header, 3–5
Prompt for Signal Connection, 2–49, E–6

Q
Quiet Line, C–24

R
Red, 2–22, 3–27, 3–36
Regional Settings, 2–24, 3–60
Repeat Interval, Measurement Sequence, 3–56
Report Out RS-232, 2–50
Restore, 3–9

Channel Table Editor, C–12
Restore Button, 3–4
Result Detail, From Global View, 3–36
Results, 2–56, 2–60

Button Bar, 3–79
Results Detail, 2–56, 3–28, B–4

Notes, 3–30
Results Detail Display, 2–56, 2–60

Navigation, 2–57
RS-232, 1–7, 1–8, 3–75, B–1, C–21
RS-232 Violations Reporting, 1–8

S
Save, 3–13

Button Bar, 3–79
Channel Table Editor, C–14

Save As, 3–13
Channel Table Editor, C–14

Save as Default, Worksheet Info, 3–48
Save as Defaults

Edit Limits File, 3–64
Edit Setups, 2–44, 3–73
Measurement Setups, 2–40, 3–68

Save As Limits File, Edit Limits File, 3–64
Scrambling, 2–18, C–23

Select
Channel Table Editor, C–20
Column, 2–13
Row, 2–13

Select All, 3–23
Select Limits File, Measurement Limits, 3–61, 3–62
Sequence, 3–43
Setup, Command Button, 2–39
Setups, Button Bar, 3–79
Site, 2–5, 3–5, 3–12, 3–14, B–4, E–5

Get 2714 Stored Results, 3–44
UDP, 3–60, D–10
Worksheet Info, 3–47

Size, 3–10
Channel Table Editor, C–13

Software Installation, 1–2
Sort

By Channel Number, C–18
By Frequency, C–18
By Program, C–18
Channel Table Editor, C–18

Start Time, Measurement Sequence, 3–56
Status, 2–59, 3–24

Button Bar, 3–79
Status Report, 2–58, 3–24

From Global View, 3–37
Measurement Summaries, 3–25

Summary Limits, 2–78, 3–65
Sync Polarity, C–24

T
T–Channels, C–12
Table Information List Box, Channel Table Editor,

C–23
Table Name, Edit Table Info, C–18
Tag, C–23

Channel Header, 3–5
Test ID, 2–5, 3–5, 3–48, B–4, E–5

All Test IDs, 3–48
Button Bar, 3–79
Results, 2–72
UDP, 2–80, 3–57
View Filter, 3–41
Worksheet Test ID, 3–48

Title Bar, 3–3
Menu Box, 3–9
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Transfer, B–6
Channel Table Editor, C–18
From 2714/2715, C–19
To, C–8
To 2714/2715, C–18

Tune to Channel, 3–43
Picture, 2–33

U
UDP, 2–80, 3–56, B–2, B–4, Glossary–2

Defining, 2–80
Running, 2–82

Upper Limits, 3–63
Use ICR, C–24
Use Quiet Line, C–24

V
Vertical Scroll Bar, 3–7
Video Driver, 3–37
Video Polarity, C–24
Video Standard

Edit Table Info, C–18
Error Message, B–7
Setting, C–3

View, 3–24
View Filter, 2–61, 2–67, 3–39, B–4, B–9, B–10

Measurement Results, 3–66
Measurement Sequence Results, 2–28, 2–70, 3–40
Measurements and Channels, 2–67, 3–37
Status Box, 2–5, 3–5, 3–38, 3–40, 3–41
Test ID, 3–41
Test ID Results, 2–72
View Used, 3–39

View Results Detail
Status Report, 3–27
View Violations, 3–27

View Used, 3–39
Measurement and Channel View Filter, 2–34

View Violations, 2–59, 3–27
Status Report, 3–27
View Results Detail command button, 2–60

Violations Report, Report Out RS-232, 2–50
Violations Reporting, 1–8
Visual Carrier Frequency, B–7

Limits, 3–63
Visual Carrier Level Differences, 3–65
Visual Frequency, C–23

Channel Header, 3–5
VITS, 2–43, H–2

Edit Setups, 3–70, H–2
Line and Field Ranges, 3–71

VM100/VM101, Average Mode, 2–40, 3–68

W
White, 2–22, 3–27, 3–36, C–24
White Line, C–24
WIN.INI, E–4

Error Message, B–4
Worksheet, 2–5, 3–4

Description, 2–3
Tutorial, 2–3

Worksheet File, E–4
Worksheet Header, 3–4

Channel Table, 3–4
Site, 3–5
Test ID, 3–5
Worksheet, 3–4

Worksheet Info, 3–47
UDP, 2–80

Y
Yellow, 2–22, 3–27, 3–36

Z
Zero Carrier Pulse, 1–7, 3–76, 3–77
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